FINAL REPORT (Appendices)

Multi-species Habitat Supply in the Quesnel Timber Supply Area, British Columbia: Appendices

R.S. MCNAY\textsuperscript{1}, V. BRUMOVSKY\textsuperscript{1}, M. FENCER\textsuperscript{2}, J. VOLLER\textsuperscript{1}, R. SULYMA\textsuperscript{1}, R.K. MCCANN\textsuperscript{1}, AND M. SNIVELY\textsuperscript{1}

MARCH 30, 2011

\textsuperscript{1}Wildlife Infometrics Inc., PO Box 308, Mackenzie, BC, V0J 2C0, wild_info@wildlifeinfometrics.com
\textsuperscript{2}Mike Fenger and Assoc., 511 Foul Bay Road, Victoria, BC, V8S 4G9, mfenger@pacificcoast.net

Prepared for the Quesnel Mitigation Committee, under agreement for FIRS project numbers: 8162001

ABSTRACT

Appendix material is provided in support of a project that addressed habitat supply modeling for multiple, terrestrial wildlife species in the western portion of the Quesnel Timber Supply Area (TSA) in British Columbia.
ACKNOWLEDGMENTS

We acknowledge the support, insight, and continued encouragement to pursue new applications for habitat supply modeling provided by Glenn Sutherland. In particular, some of the introductory material and other sections of this report were collaborations with Glenn and were rewritten with his permission. In addition, Ann-Chan McLeod (Univ. of BC) contributed a thoughtful perspective and her advice on the selection of species to be modeled; she also contributed to some of the writing in Appendix A on species selection. We would like to thank Julie Steciw, Michelle Arcand, and Rick Dawson for their review comments and improvements made to the species selection and for their improvements to the modeling project rational as a result. Gordon Nienaber (Forest Analysis and Inventory Branch in Victoria) went out of his way during a busy schedule to provide answers to our many questions regarding the Timber Supply data. Thanks to Gordon for being there when we needed him. Our pursuit of stand structure data was facilitated by Ian Moss (ForestTree Consulting Ltd.). We’ve only scratched the surface on what these data can do for habitat supply modeling so I know we’ll continue to tap Ian’s input to our work. We’d also like to thank Jonathan Armstrong (Forest Ecosystems Solutions) for his help in providing clarity about many aspects of the Quesnel data set.

A huge thank-you and enormous respect go to Phil Winkle for his masterful management of the project logistics and funding. A well managed project is fun to be engaged in and this was fun. Finally, we thank the entire QMC for their support of this work: Shawn Meisner (Tolko), Michelle Arcand (BC Min. of Environ.), Michael Pelchat (BC Min. For. and Range), Earl Speilman (West Fraser), Jon Erickson (Canadian Forest Products), Julie Steciw (BC Min. of Environ.), Bev Frittenburg (Integrated Land Management Bureau), and John Stace-Smithhand. Funding came from our three clients in the forest industry; C & C Wood Products Ltd., Canadian Forest Products Ltd., and Pioneer Family Timber Partnership Ltd.
# TABLE OF CONTENTS

ABSTRACT ........................................................................................................... I  
ACKNOWLEDGMENTS .................................................................................... II  
LIST OF TABLES ............................................................................................... XV  
LIST OF FIGURES .............................................................................................. XV  

APPENDIX A: SPECIES LIST FOR THE QUESNEL MULTI-SPECIES HABITAT SUPPLY MODELLING PROJECT ................................................................. 1  
Introduction ........................................................................................................ 1  
Species Selection Criteria and Intent ............................................................... 1  
  Criteria 1) Forest-dependent species vulnerable to cumulative effects of extensive  
     natural disturbances, forest harvest and salvage ........................................... 2  
  Criteria 2) Seral Stage Specialist Species ......................................................... 2  
  Criteria 3) Provincial Conservation Framework Priority Species .................... 2  
  Criteria 4) Species from Land Use Plans, First Nations and FIA Rational .......... 2  
Review of reports identifying species .............................................................. 3  
  Bunnell report on species affected by mountain pine beetle and salvage ........ 3  
Conservation Framework ................................................................................. 5  

Global, National and Identified Wildlife Management Strategy Species ........... 7  
  Global Ranking ............................................................................................ 7  
  National (COSEWIC) .................................................................................... 8  
  Identified Wildlife Management Strategy ....................................................... 8  
  McNay and Sutherland 2009 ........................................................................... 9  
  Silviculture Strategies .................................................................................... 10  
  Central Interior Eco-Regional Assessment ....................................................... 10  

Regionally and Culturally Identified Wildlife Species ....................................... 12  
  Cariboo Chilcotin Land Use Plan ................................................................. 12  
  Forest Investment Account Rational ............................................................ 12  
Species recommended for modeling .............................................................. 13  
  Primary Cavity Excavators ............................................................................ 14  
  Secondary Cavity Users ............................................................................... 14  
  Open Tree Nesters ....................................................................................... 14  
  Aquatic Obligates ....................................................................................... 14  
  Furbearers ................................................................................................... 15  
  Small Mammals and Amphibians ................................................................. 15  
  Grizzly Bear ................................................................................................. 15  
  Ungulates .................................................................................................... 15  

LITERATURE CITED ....................................................................................... 16  

APPENDIX B. SPECIES ACCOUNTS ................................................................. 19  
Three-toed Woodpecker ............................................................................... 20
Published species accounts ................................................................. 20
Distribution ......................................................................................... 20
Provincial range: .................................................................................. 20
Elevation range: .................................................................................... 20
Provincial context: ............................................................................... 20
General ecology and life history .......................................................... 21
Reproduction: ....................................................................................... 21
Movements and home range: ............................................................... 21
Feeding habits: ..................................................................................... 21
Range use: Life requisites ..................................................................... 22
General: ............................................................................................... 22
Foraging habitat: .................................................................................. 22
Cover from thermal extremes: .............................................................. 22
Natal sites/denning/nesting: ................................................................. 22
Security: ............................................................................................... 23
Range use: Interaction with agents of disturbance/competition .......... 23
Disturbance: ........................................................................................ 23
Competitors: ....................................................................................... 23
Range use: Mortality factors ............................................................... 23
Potential limiting factors and threats .................................................. 24
Black-backed Woodpecker ................................................................. 25
Published species accounts ................................................................. 25
Distribution ......................................................................................... 25
Provincial range: .................................................................................. 25
Elevation range: .................................................................................... 25
Provincial context: ............................................................................... 25
General ecology and life history .......................................................... 26
Reproduction: ....................................................................................... 26
Movements and home range: ............................................................... 26
Feeding habits: ..................................................................................... 26
Range use: Life requisites ..................................................................... 27
General: ............................................................................................... 27
Foraging habitat: .................................................................................. 27
Cover from thermal extremes: .............................................................. 27
Natal sites/denning/nesting: ................................................................. 28
Security: ............................................................................................... 28
Range use: Interaction with agents of disturbance/competition .......... 28
Barrow’s Goldeneye

Northern Flicker

Published species accounts

Distribution

Provincial range:
Elevation range:
Provincial context:

General ecology and life history

Reproduction:
Movements and home range:
Feeding habits:

Range use: Life requisites

General:
Foraging habitat:
Cover from thermal extremes:
Natal sites/denning/nesting:
Security:

Range use: Interaction with agents of disturbance/competition

Disturbance:
Competitors:

Range use: Mortality factors

Potential limiting factors and threats

Barrow’s Goldeneye

Published species accounts

Distribution

Provincial range:
Elevation range:
Provincial context:

General ecology and life history

Reproduction:
Movements and home range:
Feeding habits:

Range use: Life requisites

General:
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Foraging habitat:</td>
<td>36</td>
</tr>
<tr>
<td>Cover from thermal extremes:</td>
<td>36</td>
</tr>
<tr>
<td>Natal sites/denning/nesting:</td>
<td>36</td>
</tr>
<tr>
<td>Security:</td>
<td>36</td>
</tr>
<tr>
<td>Range use: Interaction with agents of disturbance/competition</td>
<td>36</td>
</tr>
<tr>
<td>Disturbance:</td>
<td>36</td>
</tr>
<tr>
<td>Competitors:</td>
<td>36</td>
</tr>
<tr>
<td>Range use: Mortality factors:</td>
<td>36</td>
</tr>
<tr>
<td>Potential limiting factors and threats:</td>
<td>36</td>
</tr>
<tr>
<td>Great Blue Heron:</td>
<td>38</td>
</tr>
<tr>
<td>Published species accounts:</td>
<td>38</td>
</tr>
<tr>
<td>Distribution:</td>
<td>39</td>
</tr>
<tr>
<td>Provincial range:</td>
<td>39</td>
</tr>
<tr>
<td>Elevation range:</td>
<td>39</td>
</tr>
<tr>
<td>Provincial context:</td>
<td>39</td>
</tr>
<tr>
<td>General ecology and life history:</td>
<td>39</td>
</tr>
<tr>
<td>Reproduction:</td>
<td>39</td>
</tr>
<tr>
<td>Movements and home range:</td>
<td>40</td>
</tr>
<tr>
<td>Feeding habits:</td>
<td>40</td>
</tr>
<tr>
<td>Range use: Life requisites:</td>
<td>40</td>
</tr>
<tr>
<td>General:</td>
<td>40</td>
</tr>
<tr>
<td>Foraging habitat:</td>
<td>41</td>
</tr>
<tr>
<td>Cover from thermal extremes:</td>
<td>41</td>
</tr>
<tr>
<td>Natal sites/denning/nesting:</td>
<td>41</td>
</tr>
<tr>
<td>Security:</td>
<td>41</td>
</tr>
<tr>
<td>Range use: Interaction with agents of disturbance/competition</td>
<td>42</td>
</tr>
<tr>
<td>Disturbance:</td>
<td>42</td>
</tr>
<tr>
<td>Competitors:</td>
<td>42</td>
</tr>
<tr>
<td>Range use: Mortality factors:</td>
<td>42</td>
</tr>
<tr>
<td>Potential limiting factors and threats:</td>
<td>42</td>
</tr>
<tr>
<td>Rusty Blackbird:</td>
<td>44</td>
</tr>
<tr>
<td>Published species accounts:</td>
<td>44</td>
</tr>
<tr>
<td>Distribution:</td>
<td>44</td>
</tr>
<tr>
<td>Provincial range:</td>
<td>44</td>
</tr>
<tr>
<td>Elevation range:</td>
<td>44</td>
</tr>
<tr>
<td>Provincial context:</td>
<td>45</td>
</tr>
<tr>
<td>General ecology and life history:</td>
<td>45</td>
</tr>
</tbody>
</table>
Reproduction: .................................................................................................................45
Movements and home range: .........................................................................................45
Feeding habits: ................................................................................................................45
Range use: Life requisites: ..............................................................................................45
General: ..........................................................................................................................45
Foraging habitat: ............................................................................................................46
Cover from thermal extremes: .......................................................................................46
Natal sites/denning/nesting: .........................................................................................46
Security: ..........................................................................................................................46
Range use: Interaction with agents of disturbance/competition ................................46
Disturbance: ....................................................................................................................46
Competitors: ....................................................................................................................46
Range use: Mortality factors ............................................................................................47
Potential limiting factors and threats ............................................................................47
Northern Goshawk: .........................................................................................................48
Published species accounts ...........................................................................................48
Distribution .......................................................................................................................49
    Provincial range: ........................................................................................................49
    Elevation range: ..........................................................................................................49
    Provincial context: ......................................................................................................49
General ecology and life history ......................................................................................49
Reproduction: ................................................................................................................49
Movements and home range: .........................................................................................50
Feeding habits: ................................................................................................................50
Range use: Life requisites: ..............................................................................................50
General: ..........................................................................................................................50
Foraging habitat: ............................................................................................................51
Cover from thermal extremes: .......................................................................................51
Natal sites/denning/nesting: .........................................................................................51
Security: ..........................................................................................................................51
Range use: Interaction with agents of disturbance/competition ................................51
Disturbance: ....................................................................................................................51
Competitors: ....................................................................................................................52
Range use: Mortality factors ............................................................................................52
Potential limiting factors and threats ............................................................................52
Sandhill Crane: ................................................................................................................53
Published species accounts ...........................................................................................53
Competitors: .................................................................................................................. 61
Range use: Mortality factors ........................................................................................... 61
Potential limiting factors and threats ............................................................................. 62
American White Pelican ................................................................................................. 63
Published species accounts .......................................................................................... 63
Distribution ...................................................................................................................... 63
Provincial range: ............................................................................................................. 63
Elevation range: .............................................................................................................. 64
Provincial context: .......................................................................................................... 64
General ecology and life history ..................................................................................... 64
Reproduction: .................................................................................................................. 64
Movements and home range: ......................................................................................... 65
Feeding habits: ................................................................................................................. 65
Range use: Life Requisites ............................................................................................. 65
General: .......................................................................................................................... 65
Foraging habitat: ............................................................................................................. 66
Cover from thermal extremes: ....................................................................................... 66
Natal sites/denning/nesting: ........................................................................................... 66
Security: .......................................................................................................................... 66
Range use: Interaction with agents of disturbance/competition ..................................... 67
Disturbance: .................................................................................................................... 67
Competitors: .................................................................................................................. 67
Range use: Mortality factors ........................................................................................... 67
Potential limiting factors and threats ............................................................................. 67
Mule Deer ......................................................................................................................... 69
Published species accounts .......................................................................................... 69
Distribution ...................................................................................................................... 69
Provincial range: ............................................................................................................. 69
Elevation range: .............................................................................................................. 69
Provincial context: .......................................................................................................... 69
General ecology and life history ..................................................................................... 70
Reproduction: .................................................................................................................. 70
Movements and home range: ......................................................................................... 70
Feeding habits: ................................................................................................................. 70
Range use: Life Requisites ............................................................................................. 70
General: .......................................................................................................................... 70
Foraging habitat/mineral licks: ....................................................................................... 71
Cover from thermal extremes: ................................................................. 71
Natal sites/denning/nesting: ................................................................. 71
Security: .................................................................................................. 71
Range use: Interaction with agents of disturbance/competition .............. 71
Disturbance: .......................................................................................... 71
Competitors: .......................................................................................... 71
Range use: Mortality factors ................................................................. 71
Potential limiting factors and threats ....................................................... 72
Moose ....................................................................................................... 73
Published species accounts ................................................................. 73
Distribution ............................................................................................ 73
   Provincial range: .................................................................................. 73
   Elevation range: .................................................................................. 73
   Provincial context: .............................................................................. 73
General ecology and life history ............................................................ 74
   Reproduction: ..................................................................................... 74
   Movements and home range: .............................................................. 74
   Feeding habits: .................................................................................. 74
Range use: Life Requisites ................................................................. 74
   General: ............................................................................................ 74
   Foraging habitat/mineral licks: ............................................................. 75
   Cover from thermal extremes: ............................................................. 75
   Natal sites/denning/nesting: ................................................................. 76
   Security: ............................................................................................ 76
Range use: Interaction with agents of disturbance/competition .............. 76
   Disturbance factors: ......................................................................... 76
   Competitors: ..................................................................................... 76
Range use: Mortality factors ................................................................. 76
Potential limiting factors and threats ....................................................... 77
Caribou ................................................................................................... 78
Published species accounts ................................................................. 78
Distribution ............................................................................................ 78
   Provincial range: ................................................................................ 78
   Elevation range: ................................................................................ 79
   Provincial context: ............................................................................ 79
General ecology and life history ............................................................ 79
   Reproduction: .................................................................................. 79
Movements and home range: .................................................................................. 79
Feeding habits: .......................................................................................................... 80
Range use: Life Requisites ......................................................................................... 80
General: ..................................................................................................................... 80
Foraging habitat/mineral licks: .................................................................................. 80
Cover from thermal extremes: ................................................................................... 81
Natal/denning/nesting: ............................................................................................... 81
Security: ..................................................................................................................... 81
Range use: Interaction with agents of disturbance/competition ............................. 81
Disturbance: .............................................................................................................. 81
Competitors: .............................................................................................................. 81
Range use: Mortality factors ...................................................................................... 81
Potential limiting factors and threats ......................................................................... 82
Mountain Goat........................................................................................................... 83
Published species accounts ...................................................................................... 83
Distribution ................................................................................................................ 83
Provincial range: ........................................................................................................ 83
Elevation range: .......................................................................................................... 83
Provincial context: ..................................................................................................... 83
General ecology and life history ................................................................................ 84
Reproduction: .............................................................................................................. 84
Movements and home range: ..................................................................................... 84
Feeding habits: .......................................................................................................... 84
Range use: Life requisites ........................................................................................... 84
General: ..................................................................................................................... 84
Foraging habitat/mineral licks: ................................................................................ 85
Cover from thermal extremes: .................................................................................. 85
Natal sites/denning/nesting: ...................................................................................... 85
Security: ..................................................................................................................... 85
Range use: Interaction with agents of disturbance/competition ............................ 85
Disturbance: .............................................................................................................. 85
Competitors: .............................................................................................................. 85
Range use: Mortality factors ...................................................................................... 85
Potential limiting factors and threats ......................................................................... 86
Grizzly Bear ................................................................................................................ 87
Published species accounts ...................................................................................... 87
Distribution ................................................................................................................ 87
Provincial range: ........................................................................................................87
Elevation range: ........................................................................................................87
Provincial context: .....................................................................................................87
General ecology and life history .................................................................................88
Reproduction: ...............................................................................................................88
Movements and home range: .....................................................................................88
Feeding habits: ...........................................................................................................88
Range use: Life Requisites ...........................................................................................89
General: ......................................................................................................................89
Foraging habitat: ...........................................................................................................89
Cover from thermal extremes: ...................................................................................89
Natal sites/denning/nesting: ......................................................................................89
Security: ......................................................................................................................90
Range use: Interaction with agents of disturbance/competition ..............................90
Disturbance: ..............................................................................................................90
Competitors: ..............................................................................................................90
Range use: Mortality factors .......................................................................................90
Potential limiting factors and threats .......................................................................90
Pine Marten ..................................................................................................................92
Published species accounts .......................................................................................92
Distribution ..................................................................................................................92
Provincial range: ........................................................................................................92
Elevation range: ..........................................................................................................92
Provincial context: ......................................................................................................92
General ecology and life history ................................................................................93
Reproduction: ..............................................................................................................93
Movements and home range: ....................................................................................93
Feeding habits: ..........................................................................................................93
Range use: Life Requisites ..........................................................................................93
General: ......................................................................................................................93
Foraging habitat: ........................................................................................................94
Cover from thermal extremes: ..................................................................................94
Natal sites/denning/nesting: .....................................................................................94
Security: ......................................................................................................................94
Range use: Interaction with agents of disturbance/competition ..............................94
Disturbance: ..............................................................................................................94
Competitors: .............................................................................................................94
Range use: Mortality factors ................................................................. 94
Potential limiting factors and threats .................................................. 95
Wolverine ............................................................................................. 96
Published species accounts ............................................................... 96
Distribution .......................................................................................... 96
  Provincial range: ................................................................................ 96
  Elevation range: ................................................................................. 96
  Provincial context: ............................................................................. 96
General ecology and life history .......................................................... 97
  Reproduction: .................................................................................... 97
  Movements and home range: ............................................................ 97
  Feeding habits: .................................................................................. 97
Range use: Life Requisites ................................................................... 97
  General: ............................................................................................. 97
  Foraging habitat: .............................................................................. 98
  Cover from thermal extremes: ......................................................... 98
  Natal/denning/nesting: ................................................................. 98
  Security: ........................................................................................... 98
  Disturbance: .................................................................................... 99
  Competitors: ................................................................................... 99
Range use: Mortality factors .............................................................. 99
  Potential limiting factors and threats .............................................. 99
Literature Cited ................................................................................ 100

APPENDIX C. MODEL PROCESSING AND SEQUENCE OF ACTIVITIES ...... 111
  Introduction ..................................................................................... 111
  Input Data Gathering and Management ......................................... 111
  Modeling Tools and Sequence of Use ............................................ 112
  Modeling Steps ............................................................................... 114
  Literature Cited ............................................................................... 116

APPENDIX D: EMPIRICAL DERIVATION OF WILDFIRE DISTRIBUTION .... 117

APPENDIX E: FC_ID RASTER AND LAYER TABLE DEVELOPMENT ...... 118
  List of Inputs ................................................................................... 118
  FC_ID Raster Development............................................................ 118
  Layer Table Development .............................................................. 120

LITERATURE CITED ................................................................................. 121

APPENDIX F: MULTI-SPECIES HABITAT SUPPLY MODEL RUN PROCEDURE ... 122
1. Run 1 - Create Res1 Grid ................................................................. 122
2. Run 1 - Export Case File to Netica .................................................... 122
3. Run 1 - Process Cases in Netica ......................................................... 123
4. Run 1 - Import results to Access and Export to ArcView ...................... 123
5. Run 1 – GIS Processing ....................................................................... 124
6. Run 1 – Create Carrying Capacity and Standard Deviation Grids ............. 124
7. Run 1 – Create Proximity Grids .......................................................... 125
8. Run 2 – Create Res2 Grid .................................................................... 126
9. Run 2 – Export Case File to Netica ...................................................... 126
10. Run 2 – Process Cases in Netica.......................................................... 126
11. Run 2 - Import results to Access and Export to ArcView ...................... 126
12. Run 2 – GIS Processing ..................................................................... 127
13. Run 2 – Create Proximity Grids ......................................................... 127
14. Run 2 – Create Marten Carrying Capacity and Std. Deviation Grid ........... 128
15. Run 3 – Create Res3 Grid .................................................................... 129
16. Run 3 – Export Case File to Netica ...................................................... 129
17. Run 3 – Process Cases in Netica .......................................................... 130
18. Run 3 – Import results to Access and Export to Table & GIS Processing ...... 130
19. Run 3 – Create Carrying Capacity and Standard Deviation Grids ............. 131
20. Run 4 – Create Res4 Grid .................................................................... 132
21. Run 4 – Export Case File to Netica ...................................................... 132
22. Run 4 – Process Cases in Netica .......................................................... 133
23. Run 4 – Import results to Access and Export to Table & GIS Processing ...... 133
24. Run 4 – Create Carrying Capacity and Standard Deviation Grids ............. 134
25. Post-Processing – Remove Woodland Caribou Low Winter Habitat That Isn’t Near High Winter Habitat .................. 135
26. Post-Processing – Remove Water From Mosaicked Grids........................ 135
27. Post-Processing – Remove Woodland Caribou From Mountain Caribou Areas .... 135
28. Post-Processing – Remove Mountain Caribou From Woodland Caribou Areas ... 136
29. Post-Processing – Round Off Large Values ........................................... 136
30. Post-Processing – Create Final Grids For Delivery .................................. 136

APPENDIX G. INFLUENCE DIAGRAMS ................................................. 138
LIST OF TABLES

Table A. Cavity nesting birds with highest use of lodge pole pine whereas bolded species are considered strong candidates for modeling. ................................................................. 4

Table B. Cavity nesting birds associated with hardwoods (after Bunnell et al 2004) whereas bolded species are considered strongest candidates for modeling. ........................................ 4

Table C. Highest priority species based on CF Goal 1, 2, and 3 scores whereas bolded species were considered for modeling .......................................................... 6

Table D. G4 ranked (highest level of Global) in the Quesnel District whereas bolded species were considered from modeling. .......................................................... 7

Table E. COSEWIC Terrestrial vertebrates that are Threatened or a Species of Concern in Quesnel (From Conservation Framework database 2010) whereas bolded species were considered from modeling. .......................................................... 8

Table F. Identified Wildlife Management Strategy Species in Quesnel Forest District (MOE 2004) ........................................................................................................... 9

Table G. Target species based on CF as applied to the Central Interior Ecoregion whereas bolded species are potential candidates. ......................................................... 11

Table H. Wildlife Species identified by Investment Account Rational whereas bolded species are included for modeling. ................................................................. 13

Table I. Species recommended for inclusion in the Quesnel District Habitat modeling project whereas bolded species have existing models developed. ........................................ 16

Table J. A list of data inputs contributing to case files used by Netica™ in processing causal-web models for the species modeled in the study area we used. ......................... 112

Table K. Sequence of model implementation for developing estimates of species occurrence throughout the study area in north-central British Columbia. ......................... 115

LIST OF FIGURES

Figure 1. An influence diagram depicting the ecological relationships between input nodes (blue) and the probability of habitat occupancy (green) by moose. ............................. 139

Figure 2. An influence diagram depicting the ecological relationships between input nodes (blue) and many different ecological proxy variables (red) used in species habitat supply modeling. ................................................................. 140
APPENDIX A: SPECIES LIST FOR THE QUESNEL MULTI-SPECIES HABITAT SUPPLY MODELLING PROJECT

Contributed by Mike Fenger¹, Scott McNay² and Anne Chan-McLeod³

Introduction

Wildlife species from nine previous studies and initiatives relevant to the Quesnel District were assessed against four criteria to select the species for modeling. The studies and initiatives reviewed were: 1) Bunnell et al. 2004, 2) Ministry of Environment (MOE) Conservation Framework, 3) Nature Conservancy of Canada 2009 Central Interior Ecoregional Assessment, 4) MOE 2004 Identified Wildlife Management Strategy, 5) Sutherland and McNay 2009, 6) Cariboo-Chilcotin Land Use Plan, 7) Silviculture Strategies Type 1, 2 and 3, 8) McNay and Sutherland 2009 and 9) Price, Waterhouse and Coopers 2010 Forest Investment Account rational.

The habitat modeling project may have resources to consider 14 to 20 species. It was estimated that for a single species ~30 model runs may be needed during the course of the project in order to forecast probable habitat conditions for 3 management scenarios at some future state past current i.e. 20 to 80 years hence. Developing habitat models means that the species and its life requisites are used to inform management decisions and tradeoffs. The selection of species therefore needs to be carefully considered from the outset. Single species models (fine filter conservation decision support) are intended to supplement (coarse filter) habitat indicators. Terrestrial species (mammals and birds) were selected but the importance of aquatic vertebrates (fish) is acknowledged and these species are in-scope for a second phase in this two year project (Phil Winkle pers comm.).

Species Selection Criteria and Intent

The Jan 18th 2010 meeting of the Quesnel Mitigation Committee (QMC) and the project team identified four criteria to guide single species selection for the purposes of habitat supply modeling and decision support. As a result of the reviewer suggestions Species at Risk Act and the Global rankings are considered separately and information shown separate of the Conservation Framework (CF) so that forest managers can track and integrate these in their planning and strategic decisions. The Conservation Framework focuses on priorities linked to Goal 1, 2, and 3 scores. In addition species identified by the Price et al. 2010 and Forest Investment Account rational are also included.

¹ Mike Fenger and Associates Ltd. http://www.mikefengerandassociates.com/
² Wildlife Infometrics http://www.wildlifeinfometrics.com/
³ Wildlife Research Associate. Forest Science UBC https://www.directory.ubc.ca/index.cfm?page=personDetail&row=123910738
Criteria 1) Forest-dependent species vulnerable to cumulative effects of extensive natural disturbances, forest harvest and salvage

This criterion was used to eliminate species closely associated with grasslands, wetlands and lakes and less. This project is to develop a decision support tool for forest managers and therefore the focus needs to be on species most directly affected by forestry practices or so called forest dependent species. Forests are affected by natural disturbances such as mountain pine beetle and wildfires as well as the cumulative impacts to ecosystems of previous harvesting and roads. There is some discretion on which species to select and prefer was given to species most closely tied to forests and by inference potentially most vulnerable.

Criteria 2) Seral Stage Specialist Species

Some species thrive in early seral conditions and other are older forest obligates. This criterion was used to show which species may be most confidently linked to timber supply forest casts. No species were added based on this criterion. Forest estate models use growth and yield to forecast seral stages so species which show strong preferences for specific seral stages will have more robust habitat forecasts and interpretations.

Criteria 3) Provincial Conservation Framework Priority Species

The Conservation Framework (CF)\(^4\) was developed by the Ministry of Environment to achieve goals that:

- Contribute to global efforts for species and ecosystem conservation
- Prevent species and ecosystems from becoming at risk
- Maintain the diversity of native species and ecosystems

There is a desire to support provincially identified conservation needs by using the CF to strengthen integration. This allows licensees and government to work together towards commonly understood species and ecosystems of concern and integrate conservation priorities, MOE 2009.

Criteria 4) Species from Land Use Plans, First Nations and FIA Rational

The land use plan has identified species which are socially important\(^5\). The plan species culturally important such as (deer and moose) have also been included for investment under the Forest Investment Account (FIA) rational. FIA has invested in some species linked to forest management and this too was used as an indicator of social importance.

\(^4\) [http://www.env.gov.bc.ca/conservationframework/](http://www.env.gov.bc.ca/conservationframework/) An excel spreadsheet was provided to the QMC listing species and ecosystems and the ranking systems maintained by Conservation Framework. (Thanks to Claudia Houwers)

\(^5\) The Cariboo-Chilcotin Land Use plan (CCBLUP) provides social direction through Resource Management Zones and resource objectives within the plan area. The most notable special management zones were established to protect winter ranges but important wetlands. The location and objectives for these zones can be found online at: [http://ilmbwww.gov.bc.ca/slrp/lmp/williamslake/cariboo_chilcotin/index.html](http://ilmbwww.gov.bc.ca/slrp/lmp/williamslake/cariboo_chilcotin/index.html) and the maps at [ftp://ftpwmli.env.gov.bc.ca/dist/Cariboo-Chilcotin%20LUOR%20Order/maps/](ftp://ftpwmli.env.gov.bc.ca/dist/Cariboo-Chilcotin%20LUOR%20Order/maps/)
The report on the Central Interior Ecoregional Assessment was also included under this criterion.

**Review of reports identifying species**

The nine reports were reviewed and tables were generated from some reports and the rational for selection of species from these reports used with the criteria and lead to species for modeling.

*Bunnell report on species affected by mountain pine beetle and salvage*

This report was written to evaluate the effects of large-scale salvage logging for mountain pine beetle on terrestrial and aquatic vertebrates. Criteria 1 and 2 were considered simultaneously by Bunnell et al. 2004 and thus they are considered together in Table A and Table B. Table A focuses on cavity excavators most closely linked to pine. Table B includes nest records of primary excavators and secondary cavity birds that used hardwood (mostly aspen). Cavity dwelling species associations, habitat selection and the degree of influence on forestry were confirmed using information in Fenger et al. 2006, Campbell and Kennedy 2009 and Identified Wildlife Management Strategy (IWMS) MOE 2004.

Four primary cavity excavators use late seral pine to some extent. Black-backed Woodpecker (BBWO) shows the highest selection preference for later seral pine and lowest preference for late seral hard wood. White breasted nuthatch is a weak cavity excavator selecting trees in later stages of decay and was removed at this initial stage as it is considered less of a keystone species with less influence on nest webs and secondary cavity users.

Table B also show bird species which either excavate or use cavities. This is a longer species list than in Table B because it includes nests in hardwoods. Hardwoods are less affected by forest harvesting as conifers are the dominant and preferred tree species harvested in the Quesnel Timber Supply Area. Only strong primary cavity excavators were highlighted as candidates as it was reasoned that weaker excavators and secondary cavity users will also be provided for when the strong primary excavators have suitable habitat. Black capped chickadee and white-breasted nuthatch were therefore eliminated as they are weak cavity excavators. Three-toed woodpecker is a potential modeling candidate because it sometimes uses pine for nesting though it prefers hardwoods. The Northern Flicker (NOFL) is a strongly excavator and a candidate. NOFL is widespread and responsible for most of the nest cavities in the Quesnel District. Species like NOFL is considered a keystone species for cavities for water fowl, owls and bats. The NOFL has the highest number of nest records in Table B. Nest record may indicate survey effort however it is also considered a reflection that NOFL occurs in generally higher numbers. This was confirmed by the Cooper Manning and Associates avian dataset collected in the Quesnel area, which detected lots of NOFL but no Three-toed woodpecker (TTWO) or Hairy Woodpecker (HAWO). Nest webs and interactions between primary and secondary cavity species have been more

---

6 Data from Bunnell et al 2004. Table 1. Percent of cavity sites in lodgepole pine and in hardwoods for cavity-nesting bird species present in the three Timber Supply Areas (study area includes Quesnel TSA)
Table A. Cavity nesting birds with highest use of lodge pole pine whereas bolded species are considered strong candidates for modeling.

<table>
<thead>
<tr>
<th>Cavity Nesting Species</th>
<th>Nest Rec</th>
<th>% Lodgepole</th>
<th>% Hardwoo</th>
<th>Successional Stage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Black-backed Woodpecker (BBWO)</td>
<td>81</td>
<td>71.4</td>
<td>0.8</td>
<td>L</td>
</tr>
<tr>
<td>White-breasted Nuthatch</td>
<td>28</td>
<td>22.2</td>
<td>11</td>
<td>L</td>
</tr>
<tr>
<td>Three-toed Woodpecker</td>
<td>81</td>
<td>20.3</td>
<td>79.8</td>
<td>L</td>
</tr>
<tr>
<td>Hairy Woodpecker</td>
<td>346</td>
<td>16.9</td>
<td>39.4</td>
<td>L</td>
</tr>
</tbody>
</table>

Table B. Cavity nesting birds associated with hardwoods (after Bunnell et al 2004) whereas bolded species are considered strongest candidates for modeling.

<table>
<thead>
<tr>
<th>Cavity Nesting Species</th>
<th>Nest Rec</th>
<th>% Lodgepole</th>
<th>% Hardwoo</th>
<th>Seral Stage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yellow-bellied Sapsucker (YBSS)</td>
<td>107</td>
<td>0</td>
<td>89.6</td>
<td>L</td>
</tr>
<tr>
<td>Black-capped Chickadee</td>
<td>109</td>
<td>0</td>
<td>87.5</td>
<td>G</td>
</tr>
<tr>
<td>Downy Woodpecker (DOWO)</td>
<td>105</td>
<td>0</td>
<td>81.3</td>
<td>L</td>
</tr>
<tr>
<td>Three-toed Woodpecker (TTWO)</td>
<td>81</td>
<td>20.3</td>
<td>79.8</td>
<td>L</td>
</tr>
<tr>
<td>Bufflehead</td>
<td>228</td>
<td>3.1</td>
<td>60</td>
<td>G</td>
</tr>
<tr>
<td>Hooded Merganser</td>
<td>38</td>
<td>0</td>
<td>57.9</td>
<td>G</td>
</tr>
<tr>
<td>Boreal Chickadee</td>
<td>18</td>
<td>0</td>
<td>56.0</td>
<td>L</td>
</tr>
<tr>
<td>Mountain Chickadee</td>
<td>206</td>
<td>0</td>
<td>55</td>
<td>L</td>
</tr>
<tr>
<td>Northern Saw-whet Owl</td>
<td>31</td>
<td>0</td>
<td>51.6</td>
<td>M-L</td>
</tr>
<tr>
<td>Barred Owl</td>
<td>8</td>
<td>0</td>
<td>50.0</td>
<td>M-L</td>
</tr>
<tr>
<td>Northern Flicker (NOFL)</td>
<td>998</td>
<td>9.9</td>
<td>44.7</td>
<td>G</td>
</tr>
<tr>
<td>Barrow’s Goldeneye</td>
<td>44</td>
<td>2</td>
<td>43.2</td>
<td>G</td>
</tr>
<tr>
<td>Common Merganser</td>
<td>53</td>
<td>0</td>
<td>39.6</td>
<td>G</td>
</tr>
<tr>
<td>Hairy Woodpecker (HAWO)</td>
<td>346</td>
<td>16.9</td>
<td>39.4</td>
<td>L</td>
</tr>
</tbody>
</table>

Late = Late, General = G, Mid to Late Successional Stages
intensively studied in forests south of Quesnel, Martin et al. 2004. Martin et al. 2006 concluded that NOFL was the key cavity excavator within their study area and a keystone species in the ecosystem. The other two primary cavity excavators identified by Bunnell et al 2004 that could be modeled are the Yellow-bellied Sapsucker and the Downy Woodpecker. YBSS may not occur in the Quesnel and thus was eliminated based on (Campbell and Kennedy 2009) distribution maps. DOWO is the smallest of the woodpeckers with a hardwood preference and was eliminated as it was considered less of a keystone species than NOFL and that managing for NOFL was considered likely to provide for DOWO and also for sapsuckers should they occur. The potential number and distribution of a species selected for modeling becomes important if there is follow-up field work done to confirm model assumptions and strength of relationship between factors. Species that are uncommon become costly to sample to statistically significant sample sizes when occurrences are naturally low. Thus species such as NOFL have higher appeal for field sampling purposes.

All the chickadees are weak cavity excavators and require trees with advanced decay but they do also use old woodpecker cavities. Though the four weak cavity excavators were identified and could be modeled none were selected. It is considered better to focus on stronger excavators because if their habitat is supplied weaker excavators may also be provided for.

Four cavity nesting ducks and an owl could be modeled but only one Barrow Goldeneye was identified as it also met the CF criterion.

Two open nesting birds were identified by Bunnell et al 2004. Blue Heron nest records show a preference for late seral cottonwood in riparian ecosystems. It is unclear how much cottonwood occurs in the TSA and whether forestry activities will have a major impact on cottonwood where it occurs. Northern Goshawk, the atricapillus subspecies occurs in the Quesnel District and is known to be sensitive to forest harvesting (Cooper and Stevens 2000; Fenger et al 2006) Campbell and Kennedy 2009 note that this species is an uncommon resident in the interior. Bunnell et al. 2004 note “that lodgepole pine is not a favoured habitat of the goshawk. Provided other tree species are reserved from harvest it should not be impacted by large-scale salvage operations. Prey-response to increased early seral stage may benefit the species”. Though the interior species of goshawk are not threatened they are of management interest and were considered worthy of inclusion as they may impact location of forestry operations location and as there is a need to know potential fluctuations habitat availability at a landscape level. Both were included and were given weight as they were included in reports too.

Bunnell et al 2004 include ungulates, grizzly bear and furbears but discussion of these is left to criteria 3 and 4.

**Conservation Framework**

Ministry of Environment is using the Conservation Framework (CF) to identify priority conservation species and ecosystem. At the request of the project team a data base (excel spreadsheet) was provided by staff in MOE. The Conservation Framework (CF)7

---

was announced in 2008 as a government initiative lead by Ministry of Environment and a means to optimize allocation of resources by prioritizing conservation efforts on species and ecosystems based on multiple parameters for the three goals and determine the most appropriate and effective management actions.

Goal 1: To contribute to global efforts for species and ecosystems conservation
Goal 2: To prevent species and ecosystems from becoming at risk
Goal 3: To maintain the full diversity of native species and ecosystems

We used the Conservation Framework goal rankings for each species (excluding fish, listed ecosystems and plants) to derive a list of wildlife species that best met each of the three goals in the Quesnel Forest District. To establish the “best met” criteria we sorted the species based on the sum of their three goal scores; first taking a straight sum of the scores then by iteratively de-emphasizing the importance of one of the goals relative to the other two. If a species was important (i.e., scored less than 11) in more than 2 of these sorts then it was retained as a candidate for modeling and are shown in Table C.

The CF also defines specific actions for the species and provides direction actions such as; review or compile a status report, conduct inventory, monitor species population trend, a review species taxonomy and classification. This information may be needed to assemble data to support listing decisions by COSEWIC or to include a species under the Wildlife Act. There may also be a number of species-specific measures identified such as habitat protection, restoration and options for species and population management etc. The project team will need work with MOE and through course of the modeling project understand what CF tasks may need to take place in the Quesnel Forest District and who may be the lead for CF actions. As a result of CF scores for mountain goat, wolverine, and rusty blackbird are included in the modeling project. Caribou, Barrow’s Goldeneye and Grizzly are also on the CF list and their inclusion supported from CF and other criterion too.

Table C. Highest priority species based on CF Goal 1, 2, and 3 scores whereas bolded species were considered for modeling.

<table>
<thead>
<tr>
<th>Species</th>
<th>Habitat considerations</th>
</tr>
</thead>
<tbody>
<tr>
<td>Caribou (N.population)</td>
<td>Forest habitat user</td>
</tr>
<tr>
<td>Grizzly Bear</td>
<td>Forest Landscape user</td>
</tr>
<tr>
<td>Wolverine</td>
<td>Forest Landscape user</td>
</tr>
<tr>
<td>Mountain Goat</td>
<td>Limited distribution; species is declining provincially</td>
</tr>
<tr>
<td>Barrow’s Goldeneye</td>
<td>Secondary cavity user near wetlands</td>
</tr>
<tr>
<td>Rusty Blackbird</td>
<td>Black Spruce wetlands, beaver dams with dead flooded trees</td>
</tr>
<tr>
<td>Harlequin Duck</td>
<td>Shallow clear fast flowing water and riparian</td>
</tr>
<tr>
<td>Western Toad</td>
<td>Resolution of data needed to fine</td>
</tr>
<tr>
<td>Columbia Spotted Frog</td>
<td>Resolution of data needed to fine</td>
</tr>
<tr>
<td>Long Billed Curlew</td>
<td>grassland obligate</td>
</tr>
</tbody>
</table>
Global, National and Identified Wildlife Management Strategy Species

**Global Ranking**

When sorted by global rank, 11 species were classified as G4 which was the highest ranked class in the Quesnel District. A G4 classification means the species is “apparently secure” while a G5 classification means the species is secured. The species shown as G4 were reviewed and their association with forests are shown in Table D. Three species were highlighted as potential candidates for the project. White Pelican is associated with lake and islet habitat in forested landscapes and has received protection of much of its critical habitat though there is vulnerability linked to the condition of feeding lakes. Rusty Blackbird, American Bittern Harlequin Duck, Black tern occur in forested landscape where their habitat requirements are most closely linked to

Table D. G4 ranked (highest level of Global) in the Quesnel District whereas bolded species were considered from modeling.

<table>
<thead>
<tr>
<th>Listed vertebrates</th>
<th>Habitat Association</th>
</tr>
</thead>
<tbody>
<tr>
<td>Black Swift</td>
<td>Cliff nesting</td>
</tr>
<tr>
<td><strong>Rusty Blackbird</strong></td>
<td>Spruce bog, swamps and beaver ponds</td>
</tr>
<tr>
<td>Olive-sided Flycatcher</td>
<td>Conifer and mixed wood habitat near wetlands</td>
</tr>
<tr>
<td>American White Pelican</td>
<td>Barren lake islands and islets, shallow lakes</td>
</tr>
<tr>
<td>American Bittern</td>
<td>Wetlands</td>
</tr>
<tr>
<td>Harlequin Duck</td>
<td>Fast moving water ground nesting sites</td>
</tr>
<tr>
<td>Black Tern</td>
<td>Shallow water marshes and ponds</td>
</tr>
<tr>
<td><strong>Grizzly Bear</strong></td>
<td>Forested landscapes</td>
</tr>
<tr>
<td>Grey Wolf</td>
<td>Forested landscapes</td>
</tr>
<tr>
<td><strong>Western Toad</strong></td>
<td>Wetland - open water - forested habitats</td>
</tr>
<tr>
<td>Columbia Spotted Frog</td>
<td>Wetland</td>
</tr>
</tbody>
</table>

8 Global Ranking:
1- Critically Imperilled Because of extreme rarity or some factor(s) making it especially susceptible to extirpation or extinction. Typically 5 or fewer existing occurrences or very few remaining individuals, e.g., fewer than 1000 Spotted Owl.
2- Imperilled Because of rarity or some factor(s) making it very susceptible to extirpation or extinction. Typically 6 to 20 existing occurrences or few remaining individuals, e.g., 1000 to 3000 White Sturgeon.
3- Vulnerable because rare and local, found only in a restricted range (even if abundant at some locations), or because of some other factor(s) making it susceptible to extirpation or extinction. Typically 21 to 100 existing occurrences, e.g., Gopher Snake.
4- Apparently Secure because uncommon but not rare, and usually widespread in the province. Possible cause for long-term concern. Typically more than 100 existing occurrences, e.g., Olive-sided Flycatcher.
5- Secure because common to very common, typically widespread and abundant, and not susceptible to extirpation or extinction under present conditions, e.g., Red-osier Dogwood.
? Unranked: Rank not yet assessed.
U Unrankable; Due to current lack of available information.
aquatic habitats such as streams and wetlands. Olive-sided Flycatcher uses a mix of forest types and required more detailed review but too was removed from inclusion as a candidate. Grizzly bear and Grey Wolf are both forest landscape users. The links between forest management and grizzly bear and forest seral stages and forage are more direct, Wood and Hamilton 2001. Grizzly bear was included as it was mentioned in the CF and IWMS whereas grey wolf only appears under global ranking.

**National (COSEWIC)**

The COSEWIC (Committee on the Status of Endangered Wildlife in Canada) ratings were used to show what species are listed in the Quesnel Forest District. Table E shows 9 species some at the population level, rated as Threatened (T) or as a Species of Concern (SC). The five species highlighted have an association with forested habitat and are potential candidates for inclusion. Olive-sided flycatcher was considered to be reasonably flexible in its habitat selection and may benefit from the current surge in early seral forests. It did not score as high under the CF as Rusty Blackbird and therefore was not kept.

Table E. COSEWIC Terrestrial vertebrates that are Threatened or a Species of Concern in Quesnel (From Conservation Framework data base 2010) whereas bolded species were considered from modeling.

<table>
<thead>
<tr>
<th>Common Name</th>
<th>COSEWIC *</th>
<th>Habitat associations</th>
</tr>
</thead>
<tbody>
<tr>
<td>Caribou (N mtn. population)</td>
<td>T/SC</td>
<td>Terrestrial Lichen mature Pine</td>
</tr>
<tr>
<td>Caribou (S. population)</td>
<td>T</td>
<td>Arboreal lichen Late succession</td>
</tr>
<tr>
<td>Common Nighthawk</td>
<td>T</td>
<td>Open Forest Grassland</td>
</tr>
<tr>
<td>Olive-sided Flycatcher</td>
<td>T</td>
<td>Conifer and mixed wood edge habitat near</td>
</tr>
<tr>
<td>Short-eared Owl</td>
<td>SC</td>
<td>Open forest-grassland</td>
</tr>
<tr>
<td>Long-billed Curlew</td>
<td>SC</td>
<td>Grasslands</td>
</tr>
<tr>
<td>Rusty Blackbird</td>
<td>SC</td>
<td>Spruce bog, swamps and beaver ponds</td>
</tr>
<tr>
<td>Grizzly Bear</td>
<td>SC</td>
<td>Mixed forest landscapes all seral stages</td>
</tr>
<tr>
<td>Western Toad</td>
<td>SC</td>
<td>permanent or temporary water bodies that have</td>
</tr>
</tbody>
</table>

* T=Threatened \ SC = Species of Concern

**Identified Wildlife Management Strategy**

Table F is a list of species from the Identified Wildlife Management Strategy for the Quesnel Forest District. Of the six bird species listed in Table E Blue Heron and Sharp tailed Grouse had the closest association with forestry activities. White Pelican, as mentioned previously, has received habitat protection and is considered as an aquatic obligate. Curlew, shorted eared owls and sharp tailed grouse are most closely associated with grasslands and open forests. Sandhill Crane is a wetland nester and may be indirectly affected by changes in water tables but may be best considered when hydrology and wetlands are considered.
Table F. Identified Wildlife Management Strategy Species in Quesnel Forest District (MOE 2004)

<table>
<thead>
<tr>
<th>Common Name</th>
<th>BOV</th>
<th>CAB</th>
<th>CAM</th>
<th>CAP</th>
<th>NAU</th>
<th>QUH</th>
<th>QUL</th>
<th>WCU</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fish</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bull Trout</td>
<td></td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Birds</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>American White Pelican</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Columbian Sharp-tailed Grouse</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Great Blue Heron</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Long-billed Curlew</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sandhill Crane</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Short-eared Owl</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mammals</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Badger</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fisher</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Grizzly Bear</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mountain Caribou</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Northern Caribou</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Wolverine</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Plant communities</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Alkali Saltgrass herbaceous vegetation</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Douglas-fir/Common Juniper/Cladonia</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Hybrid White Spruce/Ostrich Fern</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Table F also lists five mammals. These were assessed as follows:

- **Badger distribution** is shown to be at the northern edge of the range and very restricted in the Quesnel District (MOE 204 pp 335). Additional review of badger research indicates there is no on-going recovery work this far north. This reduces the need to include badgers and they were not elevated to the potential candidates list.

- **Potential wolverine habitat** is shown as rare and poor (MOE 2004 map on p382). This reduced the appeal for inclusion for decision support and modeling this species; however it was identified by the CF and was included.

- **Three grizzly bear management units** are shown in the Quesnel District. One with bears “Extirpated from the central portion of the Quesnel District”, a second shows a management unit in which populations are viable (eastern portion) and the third management unit in which the population is threatened (western portion). There is definitely a need to include Grizzly bear for forest management decisions.

- **Potential Fisher habitat** was shown to be well distributed within the Quesnel District.

- **Mountain caribou populations** ranked as threatened occur in the east. Considerable changes have occurred since 2004 so both caribou groups need to be included as their management is very strongly linked to forestry.

*McNay and Sutherland 2009*

McNay and G. Sutherland 2009 completed habitat supply models and applied these to three management units in the northern Quesnel Forest District. Five species were
selected to evaluate the impacts of changes in seral stage distribution resulting from the mountain pine beetle epidemic and from salvage logging (some species were separated into different analysis based on differences in seasonal needs and population differences and so effectively there were 8 models developed and applied). Their 5 species, for which models have now been developed, are: 1) wolverine, 2) fisher, 3) northern caribou high-elevation, 4) northern caribou low-elevation, 5) mountain caribou early winter, 6) mountain caribou late winter, 7) grizzly bear spring, and 8) grizzly bear summer for modeling. The need to continue modeling on wolverine and fisher in the Quesnel was considered low priority and these species were not recommended. Caribou and grizzly bear were expected to have a strong future influence and are recommended.

Silviculture Strategies

Type 1, 2, and 3 Silviculture Strategies (Cortex and Fenger 2006; Buell et al. 2008) were also reviewed as these studies listed single species of concern and impacted by forest management decisions. The Type 1 strategy listed species of concern (Appendix G) and briefly describes their habitat preferences. Ten species were listed:

1- Great blue heron
2- Sandhill crane
3- Northern goshawk
4- Grizzly Bear
5- Fisher
6- Pine Marten
7- Wolverine
8- Moose
9- Mule Deer
10- Northern Mountain Caribou

These 10 species are recommended for inclusion in the Quesnel decision support model. The Type 3 Silviculture Analysis report (Buell et al. 2008) selected moose and mule deer for single species assessment and provided a summary of changes in important habitats and land use polygons linked to pine content (pp 54 – 56). Some coarse filter assessment was also completed and comparison of seral stages within landscape units and whether the older seral retention could be met outside the current Timber harvest land base.

Central Interior Eco-Regional Assessment

Nature Conservancy Canada (NCC) prepared an Ecoregional Assessment which included much of the interior of British Columbia and all of the Quesnel TSA. Focal species were defined as species that have spatial, compositional, and functional requirements that may encompass other species in the region and may help address the functionality of ecological systems. It was also noted that focal species may not always be captured by coarse filter conservation provisions. Table G lists the species that were assessed by NCC. Eighteen species out of the thirty eight identified in Central Interior Ecoregion were considered as potential candidates. The Central Interior Ecoregion was

---

used to approximate the Quesnel District area. This project worked closely with the Conservation Framework. Approximate habitat needs are listed in Table F and provide the rational for why some of the species were excluded. Nagorsen and Brigham 1993 shows that specimen records for bats were along the main stem of the Fraser River further south are linked to cliff habitat. None of the bat species listed as secondary

Table G. Target species based on CF as applied to the Central Interior Ecoregion whereas bolded species are potential candidates.

<table>
<thead>
<tr>
<th>Species</th>
<th>Habitat associations</th>
</tr>
</thead>
<tbody>
<tr>
<td>1- American Avocet</td>
<td>Grasslands</td>
</tr>
<tr>
<td>2- American Kestrel</td>
<td>Open dry forests grassland; clear cuts</td>
</tr>
<tr>
<td>3- American White Pelican</td>
<td>Lake and islet habitat</td>
</tr>
<tr>
<td>4- Badger, Jerffersonii ssp</td>
<td>Open forest (at northern end of range)</td>
</tr>
<tr>
<td>5- Barrow’s Goldeneye</td>
<td>Cavity user near open water wetlands</td>
</tr>
<tr>
<td>6- Bighorn Sheep</td>
<td>Grassland</td>
</tr>
<tr>
<td>7- Bobolink</td>
<td>Grassland</td>
</tr>
<tr>
<td>8- Broad-winged Hawk</td>
<td>Likely not in area (Campbell and Kennedy 2009)</td>
</tr>
<tr>
<td>9- Canada Lynx</td>
<td>Forest landscape</td>
</tr>
<tr>
<td>10- Caribou</td>
<td>Forest landscape</td>
</tr>
<tr>
<td>11- Caspian Tern</td>
<td>Grasslands and open water wetlands and lakes</td>
</tr>
<tr>
<td>12- Clark’s Nutcracker</td>
<td>White bark pine preference.</td>
</tr>
<tr>
<td>13- Common Garter Snake</td>
<td>Open habitat grassland clearcut</td>
</tr>
<tr>
<td>14- Double-crested Cormorant</td>
<td>Lakes</td>
</tr>
<tr>
<td>15- Eared Grebe</td>
<td>Open water wetlands</td>
</tr>
<tr>
<td>16- Fisher</td>
<td>Forest landscape</td>
</tr>
<tr>
<td>17- Fringed Myotis</td>
<td>Cliffs</td>
</tr>
<tr>
<td>18- Great Blue Heron</td>
<td>Forested Riparian</td>
</tr>
<tr>
<td>19- Grizzly Bear</td>
<td>Forest landscape</td>
</tr>
<tr>
<td>20- Lesser Scap</td>
<td>Emergent vegetation wetlands</td>
</tr>
<tr>
<td>21- Long-Billed Curlew</td>
<td>Grasslands</td>
</tr>
<tr>
<td>22- Mountain Goat</td>
<td>Partial use of Forests limited occurrence</td>
</tr>
<tr>
<td>23- Mule Deer</td>
<td>Forest landscape</td>
</tr>
<tr>
<td>24- Northern Goshawk</td>
<td>Forest landscape</td>
</tr>
<tr>
<td>25- Northern Pintail</td>
<td>Open water wetlands</td>
</tr>
<tr>
<td>26- Olive-sided Flycatcher</td>
<td>Mixed forests and edges</td>
</tr>
<tr>
<td>27- Painted Turtle</td>
<td>Open water wetlands</td>
</tr>
<tr>
<td>28- Pine Marten</td>
<td>Forest landscape late seral and CWD</td>
</tr>
<tr>
<td>29- Prairie Falcon</td>
<td>Grasslands</td>
</tr>
<tr>
<td>30- Red-breasted Sapsucker</td>
<td>Seral stage</td>
</tr>
<tr>
<td>31- Red-naped Sapsucker</td>
<td>Deciduous forests</td>
</tr>
<tr>
<td>32- Sandhill Crane</td>
<td>Wetlands</td>
</tr>
<tr>
<td>33- Sharp-tailed Grouse</td>
<td>Open grasslands nests in shrub thickets</td>
</tr>
<tr>
<td>34- Three-toed Woodpecker</td>
<td>Late seral forest</td>
</tr>
<tr>
<td>35- Townsend's Big-eared Bat</td>
<td>Cliffs</td>
</tr>
<tr>
<td>36- Western Garter Snake</td>
<td>Open habitat grassland clearcut</td>
</tr>
<tr>
<td>37- Western Toad</td>
<td>Wetlands, CWD</td>
</tr>
<tr>
<td>38- Wolverine</td>
<td>Forest landscape</td>
</tr>
</tbody>
</table>

cavity users by Fenger et al. 2006 are listed in Table G. Western garter snake is present but considered to be of low impact from forest management. This project is nearing

10 http://www.bcreptiles.ca/speciesaccount2.htm
completion but the results specific to Quesnel were not available when this report was completed.

Regionally and Culturally Identified Wildlife Species

Criteria 4. Species (terrestrial vertebrates) considered regionally important as identified in land use plans, species known to be culturally important to First Nations and species mentioned in FIA investment documents.

Cariboo Chilcotin Land Use Plan

The land use plan identifies the following species and provides mapped information (zones) and objectives for:

1. Moose
2. Grizzly bear
3. Mule deer winter ranges
4. Caribou
   a) mountain
   b) Northern

All these species were included as they met the agreed criteria. Moose and mule deer were not identified by earlier criteria but need to be included due to their social importance and their link to forests and habitat affected by forest management decisions. The land use plan identified high value wetlands for moose.

There was no source of information available from which to include culturally important species as listed by First Nations. If this information is known to members of the QMC then additional species could potentially be included. It is likely that maintaining the health and productivity of ecosystems and the complement of species used traditionally is of First Nations importance. Decision support that forecasts and incorporates coarse filter ecosystem indicators may be able to show forest changes and assess cumulative impacts to ecosystems in Quesnel.

Forest Investment Account Rational

Species identified by Forest Investment Account are also considered socially important. Investment through the FIA is expected to improve the forest asset base and support sustainable forest management practices on Crown land through:

- higher level strategic decision-making and planning
- increased timber volume and value
- increased site productivity

---

11 The Cariboo-Chilcotin Land Use plan (CCBLUP) provides social direction through Resource Management Zones and resource objectives within the plan area. The most notable special management zones were established to protect winter ranges. The location and objectives for these zones can be found online at: http://ilmbwww.gov.bc.ca/sirp/lrmp/williamslake/cariboo_chilcotin/index.html and the maps at ftp://ftpwl.env.gov.bc.ca/dist/Cariboo-Chilcotin%20LUOR%20Order/maps/ http://www.fcr.gov.bc.ca/hcp/fia/landbase.htm

12 http://www.for.gov.bc.ca/hcp/fia/landbase.htm
restored terrestrial, aquatic and riparian environments
better decision-making information and tools
infrastructure that protects public safety and mitigates environmental hazards

Table H shows the wildlife species that have had some focus from FIA funding that are described in Price, Waterhouse and Coopers 2010 FIA Land based investments under medium priority investments.

Table H. Wildlife Species identified by Investment Account Rational whereas bolded species are included for modeling.

<table>
<thead>
<tr>
<th>Species</th>
<th>Strategy and conservation direction</th>
<th>Strategic modeling</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Grizzly</td>
<td>Appropriate management for human-bear conflicts and security cover</td>
<td>Yes</td>
</tr>
<tr>
<td>2. Mule Deer</td>
<td>Appropriate management as per MDWR strategy/plans</td>
<td>Yes</td>
</tr>
<tr>
<td>3. N.&amp; Mtn Caribou</td>
<td>Appropriate management as per Caribou strategies</td>
<td>Yes</td>
</tr>
<tr>
<td>4. Mountain Goat</td>
<td>Appropriate management for winter ranges, seasonal disturbance, security cover, thermal cover and disease transmission from domestic goats</td>
<td>Yes</td>
</tr>
<tr>
<td>5. Moose</td>
<td>Appropriate management of winter security and thermal cover, key wetlands and caribou/moose interactions</td>
<td>Yes</td>
</tr>
<tr>
<td>6. Fur-bearers</td>
<td>Appropriate habitat management through landscape and stand level biodiversity</td>
<td>Pine Martin</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Wolverine</td>
</tr>
<tr>
<td>7. Sandhill Crane</td>
<td>Appropriate management of nest sites and preventing disturbance of nesting cranes</td>
<td>Hydrology phase</td>
</tr>
<tr>
<td></td>
<td></td>
<td>of project</td>
</tr>
<tr>
<td>8. Northern Goshawk</td>
<td>Appropriate management of habitat and nest sites</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td></td>
<td>of project</td>
</tr>
<tr>
<td>10. Species at risk</td>
<td>Appropriate management when identified (see Table E for COSEWIC listed species)</td>
<td>Olive-sided Flycatcher</td>
</tr>
<tr>
<td></td>
<td></td>
<td>N. Mtn Caribou</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Grizzly Bear</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Rusty Blackbird</td>
</tr>
<tr>
<td>11. Bighorn sheep</td>
<td>Appropriate management for migration and lambing areas</td>
<td>No sheep in the area</td>
</tr>
</tbody>
</table>

Species recommended for modeling

The candidate list was formed by review of all species that were identified in Tables A to F and that were highlighted as potential candidates. The recommended number of species was reduced to the 18 species shown in Table I all of which met criterion agreed to. Consideration was given to the degree to which forest management decisions would influence the capability and suitability of habitat for a species. The stronger the link to forest management decisions the stronger the case for inclusion in the wildlife account component of decision support. It was considered better to model a few species thoroughly than to model many species more crudely. A limit on the number of modelled species was also justified given this is part of a larger decision support tool that will include coarse filter ecosystem indicators and aquatic species. Single species (so called
fine filter conservation measures) can inform forest managers of the adequacy of coarse filter measures such as the pattern, types and distribution of forests retained at the landscape and watershed level. Forest managers and scenarios are expected to have the ability to vary retention levels at the stand and landscape scales, harvest patterns, species selection in harvest and reforestation decisions and understand how this benefit wildlife species.

**Primary Cavity Excavators**

Ten cavity excavators were identified within the reviewed studies. There were two species of sapsucker, four woodpecker species (strong cavity excavators) and four weaker cavity excavators (chickadee species). The two sapsucker species selected deciduous or mixed wood forests and though affected by forestry they were considered lower priority. They also occur in the lower relative densities so model verification and field work becomes more difficult. Three of the four stronger cavity excavators are recommended for modeling. Three-toed woodpecker is recommended as it may be the most sensitive to harvesting. There are some data on effects of post-mountain pine beetle salvage logging and short term post-mountain pine beetle unsalvaged forests for TTWO for Prince George that also could help with Bayesian models (Ann Chan MacLeod pers comm.). The black-backed woodpecker is recommended as it has shown a high affinity for larger older pine for nest tree selection and is also linked to burns which presents some modeling and practices challenges. Black-backed woodpecker was also included as decisions on pine salvage and the pattern and distribution of dead pine influence this species. The Northern Flicker was selected as it is the most prodigious excavator and performs a keystone role in nest webs for many secondary cavity users.

**Secondary Cavity Users**

There are numerous secondary cavity users. Barrows Goldeneye was selected as it scored high under the CF. BC’s global responsibility is also high as approximately 60 to 90% of the global population resides in BC.

**Open Tree Nesters**

There were numerous potential modeling candidates from the open nesters. Three were selected. The Northern Goshawk was selected as it was supported by the FIA rational. Great Blue Heron was listed by IWMS. Rusty Blackbird was included as it scored highest under the CF.

**Aquatic Obligates**

Sandhill Crane, Harlequin Duck and American White Pelican are considered aquatic obligates and may be best addressed when modeling watersheds and riparian conditions.
**Furbearers**

Lynx, Grey Wolf, Fisher, Wolverine and Pine Marten were all identified and Pine Marten and Wolverine were selected. There were project efficiencies in selecting pine marten because a model had been completed previously. The pine marten is a secondary cavity user and links to late successional forests and is sensitive to forest fragmentation. Wolverine was highly ranked by the CF and also listed by IWMS. Though Lynx was suggested by a reviewer it was not chosen as it did not appear as a focal species in other projects and thus was not included for budget and time constraints.

**Small Mammals and Amphibians**

Small mammals and amphibians such as voles and western toad were initially considered. No small mammals and amphibians were selected due to scale related habitat concerns. Small mammals are definitely linked to stand level forest habitats and more study and research will benefit understanding of these species and whether they require specific practices. The benefits modeling species with small home ranges was considered of low utility especially as habitat requirements occur on a micro scale and can vary independently of forest inventory. Though somewhat unsatisfying managing for larger species and the coarse filter provisions will need to be relied on to maintain a diversity of habitat availability for these mice, voles, amphibians and snakes 13, 14, 15.

**Grizzly Bear**

Two grizzly bear population management units occur in the Quesnel District (MOE 2004). The condition of the habitat in the western portion population management unit indicates bear populations are of concern and consequently Grizzly bear was to be included in modeling planned for the first year of this two year project.

**Ungulates**

The northern caribou populations occur in the western portion of the unit. Models have been developed (Sutherland and McNay 2009) and there are some project efficiencies as a result. Winter habitat is considered the most limiting and the availability of arboreal and terrestrial is important for these populations in habitat selection (Harold Armleder pers comm.). Moose, mule deer, and mountain goats are included and models were developed previously. Table I summarizes the wildlife species recommended for further modeling effort in the Quesnel Forest District.

---

14 [http://www.env.gov.bc.ca/wld/frogwatch/whoswho/factshts/westtoad.htm](http://www.env.gov.bc.ca/wld/frogwatch/whoswho/factshts/westtoad.htm)
Table I. Species recommended for inclusion in the Quesnel District Habitat modeling project whereas bolded species have existing models developed.

| Species recommended for modeling (Bolded species have models developed) | Criteria |
|---|---|---|---|
| | Forested Species | Seral stage preferences | Global | COSEWIC | CF | Social Importance |
| | Forest dependent | Rankings | | | | | Culturally important (land use plans, FIA) |
| 1. Three-toed Woodpecker | X | X |
| 2. Black-backed Woodpecker | X | X |
| 3. Northern Flicker | X | X |
| 4. Barrow Golden Eye | X | X | X | X |
| 5. Rusty Blackbird | X | X | X | X |
| 6. Blue Heron | X | X |
| 7. Northern Goshawk | X | X | X |
| 8. Mountain Goat | X | X |
| 9. Grizzly Bear | X | X | X | X | X |
| 10. Caribou (N Mtn pop.) | X | X | X | X |
| 11. Pine Marten | X | X | X |
| 12. Moose | X | X | X |
| 13. Mule deer | X | X | X |
| 14. Wolverine | X | X | X |
| 15. Sandhill Crane (Phase 2) | X |
| 16. Harlequin Duck (Phase 2) | X | X | X |
| 17. American White Pelican (2) | X | X | X |

CF = Conservation Framework
COSEWIC = Committee on Status of Endangered Wildlife in Canada

LITERATURE CITED

(The following were accessed and reviewed to help select species and better understand forest habitat relations as were the web links in footnotes in the report)


Buell, Mike, Glenn Sutherland and Doug Williams. 2006 Quesnel Silviculture Strategy (Type 2) and Habitat Analysis (Type 3). Prepared for the Quesnel TSA Strategic Forest Analysis Committee.


Cortex Consultants, Inc. and Mike Fenger and Associates Ltd. March 2006. Quesnel TSA Type 1 Silviculture Strategy. Appendix G – Species/Groups of Conservation Concern


Ministry of Environment, Lands and Parks (MELP) 1998, Inventory Methods for Small Mammals: Shrews, Voles, Mice & Rats Standards for Components of British Columbia’s Biodiversity No. 31 Ministry of Environment, Lands and Parks Resources Inventory Branch for the Terrestrial Ecosystems Task Force Resources Inventory Committee May 6, 1998


APPENDIX B. SPECIES ACCOUNTS

This appendix provides a summary of general account information for the following selected species:

- Three-toed woodpecker
- Black-backed woodpecker
- Northern flicker
- Barrows goldeneye
- Great blue heron
- Rusty blackbird
- Northern goshawk
- Sandhill crane
- Harlequin duck
- American white pelican
- Mule deer
- Moose
- Mountain caribou
- Mountain goat
- Grizzly bear
- Pine marten
- Wolverine

This information is extracted from various books and reports that provide pertinent information about these species as it relates to their presence in the province. The background literature search, although not exhaustive, was intended to be sufficient to determine the key habitat factors required by each species for the purposes of habitat supply modeling.

Each species account provides the following information:

- Scientific name, code and provincial and federal status
- List of published species accounts
- Distribution
- General ecology and life history
- Range use: life requisites
- Interaction with agents of disturbance/competition
- Mortality factors
- Potential limiting factors and threats
Three-toed Woodpecker

Scientific name: Picoides dorsalis (Baird 1858)  
Species code: B-ATTW  
BC status: Yellow listed  
COSEWIC status: No current status

Published species accounts


Note: There are a large number of North American bird identification books and reports on the market in which brief species accounts are available. Due to this plethora of basic information on the bird species of North America the above list is generally limited to accounts that are specific to BC.

Distribution

Provincial range:
The Three-toed woodpecker is widely distributed throughout BC east of the Pacific and Cascade Mountains and the Coastal Gap. It is found in only small locations on the coast and Vancouver Island and is absent from the Queen Charlottes (Campbell et al. 1990a). It winters and breeds throughout most of the province although found less frequently breeding west of the Coastal Mountains.

Elevation range:
In BC, the three-toed woodpecker’s breeding habitat is found from 520m to 1620 m in elevation. The non-breeding birds may be found from 450 to 2100 m in elevation (Campbell et al. 1990a). Studies throughout North America summarized in Anderson (2003) confirm that this species can be found between 450 and 2743 m.

Provincial context:
This species is considered an uncommon to rare resident. West of the Coastal Mountains and on Vancouver Island it is considered to be very rare and is absent from
the Queen Charlotte Islands (Campbell et al. 1990a). This species is resident in BC and is not considered migratory (BC CDC 2010a).

**General ecology and life history**

**Reproduction:**

Records in BC indicate that the three-toed woodpecker has a clutch between May and July with an incubation period of 12 to 14 days in which both sexes take part; males will sit on the eggs at night (Anderson 2003, Campbell et al. 1990a). This species lays only one clutch per year and the eggs are laid on a bed of wood chips within a cavity (BC CDC 2010a). In general, three-toed woodpecker clutch sizes range from 2 to 4 young (BC CDC 2010a, Campbell et al. 1990a). Young have been recorded hatching as early as May 22 and as late as July 22. In BC, one study indicated that nestling lasted 18 to 23 days (Campbell et al. 1990a). Anderson (2003) states that fledging occurs 22 to 26 days following hatching, but young may stay for up to 2 more months with the parents.

**Movements and home range:**

**Feeding habits:**

The primary diet of this species is insects obtained from under the bark of dead or dying trees; 75% are wood boring beetles and caterpillars (BC CDC 2010a). It often feeds by chipping off bits of bark to reach the invertebrates underneath (Anderson 2003). It may feed by pecking, scaling or excavating (Anderson 2003). They may also feed on spiders, weevils and ants as well as vegetation such as berries, acorns, sap and the cambium of trees (Terres 1991) as well as seeds including those provided at bird feeders (Campbell et al. 1990a).

Three-toed woodpeckers are considered important predators following insect outbreaks (Short 1982 in Anderson 2003). Woodpeckers kill mountain pine beetle and other insects directly by eating the insect, or indirectly, by drilling holes or flaking bark off which leads to desiccation or exposure and therefore death of the larvae (Anderson 2003). Woodpeckers feed on many species of insects so the numerical response to pine beetle is limited. However, in eastern Texas, following a pine beetle outbreak an increase in the woodpecker population was noted and the woodpecker population subsequently declined following a decline in the beetle population (Anderson 2003). Studies indicate that, although woodpeckers feed on many different species of insects, during beetle outbreaks, these birds respond by increasing the proportion of beetles in their diet (Anderson 2003). For example, Koplin (1972 in Anderson 2003) found that in areas with endemic levels of spruce beetle, 19% of the woodpecker’s stomach contents consisted of spruce beetle larvae, while in areas with an epidemic of spruce beetle, 83% of their stomach contents were spruce beetle larvae.
Range use: Life requisites

General:

The tree-toed woodpecker is resident throughout most of NA (BC CDC 2010a). In BC, during the non breeding season it is found most commonly in the subalpine, boreal and sub-boreal forests as well as the higher elevation western hemlock and interior Douglas fir ranging from 450 to 2,100 m. It prefers habitat near openings made by ponds, lakes, burns, clearcuts, bogs and muskegs (Campbell et al. 1990a). It may sometimes be found at lower elevations (Campbell et al. 1990a). This species tends to inhabit areas where standing dead timber is found after logging (BC CDC 2010a) or are found associated with insect outbreaks and burns (Anderson 2003). In Utah, Spahr et al. 1991 (in BC CDC 2010a) found that increases in woodpecker populations may occur 3 to 5 years following a forest fire. Other studies in the western states indicated an increase in three-toed woodpecker populations following burns, but results varied with respect to how many years after the burn the population increased (Anderson 2003). Its optimal habitat is considered to be areas where there are approximately 42 to 52 snags/40 hectares, 6 to 12 metres in height, standing in clumps with a dbh between 30 and 40 cm (BC CDC 2010a).

In a study in the boreal forests of Alberta, Hoyt and Hannon (2002) found that three-toed woodpeckers were most often found in 2 year old burns and old growth (compared to mature stands and burns at 3, 4, 8, 16 and 17 years post burn); none were found in mature conifer stands or 16 and 17 year old burns. They were found in stands 3, 4, and 8 years, post burn but at significantly lower numbers. They were also more likely to be detected in areas with a high density of lightly burned trees and a low density of moderately burned trees and jack pine (Pinus banksiana).

Foraging habitat:

Studies in different locations in North America show differences in foraging tree species preferences. Spruce was the favoured tree in an Alaskan study, Douglas fir and larch in Montana preferred over ponderosa pine, lodgepole pine and Engelmann spruce were preferred in Oregon, spruce and fir preferred over pine and aspen in Wyoming, and Douglas fir, western larch, ponderosa pine and lodgepole pine were preferred in a mixed conifer forest in Washington. The condition of the foraging trees also varied with the study (Anderson 2003).

Cover from thermal extremes:

Natal sites/denning/nesting:

In most cases, nests of this species have been found in excavated cavities in both live and dead coniferous and deciduous trees (BC CDC 2010a, Campbell et al. 1990a). Cavities are excavated by both sexes (BC CDC 2010a); new nests are excavated every
year (Anderson 2003). Data presented in Campbell et al. 1990a indicate that these cavities are found in coniferous 67% of the time and deciduous 25%. The most common nesting tree species were; Englemann, white or black spruce 27%, lodgepole pine 15%, and trembling aspen 15% (Campbell et al. 1990a). These species were verified in Anderson (2003) which indicated that this species was found nesting in spruce, larch, pine, balsam, cedar and aspen. The nests were found from 1 to 24 m (BC CDC 2010a, Campbell et al. 1990a) with 58% of these falling between 1 and 4.6 m from the ground.

Breeding habitat usually consists of coniferous forests between 520 and 1,690 m in elevation. Similar to the non-breeding season, they prefer to be near openings made by ponds, lakes, clearcuts, burns and bogs (Campbell et al. 1990a). Anderson (2003) intimates that habitat characteristics surrounding the nest cavity may be important to this species such as the condition and species of the surrounding trees, basal area, and average dbh.

Security:

Range use: Interaction with agents of disturbance/competition

Disturbance:

In other parts of its range in North America, this species has been known to have occasional irruptions; in particular, northeast North America and the midwest US. These irruptions have usually followed extensive forest fires and insect outbreaks. The irruptions of three-toed woodpeckers do not necessarily correspond to irruptions of black-backed woodpeckers because their diets differ slightly (Anderson 2003).

Competitors:

There is some suggestion that competition between three-toed and black-backed woodpeckers has led to different foraging strategies, however, not all data supports this (Anderson 2003). Villard (1994) found that these 2 species foraged at different heights on the tree, and that three-toed tended to forage by scaling the trees more than the black-backed did; other studies have not found this difference (Anderson 2003). In general, three-toed woodpeckers obtain wood boring beetles by scaling or flaking off the bark to expose the larvae beneath; black-backed woodpeckers drill or excavate in the sapwood for the larvae (Hoyt and Hannon 2002). Three-toed woodpeckers may also compete with tree swallows and squirrels over nest sites (Anderson 2003).

Range use: Mortality factors

Most information on predators of the three-toed woodpecker is anecdotal but the following species are believed to predate on this species: northern goshawk, black bear, mice, squirrels, and great horned owls (Leonard 2001 and Goggans 1989b in Anderson 2003).
Potential limiting factors and threats

Anderson (2003) states that practices that limit food resources and habitat pose the greatest risk to three-toed woodpeckers. For both three-toed woodpeckers and black-backed woodpeckers it is thought that fire suppression, salvage logging and elimination of contiguous mature stands may be limiting factors (Anderson 2003). Fire suppression decreases insect infestations which follow fires. Salvage logging removes potential habitat and insect-infested trees for the woodpeckers (Anderson 2003, BirdLife International 2009). Decreases in contiguous mature stands also decrease the amount of decaying trees available in these aging stands.
Black-backed Woodpecker

**Scientific name:** *Picoides arcticus* (Swainson 1832)

**Species code:** B-BBWO

**BC status:** Yellow

**COSEWIC status:** No current status

**Published species accounts**


Note: There are a large number of North American bird identification books and reports on the market in which brief species accounts are available. Due to this plethora of basic information on the bird species of North America the above list is generally limited to accounts that are specific to BC.

**Distribution**

**Provincial range:**

The black-backed woodpecker is locally distributed throughout BC but is thought to be absent from Vancouver Island and the Queen Charlottes (Campbell et al. 1990a).

**Elevation range:**

During the non breeding season this species may be found from 335 m to 1,890 m in elevation and during the breeding season from 335 to 1,400 m (Campbell et al. 1990a).

**Provincial context:**

This species is resident in BC and is not considered migratory (BC CDC 2010b). The black-backed woodpecker is considered a rare to very rare resident east of the Coastal Range and a casual resident west of this Range. It is thought to breed throughout its range (Campbell et al. 1990a). It is believed that this species is fairly secure even though it has probably undergone declines over the last century due to the decrease in snags and mature and old growth forests; however, temporary boosts in population size
occurs due to occasional population irruptions and population extensions outside their normal range as a result of fire and insect outbreaks (Natureserve 2009).

**General ecology and life history**

**Reproduction:**

Courtship and pair bonding begins in April with cavity excavating beginning in May (Natureserve 2009). In BC, data indicates that eggs are generally laid in May and June with an incubation period of approximately 12 to 14 days and a clutch size of 2 to 6 with an average of 4 (BC CDC 2010b, Campbell et al. 1990a) with both parents caring for the eggs (Natureserve 2009). Young have been recorded as hatching as early as the third week of May and as late as the second week of July. Broods ranged in size from 1 to 3 (Campbell et al. 1990a) and are tended by both parents (BC CDC 2010b). Young generally fledge after about 25 days (Ehrlich et al. 1988 in BC CDC 2010b).

**Movements and home range:**

This species is resident and territorial with other black-backed woodpeckers (BC CDC 2010b). Recorded home range sizes in various studies in the western States ranged from 72 to 328 hectares; the smaller home ranges were found in areas with abundant mature and old growth forest (BC CDC 2010b). Movements in home range have been observed in response to local increases in forage availability (BC CDC 2010b). Even though this species is not usually migratory, occasional irruptions in response to burns and insect outbreaks may extend their home range or may cause them to move from their home range (Anderson 2003).

It is thought that black-backed woodpeckers use edge habitat between coniferous forest and burns, logged areas, bogs and meadows. However, outside the breeding season, this species is believed to range widely in response to food availability; therefore it is important to manage this species habitat at a regional or landscape level (Natureserve 2009).

**Feeding habits:**

The black-backed woodpecker is an insectivore feeding mostly on wood boring beetle larvae but will feed on other insects such as weevils, spiders, ants and other types of beetles; it will occasionally feed on vegetation such as the sap and cambium of trees and shrubs as well as fruits and nuts (Terres 1991). This woodpecker generally flakes the bark off of trees and logs to feed on insects. They feed mostly on logs or trees greater than 7.5 cm dbh; most often the diameter is 15 to 25 cm dbh (Short 1974). Males are thought to provide the greater proportion of food to the young; although the female feeds them more often, she brings less back each time (Short 1974, Kilham 1983).
Range use: Life requisites

General:

Burn sites are favoured habitat of the black-backed woodpecker but like the three-toed woodpecker, this species also frequents subalpine, boreal and sub-boreal forests as well as the higher elevation western hemlock and interior Douglas fir ranging from 335 to 1,890 m (Campbell et al. 1990a). It is sometimes found in the valley bottom feeding and nesting. It may also be found along pond and lake edges as well as open bogs, residential areas and road edges. Breeding habitat generally consists of open areas such as burns, clearcuts, and shores of lakes, streams, swamps, and bogs in coniferous forest from 335 to 1,400 m in elevation (Lehnhauser and Murphy 1985 in Campbell et al. 1990a). It is usually associated with boreal and montane coniferous forests and may be found infrequently in mixed forest; it is seldom seen in deciduous forest in winter (BC CDC 2010b). The habitat types this species are associated with are extremely restricted and is strongly associated with recent forest fires (BC CDC 2010b). Certain characteristics are thought to be important for this species; diseased trees for roosting, heart-rot in snags and trees for nests, and insect-infested trees for forage (Natureserve 2009).

In a study in the boreal forests of Alberta, Hoyt and Hannon (2002) found that black-backed woodpeckers were not found in old growth or mature stands but only found in areas of 2, 3, 4 and 8 years post burn; they were not found in 16 and 17 year old burns. In the 2-year-old burns, they were more likely found in stands with a lower density of deciduous and a larger average dbh; they were detected in areas with a mean dbh of 161.8 mm, but were not detected in areas with a mean dbh of 141.7 mm. In the 3, 4 and 8 year-old burns, they were most likely found where there was a high density of downed trees; they were present in stands with a mean density of 2634.2/ha downed trees but were not present in areas with a mean density of 1869.1/ha downed trees.

Foraging habitat:

The black-backed woodpecker is found using the following tree species: pine (*Pinus* spp.) i.e., ponderosa pine (*P. ponderosa*), jack pine (*P. banksiana*), white pine (*P. strobus*), and lodgepole pine (*P. contorta*); spruce (*Picea* spp.) i.e., black spruce (*P. mariana*) and white spruce (*P. glauca*); fir (*Abies* spp.) i.e., boreal balsam fir (*A. balsamea*), and red fir (*A. magnifica*), Douglas fir (*Pseudotsuga menziesii*) and tamarack (*Larix* spp.; BC CDC 2010b). In an Oregon study, this species was found to forage on ridges 97% of the time; the preferred tree species being ponderosa pine and lodgepole pine. They also fed almost equally on dead and live trees (BC CDC 2010b). The average size of foraging tree was 31 cm dbh and 18 m tall, with greater than 40% of their needles intact; this suggested that they favoured recently dead or live trees (Bull et al. 1986 in BC CDC 2010b).

Cover from thermal extremes:
Natal sites/denning/nesting:

Black-backed woodpeckers are primary excavators with males doing most of the excavating (BC CDC 2010b). Generally, nests are found in living or dead coniferous trees in excavated cavities ranging in height from 1 to 24 m from the ground; most (69%) were located between 1 and 3 m from the ground. The coniferous trees in which cavities were found are: pines, spruce, Douglas fir, western larch, western hemlock, and western red cedar (Campbell et al. 1990a). Occasionally nests are found in stumps, fence posts and utility poles (BC CDC 2010b).

Security:

Range use: Interaction with agents of disturbance/competition

Disturbance:

In parts of this species range, irruptions and range extensions associated with insect outbreaks and forest fires have been observed (BC CDC 2010b). Hoyt and Hannon (2002) found that black-backed woodpeckers appear to be burn dependant. They found them to frequent 2, 3, 4, and 8-year-old burns, but not 16 and 17-year-old burns.

Competitors:

There is some suggestion that competition between three-toed and black-backed woodpeckers has led to different foraging strategies, however, not all data supports this (Anderson 2003). Villard (1994) found that these 2 species foraged at different heights on the tree, and that three-toed tended to forage by scaling the trees more than the black-backed did; other studies have not found this difference (Anderson 2003). In general, three-toed woodpeckers obtain wood boring beetles by scaling or flaking off the bark to expose the larvae beneath; black-backed woodpeckers drill or excavate in the sapwood for the larvae (Hoyt and Hannon 2002).

Range use: Mortality factors

Potential limiting factors and threats

For both three-toed woodpeckers and black-backed woodpeckers it is thought that fire suppression, salvage logging and elimination of contiguous mature stands may be limiting factors (Anderson 2003). Fire suppression has drastically changed the habitat diversity available to fires dependant species such as these woodpeckers (Natureserve 2009). Since the 1930’s, the extent of forest fires in Canada has been reduced by more than 80% in the montane cordillera and mixed wood plains. Since 1960, timber
harvesting has doubled in Canada. In the montane cordillera, in areas of mountain pine beetle outbreak, timber harvesting has replaced forest fires as the major source of disturbance (NatureServe 2009).
Northern Flicker

**Scientific name:** *Colaptes auratus* (Linnaeus 1758)
**Species code:** B-NOFL
**BC status:** Yellow
**COSEWIC status:** No current status

**Published species accounts**


Note: There are a large number of North American bird identification books and reports on the market in which brief species accounts are available. Due to this plethora of basic information on the bird species of North America the above list is generally limited to accounts that are specific to BC.

**Distribution**

**Provincial range:**

The northern flicker is found throughout BC including Vancouver Island and the Queen Charlottes (Campbell et al. 1990a).

**Elevation range:**

During the breeding season the flicker may be found from near sea level to 2,100 m in elevation (Campbell et al. 1990a).

**Provincial context:**

These birds may be resident or migratory. The northern flicker breeds throughout BC but generally populations north of the Queen Charlottes migrate south for the winter (BC CDC 2010c, Campbell et al. 1990a). It is considered a fairly common resident in southern BC, uncommon resident in the centre third of the province and an uncommon summer resident in the northern part of the province (Campbell et al. 1990a).
General ecology and life history

Reproduction:
The northern flicker breeds throughout BC. In BC, clutches have been found from late April to mid to late July with most found between mid May to early June. Clutches may be found up to a month earlier in the southern half then the northern part of the province (Campbell et al. 1990a). Campbell et al. 1990a noted that with a sample size of 209 clutches, clutch size varied between 1 and 13 eggs with 51% of these having 7 or 8 eggs; there is 1 egg laid per day. Incubation period is thought to range between 11 and 13 days with both sexes participating (Campbell et al. 1990a). Most clutches observed hatched in mid to late June with brood sizes varying between 1 and 11 young; 60% had between 5 and 7 young (Campbell et al. 1990a). It is thought that nesting may last up to 28 days (Campbell et al. 1990a).

Anderson (2003) found information from a small amount of individuals indicated that mates were not the same from season to season but that most did return to that same area and some used that same tree.

Movements and home range:
In areas where there are resident populations, migration periods are difficult to confirm; spring, between March and May, brings a population increase in breeding areas (Campbell et al. 1990a). In the southern part of the province, the flicker arrives at its breeding sites in early March and in the north, may arrive as late as the end of May. Migration at the end of the season generally begins in late August and may continue through October (Campbell et al. 1990a).

Lawrence (1967 in Anderson 2003) found that nest territories were approximately 50 m but that the flicker could range up to 0.8 km. Other studies cited by Anderson (2003) state that nest territories were varied depending on the type of habitat and geographic area in which it was found; nest territories ranged from 16 m apart to 252 m apart.

Winter home ranges reported by Moore (1995 in Anderson 2003) were 48 to 101 ha.

Feeding habits:
The flicker is a herbivore and an insectivore (BC CDC 2010c). Both the adult and immature flicker may feed on insects such as grasshoppers, beetles, ants, wasps, caterpillars or grubs as well as vegetation such as seeds, fruits and berries (Terres 1991). They often feed on the ground in open areas. It will also catch insects on the wing (Terres 1991). Anderson (2003) states that 65% of their foraging time is spent on the ground, but they will also excavate, glean and seed harvest on trees as well as catch on the fly.
**Range use: Life requisites**

**General:**

During the non-breeding season, the flicker is frequently found in open forest type habitat, including residential and farmland (Campbell et al. 1990a). During the breeding season, the flicker may be found in almost every forested zone in BC but prefers open habitats such as urban and rural habitat as well as forest edge, riparian woodland, lodgepole pine parkland, aspen, alpine meadow edges, burns, clearcuts and second growth plantations (Campbell et al. 1990a). Anderson (2003) confirms that flickers may be found in many habitats from sea level to tree line. Bate (1995 in Anderson 2003) states that Flicker abundance demonstrates a positive relationship with the number of snags greater than 20.3 cm and with the number of layers of canopy. Anderson (2003) found that several studies indicated that flickers were associated with burned areas.

Many secondary cavity nesters rely on cavities excavated by flickers (BC CDC 2010c).

**Foraging habitat:**

Anderson (2003) looked at several studies and found that flicker’s foraging habitat was often associated with burned areas, clear-cuts, or edge habitat. Another study cited by Anderson (2003) found that flickers were not found in mature, uncut stands. Nest areas are different from feeding areas (Anderson 2003).

**Cover from thermal extremes:**

The flicker seeks cover by boring cavities in trees or may excavate in the side of barns, houses, and eaves of houses to create a winter roost (Terres 1991).

**Natal sites/denning/nesting:**

Nests of the flicker are generally found in coniferous or deciduous trees, stumps, snags or in silt or clay cliffs; coniferous trees were used 26% of the time and deciduous 48%. They will sometimes use man-made sites (generally less than 5% of the time) such as nest boxes, fence posts, and power poles. Out of a sample size of 543 nests, the following tree species were noted as nest sites: trembling aspen (38%), lodgepole pine (10 %), ponderosa pine (9%), black cottonwood (8%), Douglas fir (8%), birch (6%). Of the deciduous trees used, 67% were alive, while only 35% of the coniferous trees used were alive. (Campbell et al 1990) Researchers have observed that the flicker tends to be a “weak excavator” choosing to excavate cavities in softer, decaying wood and seldom excavating sound wood (Keisker 1986 in Campbell et al. 1990a). In various studies throughout BC, the DBH of cavity trees ranged from 23 to 91 cm. The height of the cavities ranged from ground level to 27m, however, 60% of the nests were found below 3m (Campbell et al. 1990a).

Both sexes excavate the nest cavity (Campbell et al. 1990a). However, the male plays a significant role in choosing the nesting site. This species may also uses nests from previous years (Terres 1991).
Security:

The flicker will come to roost prior to sundown in a cavity (Terres 1991).

Range use: Interaction with agents of disturbance/competition

Disturbance:

Competitors:

Flickers are apparently quite passive and are generally not the aggressors, however, other woodpeckers and birds have been known to be aggressive to the flicker. Anderson (2003) indicates a record where a flicker forced a kestrel from its cavity. Raphael and White (1984 in Anderson 2003) indicate that most cavity interactions are not competitive in nature because they usually occupy different niches and competition only occurs if the resource is limited. Starlings are thought to be a major competitor and often successful at outcompeting flickers for food and nesting sites (Anderson 2003).

Range use: Mortality factors

The flicker has many predators but it is not known what impact they have on the population overall (Anderson 2003). Many raptor species predate on the flicker as well as raccoons, squirrels, mustelids, crows, ravens, snakes and mice (Anderson 2003).

Potential limiting factors and threats

The primary limiting factors and threats to the flicker are thought to be starling competition and habitat loss (Anderson 2003). Other limiting factors are the amount of available cavity, nest building, and roost-site substrates. In areas where snags have been removed, the number of flickers has decreased (Anderson 2003). Winter food resources or territoriality may also be a limiting factor (Anderson 2003).
Barrow’s Goldeneye

**Scientific name:** *Bucephala islandica* (Gmelin 1789)  
**Species code:** B-BAGO  
**BC status:** Yellow  
**COSEWIC status:** No current status

*Published species accounts*


*Note:* There are a large number of North American bird identification books and reports on the market in which brief species accounts are available. Due to this plethora of basic information on the bird species of North America the above list is generally limited to accounts that are specific to BC.

*Distribution*

**Provincial range:**

This species is a year round resident and breeder in the following MOE regions: Lower Mainland, Thompson, Kootenay, caribou, Skeena and Okanagan. It is a year round resident and probable resident in the Vancouver Island Region. It is a seasonal resident and breeder in the Omineca and Peace Regions. It is found in the following BEC zones: BG, BWBS, CDF, CWH, ESSF, ICH, IDF, MS, PP, SBPS, SBS, and SWB. (BC CDC 2010d).

**Elevation range:**

The primary breeding grounds of Barrow’s goldeneye are lakes and subalpine lakes and water bodies in mountain and intermountain areas. In Quebec they are found in lakes above 500m in elevation (SDJV 2003a).

**Provincial context:**

The core breeding population of this species in North America occurs in the interior of BC. They winter along the coast of BC most often in marine habitats such as bays,
harbours and rocky shores (SDJV 2003a). Late in the fall, the goldeneye moves south but remains inland until freeze-up at which time they move to the coast. Males and females have different moulting areas so are likely to have different fall staging areas as well and reunite in winter (SDJV 2003a).

General ecology and life history

Reproduction:

This species is thought to be monogamous and form pairs while on their wintering grounds. In general, females do not breed until they are 3 years of age or older (SDJV 2003a). Both sexes are territorial during breeding season (SDJV 2003a). The barrow's goldeneye has an average clutch size of 10 to 13 and a range of 6 to 15 eggs with an incubation period of approximately 30 days (Savard et al. 1991). The female incubates the eggs, and in BC, the average date of hatching falls between mid to late June (Savard et al. 1991); incubation is approximately 30 days (SDJV 2003a). This species is known to practice intraspecific nest parasitism (Savard 1988). The young are able to dive for food immediately following hatching.

Movements and home range:

In BC, this species summer and winter ranges may be as much as 320 km apart (Savard 1985). The goldeneye will defend a small territory of approximately 0.18 to 1.45 hectares (NatureServe 2009). Males will leave females during nesting to fly to moulting areas often beyond their breeding range. This migration is thought to be direct and swift possibly covering as much as 1000 km in 2 days (SDJV 2003a). Large aggregates of females moulting on their breeding sites in central BC. This species remains flightless during the moulting period which generally lasts about 30 days. These moulting areas are generally used year after year (SDJV 2003a).

Feeding habits:

This species forages in both salt and fresh water; in fresh water it feeds on both plants and animals such as insects, crustaceans, small fish as well as fish eggs (BCCDC 2010d). In salt water it forages for molluscs, marine invertebrates such as sea worms and some sea stars (BC CDC 2010d). The young are able to dive for food immediately following hatching feeding on crustaceans and insect larvae (SDJV 2003a).

Range use: Life requisites

General:

During the breeding season this species is generally found on alkaline or freshwater lakes but will winter on the coast (SDJV 2003a).
Foraging habitat:

In winter, this species is generally found in marine habitat although some may winter on inland lakes, ponds and rivers that are free of ice (SDJV 2003a). The ones on the coast will feed in the shallow waters, foraging on bivalves, crustaceans and fish eggs (SDJV 2003a). In summer, they are generally found on inland lakes or other bodies of water (SDJV 2003a).

Cover from thermal extremes:

Natal sites/denning/nesting:

Nesting habitat for this species is generally found near a lake or pond that is surrounded by dense vegetation, or in a wooded area or open country (BC CDC 2010d). The nest is usually made in a natural tree, rock or woodpecker cavity or in a stream bank. This species will nest in the same area and nest site in subsequent years (BC CDC 2010d, SDJV 2003a). Nest boxes have been used successfully for this species (Savard 1988).

Security:

Range use: Interaction with agents of disturbance/competition

Disturbance:

It is believed that logging activities are a major threat to this species due to its reliance on older trees and snags for its nest site (SDJV 2003a).

Competitors:

Competition for cavity nest sites may be of concern from other secondary cavity nesters.

Range use: Mortality factors

Mortality of the young of this species is high in the first few weeks after hatching. The primary source of mortality for young is predation and adverse weather (SDJV 2003a). It is thought that hunting pressure is low for the western populations (SDJV 2003a).

Potential limiting factors and threats

The availability of suitable cavity nest sites is thought to be a limiting factor to the population size of this species; however, well placed nest boxes have proven successful
Logging removes older trees and snags and therefore decreases cavity nest sites available, which may further lead to increased predation pressure on the remaining nest sites (SDJV 2003a). In BC, forest harvest is thought to be the greatest threat to the Barrow’s goldeneye (SDJV 2003a). Other potential threats to this species include oil spills, fish stocking in previously fishless interior lakes in breeding areas and pollutants from agriculture and industry; especially the cumulative effect these pollutants have in their preferred prey of shellfish (SDJV 2003a).
Great Blue Heron

**Scientific name:** *Ardea herodias* (Linnaeus 1758)
*Ardea herodias herodias* subspecies (Linnaeus 1758)
*Ardea herodias fannini* subspecies (Chapman 1901)

**Species code:**
- B-GBHE
- B-GBHE-HE
- B-GBHE-FA

**BC status:**
- No status (*Ardea herodias*)
- Blue (*Ardea herodias herodias*)
- Blue (*Ardea herodias fannini*)

**COSEWIC status:**
- No current status (*Ardea herodias*)
- No current status (*Ardea herodias herodias*)
- Special concern (*Ardea herodias fannini*)

**Published species accounts**


Note: There are a large number of North American bird identification books and reports on the market in which brief species accounts are available. Due to this plethora of basic information on the bird species of North America the above list is generally limited to accounts that are specific to BC.

**Distribution**

**Provincial range:**

Within Canada, great blue herons are found only in BC (COSEWIC 2008). The great blue heron is found throughout the province; in some regions it is found year round in others it is found seasonally. It may be found in the following BEC zones: BG, BWBS, CDF, CWH, ICH, IDF, MS, PP, SBPS and SBS. (BC CDC 2010e) The *herodias* subspecies is a year round resident and breeder in the following MOE regions: Thompson, Kootenay, Cariboo and Okanagan. It is a seasonal resident and breeder in the Omineca region. The *herodias* subspecies may be found in the following BEC zones: BG, BWBS, H, IDF, MS, PP, SBPS, and SBS. (BC CDC 2010g) The *fannini* subspecies is a year round resident and breeder in the Vancouver Island, Lower Mainland, and Skeena Regions and year round resident and probable breeder in the Cariboo Region. This subspecies may be found in the CDF or CWH BEC zones. (BC CDC 2010f)

**Elevation range:**

On the coast, this species is most often found at sea level and in the interior it frequents valley bottoms where wetland complexes are most often found (Gebauer and Moul 2001), however, there have been some documented occurrences of nests and sightings up to 1100m (Campbell et al. 1990b).

**Provincial context:**

True population size is extremely difficult to determine due to herons susceptibility to abandon colonies when disturbed and their habit of moving sites frequently. It is thought that the interior population may be somewhere between 300 and 700 birds (Gebauer and Moul 2001). There are far more on the coast and the coastal population for the area around the Strait of Georgia alone is thought to be estimated at 2076 breeding pairs (Butler 1997).

**General ecology and life history**

**Reproduction:**

This heron incubates its eggs for approximately 25 to 29 days with the eggs hatching in the order they were laid (Gebauer and Moul 2001). This results in varied chick sizes with the youngest often starving or getting pushed out of the nest. The great blue heron has a clutch size that varies from 1 to 8 eggs with the average being 3 to 5 (Gebauer
and Moul 2001). Studies indicate that as latitude increases so does clutch size and clutch size decreases as the breeding season progresses (Pratt and Winkler 1985 in Gebauer and Moul 2001). They generally fledge 56 to 60 days after hatching although some studies have found a shorter time till fledging; as short as 45 days in Nova Scotia. They become independent approximately 3 weeks after fledging (Butler 1991b in Gebauer and Moul 2001). The average number of successful fledglings is usually somewhere between 2 and 3 (Gebauer and Moul 2001). In BC, this species raises only one brood per year (Butler 1997).

In BC, herons generally return to nesting areas in mid January to late march depending on their geographic location. Nest building is usually in March and April with eggs being laid in early April till early July although some have been found brooding as late as August, again depending on their location in the province (Gebauer and Moul 2001). Pratt (1973 in Gebauer and Moul 2001) states that most begin breeding when they are approximately 22 months.

**Movements and home range:**

The *fannini* subspecies of great blue heron is considered to be more resident and its breeding grounds and wintering areas are close to each other. Butler (1995) states that males during dispersal were more solitary and defended a definite foraging territory; females congregated more than males. The *herodias* subspecies is mostly migratory congregating in colonies during breeding and migrating south in the winter.

In BC, Butler (1991a in Gebauer and Moul 2001) found the average distance between the colonies and foraging sites was 2.3 km. Other studies cited in Gebauer and Moul (2001) have found the distance between colonies and foraging sites to vary from 2.3 to 6.5 km.

**Feeding habits:**

This species slowly walks or stands in shallow water stalking its prey; it may also stand on shore or on floating objects watching for its prey in the water. It uses its sight to locate prey then rapidly grabs the prey and swallows it whole (Gebauer and Moul 2001). Its prey includes fish, herpetiles, aquatic insects and other small species found in wetlands. When feeding in the upland, this species of heron has been noted to feed on ground squirrels, chipmunks, gophers, rabbits, and smaller rodents such as voles. Other prey includes passerines such as blackbirds, swallows and starlings (Gebauer and Moul 2001).

**Range use: Life requisites**

**General:**

Great blue heron habitat consists of breeding areas, foraging habitat associated with either the non breeding or breeding season and roost sites, all of which are critical. It is assumed that the quality of the feeding habitat influences the location of the breeding sites (Gebauer and Moul 2001). In the interior of BC, roost sites have not been well
documented but they have been observed roosting in coniferous trees close to summer colonies or winter foraging sites. On the coast, however, herons have been observed roosting on trees, jetties, wharves, rocks and on the shore throughout the year (Campbell et al. 1990b). There is very little data on the staging areas of the great blue heron although it is believed that important staging areas in the interior may be large wetland complexes and large estuaries on the coast (Gebauer and Moul 2001).

Foraging habitat:

The great blue heron will forage in wetlands, lakes, streams and other bodies of water that provide forage as well as upland areas. Foraging habitat in the interior of BC is generally along the shore of lakes, marshes, sloughs, ponds, wetlands and slow moving rivers (Campbell et al. 1990b). In the interior these foraging sites are most likely in valley bottoms where wetland complexes exist. The heron on the coast forages on both fresh and saltwater shores along the whole BC coast (Campbell et al. 1990b). This heron requires accessible and plentiful forage within 10 km of the breeding colony (BC MWLAP 2004a).

In the non-breeding season herons usually forage along ice free shore lines of lakes and other ice-free bodies of water that provide sufficient forage (Gebauer and Moul 2001).

Cover from thermal extremes:

Natal sites/denning/nesting:

In BC, most great blue herons are colony nesters with only a few single nest sites being reported (Butler 1997). The number of nests in the colony has been shown to be positively related to the size of the colonies foraging area (Butler 1991a in Gebauer and Moul 2001). The size of great blue heron nests ranges in size from 50 cm to over 1 m in diameter. Nest material usually consists of small diameter twigs approximately 20 to 30 cm in length and is often lined with small twigs, strips of bark, evergreen branches, moss or rushes (Gebauer and Moul 2001).

The great blue heron changes their nesting sites frequently; this may be due to various forms of disturbance, either natural (i.e., black bears or bald eagles) or human. Draulins (1988 in Gebauer and Moul 2001) indicates that colonies may function as areas where they can assemble and find new mates and nest sites every year.

Nest sites are usually found along the edge of lakes or other bodies of water. In southern BC, the cottonwood is the most common nest tree, whereas in central BC around Williams Lake, nests were located in coniferous trees such as pine, spruce and Douglas fir (Gebauer and Moul 2001).

Security:
Range use: Interaction with agents of disturbance/competition

Disturbance:

The great blue heron is very susceptible to disturbance and will readily abandon nesting sites and colonies if disturbed. Disturbance can be natural such as predators such as eagles and black bears or manmade disturbances (Gebauer and Moul 2001).

Competitors:

Range use: Mortality factors

Predators such as the common raven, crow and bald eagle have been known to eat the eggs of the great blue heron. In addition, great blue herons have abandoned their colonies following an attack by a bald eagle. Other predators such as the red fox and the raccoon also feed on heron eggs. Bald eagles, ravens, golden eagles, great horned owl, hawks, and raccoons will prey on the chicks of the herons. Black bears have also been found to feed on the chicks (Gebauer and Moul 2001). Bald eagles have also been noted to predate on adult herons.

Chicks may push each other out of the nest, or simply fall from the nest, or smaller nestlings may starve to death due to their inability to compete (Gebauer and Moul 2001). Some studies indicated that an important source of mortality was poor weather either through a decrease in forage success due to turbidity or rippling of the water or hypothermia.

Starvation over the winter in adult blue herons, and pollution are also noted sources of mortality (Gebauer and Moul 2001).

Other random sources of mortality are entanglements in fishing line or nets, falling of the nests from the tree and fish bone obstruction in a chick’s throat; adults have also been known to die from choking on prey that is too large (Gebauer and Moul 2001).

Potential limiting factors and threats

The availability of ice free winter forage areas, limits the distribution of this species in the interior and in the northern portions of the province (Gebauer and Moul 2001). Habitat destruction has led to the loss of several colonies of great blue herons. Logging has also been noted as a limiting factor for the great blue heron; this is especially significant when mature timber next to a prime forage area is removed (Gebauer and Moul 2001). Urban development, especially in areas of prime foraging and nesting, may also be a significant limiting factor. Forbes et al. (1985b in Gebauer and Moul 2001) suggest that random environmental effects such as large amounts of rainfall could lead to higher mortality rates; either through lower foraging success due to increased turbidity and rippling of the water, or hypothermia of nestlings. Great blue herons are known to be very sensitive to human disturbance, especially if it occurs during breeding and nesting;
disturbance often leads to abandonment of the colony (Gebauer and Moul 2001). In various parts of BC, pollutants have led to egg shell thinning and reduced reproductive success (Gebauer and Moul 2001).
Rusty Blackbird

**Scientific name:** *Euphagus carolinus* (Muller 1776)

**Species code:** B-RUBL

**BC status:** Blue

**COSEWIC status:** Special concern

*Published species accounts*


Note: There are a large number of North American bird identification books and reports on the market in which brief species accounts are available. Due to this plethora of basic information on the bird species of North America the above list is generally limited to accounts that are specific to BC.

*Distribution*

**Provincial range:**

The rusty blackbird is found throughout BC. It is considered a year round resident and breeder in the Thompson and Okanagan MOE regions. It is considered a year round resident and probable breeder in the Kootenay Region. It is a seasonal resident and breeder in the Cariboo, Skeena, Omineca and Peace Regions. It is a seasonal resident and nonbreeder in the Vancouver Island and Lower Mainland Regions. It may be found in the following BEC zones: BG, BWBS, CDF, CWH, ESSF, MS, PP, SBPS, SBS, and SWB. (BC CDC 2010h)

**Elevation range:**

This species of blackbird is not generally found in wetlands above treeline, or in high mountain wetlands (COSEWIC 2006).
Provincial context:

This species is thought to have a decreasing population trend (BirdLife 2008). Christmas bird counts indicate a decline of negative 5.1% per year since 1966 which would represent an 85% decrease since the mid 60’s. Further analysis between 1994 and 2003 show a decline of negative 2.1% which would represent a decrease of 18.3% over the last 10 years. Approximately 70% of the world’s breeding population is found in Canada and is estimated to be between 110,400 and 1.4 million individuals.

General ecology and life history

Reproduction:

The rusty blackbird has an average clutch size of 4 to 5 which is incubated by the female (BC CDC 2010h). It usually lays the eggs between May and June (Terres 1990). Incubation generally lasts about 14 days. The young, however, are tended by both parents and fledge at about 13 days (BC CDC 2010h). This species is usually monogamous (COSEWIC 2006).

Movements and home range:

This species is considered a long distance migrant (Natureserve 2009). The rusty blackbird often travels in large flocks (Terres 1990). At the end of July in the northern part of the breeding grounds, flocks ranging from a few dozen to hundreds gather. In early October, flocks in northeastern BC have been observed migrating east (COSEWIC 2006).

Feeding habits:

This blackbird forages in the shallows of ponds feeding on aquatic insects, crustaceans, snails, salamanders, and small fish. About half of its diet is insects and other animals and the other half is vegetation such as seeds, grains and berries (Terres 1990). During severe winters this species has been observed attacking and eating shorebirds and passerines (Avery 1995 and Bent 1958 in COSEWIC 2006).

Range use: Life requisites

General:

This species is generally associated with water and wetlands. It may be found in bogs, fens, forested wetlands, riparian areas and scrub wetlands. It may also be found in agricultural areas, grasslands, forests, both deciduous and coniferous and scrubland (NBII 2010). Moist coniferous forests, bogs and fens surrounded by bush, wooded riparian areas and beaver ponds are the preferred breeding ground of this species (NBII 2010). Its winter and migratory habitat is usually wooded wetlands and riparian habitat but may include open woodlands and agricultural areas (NBII 2010).
The breeding range of this species strongly corresponds to the boreal forest and taiga terrestrial ecozones (COSEWIC 2006).

Foraging habitat:

This species is found associated with wetlands and other water bodies that provide sufficient forage and cover (COSEWIC 2006, Terres 1990).

Cover from thermal extremes:

Natal sites/denning/nesting:

This species builds its nest in shrubs overhanging water or in thick clumps of conifers anywhere from 0.5 m to 6 m from the ground. It does not build its nest in colonies like other blackbirds (Terres 1990).

Security:

Range use: Interaction with agents of disturbance/competition

Disturbance:

Rusty blackbird breeding habitat in Canada has been lost from the conversion of wetlands for agriculture and urban development. As well flooding of large areas of valley bottom habitat for hydroelectric dams may adversely affect the rusty blackbird (COSEWIC 2006). As well, oil and gas extraction and the associated drainage and pumping activities remove large amounts of freshwater from surface and underground reservoirs will also affect this species (COSEWIC 2006).

Competitors:

There is not much information on interspecific interactions during breeding; however, red-winged blackbirds have been known to displace the rusty blackbird. It is also proposed that habitat conversion of the breeding grounds will lead to an increase in red winged blackbird and grackles and therefore a decrease in rusty blackbirds (COSEWIC 2006). The rusty blackbird has been observed joining mixed flocks of other blackbirds, starlings and grackles during migration and in wintering areas (COSEWIC 2006).
Range use: Mortality factors

There are not many observations noted of predation on the rusty blackbird, however, aggressive behaviour of this bird towards species such as the northern harrier, sharp-tailed hawk and pine marten indicate these as probable predators (COSEWIC 2006). There was also a report of a gray jay predating on young (Campbell et al. 1997 in COSEWIC 2006).

Potential limiting factors and threats

In North America, this species has had a dramatic decline over the last 45 years; the population is thought to have declined 85 to 99% since 1966 but the reasons are not well understood (BirdLife 2008). It is thought that destruction and conversion of wetlands, as well as global climate change resulting in drying and chemical change of wetlands are contributing factors in the decline of this species (BirdLife 2008). In other parts of North America it is thought that pollution such as depletion in calcium from acid precipitation and increased methyl mercury as well as mortality associated with blackbird control methods also contribute to this species decline (BirdLife 2008). Ellison (1990 in COSEWIC 2006) and Erskine (1992 in COSEWIC 2006) believe that invasion of dominating species such as the red-winged blackbird may also be a limiting factor for the rusty blackbird.
Northern Goshawk

**Scientific name:** Accipiter gentilis atricapillus subspecies (Linnaeus 1758)
Accipiter gentilis laingi subspecies (Taverner 1940)

**Species code:** B-NOGO
B-NOGO-LA (Accipiter gentilis laingi subspecies)

**BC status:**
Yellow (Accipiter gentilis atricapillus subspecies)
Red (Accipiter gentilis laingi subspecies)

**COSEWIC status:**
Not at risk (Accipiter gentilis atricapillus subspecies)
Threatened (Accipiter gentilis laingi subspecies)

**Published species accounts**


Note: There are a large number of North American bird identification books and reports on the market in which brief species accounts are available. Due to this plethora of basic information on the bird species of North America the above list is generally limited to accounts that are specific to BC.

**Distribution**

**Provincial range:**

The *atricapillus* subspecies of Northern Goshawk is found throughout BC except for Vancouver Island and the Queen Charlottes; the *laingi* subspecies is found mostly on Vancouver Island and the Queen Charlottes and possibly along the mainland coast (BC CDC 2010i). The *atricapillus* subspecies is found in the following MOE Regions: Thompson, Kootenay, Omineca, Peace and Okanagan. It is found in the following BEC zones: BG, BWBS, CDF, CWH, ESSF, ICH, IDF, IMA, MH, MS, PP, SBPS, SBS, and SWB. It is also thought to be a probable resident in Boreal Altai Fescue Alpine (BAFA) (BC CDC 2010i). The *laingi* subspecies is a year round resident and breeder in the Vancouver Island, Lower Mainland, and Skeena Regions. It is a year round resident and probable breeder in the Cariboo Region. This subspecies is found in the CDF, CWH and MH BEC Zones (BC CDC 2010j).

**Elevation range:**

The northern goshawk may be found from sea level to 2,290 m in elevation.

**Provincial context:**

The northern goshawk breeds and winters throughout BC although some may migrate south in the winter (Campbell et al. 1990a). Although this species is essentially non migratory, it is considered a rare to uncommon resident throughout BC and an irregular migrant that is rare to uncommon in the spring and rare to fairly common in August. It is most abundant in the northern interior (Campbell et al. 1990a).

The population size of the *laingi* subspecies is thought to be between 250 and 1000 individuals and it is believed that BC has the majority of the world’s population (BC CDC 2010k).

**General ecology and life history**

**Reproduction:**

Clutches range from 2 to 4 eggs and may be found from the beginning of April to mid July although it is thought that any clutches found after mid June are probably replacement clutches (Campbell et al. 1990a) although it is believed they generally produce only 1 clutch per year (BC CDC 2010i). During cold and wet springs they may
not produce a clutch or it may be delayed during this weather and at higher elevations (BC CDC 2010i). Incubation is 28 to 32 days resulting in 1 to 4 young hatched with a nestling period of 34 to 37 days (Campbell et al. 1990a); they become independent after about 70 days (BC CDC 2010i). Most don’t begin to breed till they are young adults but a small percentage of subadults are sexually mature; it is believed that this occurs in expanding populations and occurs less frequently in stable populations (BC CDC 2010i).

In North America, nesting success ranges from 44 to 94 percent with the average successfully producing 2 to 3 fledglings. The female does most of the brooding and feeding of the nestlings while the male brings the food to the nest (BC CDC 2010i).

**Movements and home range:**

This bird is considered to be a resident or short distance migrator but will intermittently have irruptions out of the northern portion of its range (BC CDC 2010i). If conditions are good, the northern goshawk will overwinter in the northern part of the province by moving to lower elevations rather than migrating south (Campbell et al. 1990a). However there seems to be a cyclic pattern where migration south occurs as a result of a decrease in prey populations (Campbell et al. 1990a).

During nesting, home ranges vary from 95 to 3500 hectares depending on habitat characteristics and sex (BC CDC 2010i). Generally male’s home ranges are larger than that of the female. Except for the nesting areas, home ranges will often overlap; the nesting and core area makes up approximately 32% of the home range (Kennedy et al. 1994 in BC CDC 2010i). Home ranges are often shifted or enlarged after breeding (Hargis et al. 1994, Keane and Morrison 1994 in BC CDC 2010i).

**Feeding habits:**

The northern goshawk is a carnivore. This species is an opportunistic feeder and prey may be captured in the air, on the ground, or in vegetation (BC CDC 2010i). In general, the goshawk perches for a short period of time, scans the area, then if no prey is spotted, will move on to another perch. Harassment is also used as a means of scaring the prey out into the open. Flying along edge habitat and surprising prey is also a technique used by the goshawk (Demarchi and Bentley 2005).

It will prey on a large variety of vertebrates as well as the occasional insect. The most common prey is small mammals such as tree squirrels, ground squirrels, lagamorphs and birds (BC CDC 2010i, Demarchi and Bentley 2005). Diet varies depending on the season, geographic location, and prey availability (Demarchi and Bentley 2005).

**Range use: Life requisites**

**General:**

The northern goshawk’s prime habitat is forests situated on a gentle slope with large trees and high percent canopy cover (Demarchi and Bentley 2005); however, it can be found in a wide variety of habitats such as mixed, open, or dense forests (Campbell et
Hunting areas for this species is usually the habitat found near the sea, estuaries, lagoons, rivers, creeks and lakes. It may also be seen around habitat influenced by man such as farmland and airports. During migration it uses mountain ridges and meadows (Campbell et al. 1990a). During breeding this raptor becomes very secretive.

**Foraging habitat:**

This species will forage in both open habitat and heavily forested areas (BC CDC 2010i). The northern goshawk forages primarily in mature and old growth forests. They will occasionally be seen in larger city parks where there is an abundance of prey but rarely are they seen in more open habitat even when the prey is plentiful (Demarchi and Bentley 2005).

**Cover from thermal extremes:**

**Natal sites/denning/nesting:**

The northern goshawk breeds throughout BC. The most common breeding habitat consists of dense, mature coniferous forest; however, it has also been noted to breed in mixed woodlands, deciduous forests such as trembling aspen, coniferous bogs and open coniferous forest (Campbell et al. 1990a). Nests are generally found near a water source and may range in elevation from sea level to 1,400 m. The most common nest trees were: live trembling aspen, Douglas fir, black cottonwood and spruce; less commonly nests have been found in dead trees. Nests have been recorded from 6 to 18 m from the ground (Campbell et al. 1990a). Nests tend to be large structures up to 90 cm in diameter, made with sticks and twigs and lined with bark, leafy boughs, and twigs located in main branch forks or against the tree trunk, or on broken tree tops (Campbell et al. 1990a). The goshawk will maintain from 1 to 8 alternate nests in their nesting area ranging from 15 to 2066 m apart (BC CDC 2010i). In one Arizona study, the distance between nests of neighbouring goshawks was 3 km (BC CDC 2010i).

**Security:**

**Range use: Interaction with agents of disturbance/competition**

**Disturbance:**

Logging near nest sites reduces canopy closure and leads to an increase in predation as well as competition with species that are more adapted to an open habitat.
Competitors:

The northern goshawk is aggressive with other raptors especially when they come near the nests. They may also compete with other raptors, sometimes unsuccessfully for nesting sites. Species such as red-tailed hawk, great horned owl, great gray owl, barred owl and long eared owl can successfully compete with goshawks for nests. They have been known to avoid available nesting sites when bald eagles are present (Cooper and Stevens 2000). Both inter- and intra- specific competition does take place for nesting sites (Cooper and Stevens 2000).

Range use: Mortality factors

Mortality of eggs and nestlings is most often attributed to exposure to rain, cold or being pushed from the nest by a sibling. There is predation on the nest as well from predators such as mustelids (BC CDC 2010i).

Predation by mustelids such as fisher has been thought to depress a population of goshawks in Arizona. Great Horned owls are also thought to be a significant predator.

Potential limiting factors and threats

In the Omineca Peace region of BC forest habitat, although still plentiful, is undergoing rapid change due to forestry, mining and oil and gas development as well as urbanization, agriculture and hydro-electric activity. Northern goshawk is considered a species of concern in this area due to this activity.
Sandhill Crane

**Scientific name:** *Grus canadensis* (Linnaeus 1758)

**Species code:** B-SACR

**BC Status:** Yellow

**COSEWIC status:** Not at risk

*Published species accounts*


Note: There are a large number of North American bird identification books and reports on the market in which brief species accounts are available. Due to this plethora of basic information on the bird species of North America the above list is generally limited to accounts that are specific to BC.

*Distribution*

**Provincial range:**

Provincially, sandhill cranes are a common migrant (BC MWLAP 2004c) and breeding pairs are possibly found throughout BC, with the noted exception of Okanagan-Similkameen Regional District where they are presumed extirpated (BC CDC 2010l).

**Elevation range:**

Breeding sandhill cranes are found at elevations ranging from sea level to 1220m and nonbreeders from sea level to 1510m (Campbell et al. 1990a).
Provincial context:
Possibly three subspecies occur in the province: Lesser (*G. canadensis canadensis*), Canadian (*G. canadensis rowani*), and Greater (*G. canadensis tabida*); however subspecies designation of *G. canadensis rowani* is questionable (NatureServe 2009). The breeding distribution of the subspecies present in BC is poorly known (BC MWLAP 2004c).

Sandhill cranes are migrants, seasonal residents and breeders in BC. Some birds have occasionally been found to winter in the lower Fraser River Valley and on Vancouver Island and Haida Gwaii (BC CDC 2010m). Three migration flight paths, used in spring and autumn, exist in BC: coastal (~3500 individuals), central interior (~22,000 – 25,000 individuals) and northeastern Interior (~150,000 – 200,000 individuals) (BC MWLAP 2004c). Timing of spring movements is March – April for the coastal flight, mid-March – late April for the central interior flight, and late April – late May for the northeastern flight. Fall movements occur early August to late November for the coastal flight, mid-August to late October for the central flight and late August to mid-October for the northeastern flight (Cooper 1996).

Sandhill crane populations in BC are believed to be stable to increasing; however data is too sparse to determine trends in the breeding populations. Localized population decline has occurred in the Fraser Lowlands, and the south Okanagan population has been extirpated (BC MWLAP 2004c).

**General ecology and life history**

**Reproduction:**
Eggs are laid from late April to mid-May likely depending on latitude. One to three (most commonly two) eggs are laid and are incubated by both sexes for approximately 28 – 34 days. Both parents tend to chicks that begin flying at two months of age. Chicks remain with parents until the following year but only one chick usually survives to fledging due to sibling aggression (Blood and Backhouse 1999). If a clutch is abandoned or lost within about 20 days, females will usually re-nest. Pairing of individuals may occur as early as three years of age but is more common at five to six years of age. Most recruitment is by individuals seven years of older (BC CDC 2010l). Sandhill cranes mate for life and may reproduce for 15 – 20 years (Cooper 1996).

**Movements and home range:**
Territory size of nesting cranes in BC has not been determined but territory size ranges from 17 – 85 ha elsewhere (BC MWLAP 2004c). Once hatchlings leave the nest they forage with parents along the perimeter of the natal wetland. After fledging of young, sandhill cranes form localized congregations in pre-migration staging areas. In the fall, flight movements of 2 – 16 km occur between roosting and feeding areas (BC MWLAP 2004c).
Feeding habits:

Sandhill cranes are omnivores and feed on small vertebrates (e.g., snakes, small rodents, birds), invertebrates (insects and earthworms), and roots, tubers, berries, seeds, and grains (Natureserve 2009, BC CDC 2010l). Young cranes forage extensively on invertebrates during the first weeks of life. Dietary items are generally scoured from the surface of the ground or from low vegetation although they also use their bill to dig roots and tubers.

Range use: Life Requisites

General:

Open fresh water wetlands, meadows and estuaries are the primary habitat of sandhill cranes (Cooper 1996) and breeding densities are highest in open sedge wetlands adjacent to low vegetation uplands. Outside of the breeding season, sandhill cranes roost at night on alluvial islands of braided rivers, or in shallow water of along river channels and wetlands (BC CDC 2010l). Important features of roosting habitat include level terrain, shallow water (<25 cm), an open or sparsely vegetated shoreline and isolation. Flooded meadows and agricultural fields are good examples. Shallow water appears to be the most critical feature of roosting habitat (BC MWLAP 2004c). Structural stages used for roosting include: 1 (non-vegetated/sparsely vegetated), 2 (herb), 3a (low shrub), 3b (tall shrub), and 4 (pole/sapling; BC MWLAP 2004c).

Foraging habitat:

Foraging habitat includes dry uplands, shallow wetlands, estuarine marshes, intertidal areas, and agricultural fields with use of agricultural lands highest in nonbreeding areas (BC MWLAP 2004c, BC CDC 2010l). Isolation from disturbance and unobstructed views of surrounding areas are important characteristics of foraging habitats (BC MWLAP 2004c).

Cover from thermal extremes:

Natal sites/denning/nesting:

Breeding habitat for sandhill cranes includes open grasslands, marshes and marshy edges of ponds and lakes, and river banks. Typically, breeding habitats are isolated, shallow freshwater wetlands >1ha with convoluted shorelines and surrounding forest cover (BC MWLAP 2004c). Successful breeding habitat incorporates a nest site, a roost site (usually within the nesting marsh), a feeding site and isolation (BC CDC 2010m). Visual cover to promote isolation is a notable requirement (BC CDC 2010m).

Broad habitat classes known to be used for nesting in BC include: sphagnum bog, Cedars-Shore pine bog, sedge fen, marsh, meadow, shrub fen, and shrub swamp.
(Cooper 1996). Structural stages used for nesting include: 1 (non-vegetated/sparsely vegetated), 2 (herb), 3a (low shrub), 3b (tall shrub), and 4 (pole/sapling; BC MWLAP 2004c).

Nests are generally low mounds constructed out of the dominant surrounding vegetation. Nests are built on the ground but more often in shallow water (maximum water depth of 1.5m reported in BC) on large marshes, wet forest meadows or open tundra (Cooper 1996, BC CDC 2010l). Open areas are an important feature for the nest site (Blood and Backhouse 1999).

High fidelity is generally exhibited to breeding territories; however preliminary data from central BC suggests fidelity is not strong (BC MWLAP 2004c).

Security:

Sandhill cranes with young will use coniferous forest as escape cover (BC CDC 2010m) and structural stages 4 (pole/sapling) through 7 (old forest) in general are listed as escape habitat (BC MWLAP 2004c).

Range use: Interaction with agents of disturbance/competition

Disturbance:

Sandhill cranes are vulnerable to anthropomorphic disturbance during nesting, roosting and feeding (BC CDC 2010m). Access improvements that permit human intrusion or recreational activities in wetland areas can reduce or eliminate use by sandhill cranes. Some nesting cranes have exhibited habituation to highways, roads, mines, farms and ranches, and have nested within 200 – 500m of such activities (Cooper 1996). Maintenance of screening vegetation cover (structural stages 4 [pole/sapling] through 7 [old forest]; BC MWLAP 2004c) likely augments such habituation. Many sites where they currently breed in BC are remote and inaccessible (BC CDC 2010m). Roosting cranes are more vulnerable to disturbance and will not roost in areas where disturbance is intrusive (Cooper 1996).

Competitors:

Range use: Mortality factors

Collisions with powerlines may be a significant mortality factor in some areas; however it is not believed to be important in BC (BC MWLAP 2004c). In urban areas, road mortality may be a factor. Other possible sources of mortality include avian cholera, avian botulism, avian tuberculosis, flooding of nests due to water management projects, agricultural activities such early draining of marshes and mowing in July, and extreme weather events such as storms and droughts (BC MWLAP 2004, BC CDC 2010m). Predation of nests and chicks by ravens, coyotes and raccoons can be locally significant (Natureserve 2009).
**Potential limiting factors and threats**

The loss or degradation of wetland and riverine ecosystems due to urbanization, logging or intensive agriculture practices constitutes the most important threat to sandhill crane populations. Within BC, logging activities peripheral to breeding wetlands are probably the most significant land use practice affecting habitat suitability (BC MWLAP 2004c). Elimination of isolation buffers due to logging to the edge of wetlands, draining of wetlands, and livestock trampling of emergent vegetation are all implicated in habitat loss or degradation. Wetlands proximal to recent clear cuts appear not to be used for nesting (BC CDC 2010m). Generally, areas of heavy human use result in disappearance of sandhill cranes (Natureserve 2009).
Harlequin Duck

Scientific name: *Histrionicus histrionicus* (Linnaeus 1758)
Species code: B-HADU
BC Status: Yellow
COSEWIC status: No current status

Published species accounts


Note: There are a large number of North American bird identification books and reports on the market in which brief species accounts are available. Due to this plethora of basic information on the bird species of North America the above list is generally limited to accounts that are specific to BC.

Distribution

Provincial range:

On an annual basis, harlequins are widely distributed over BC with winters generally spent along the coast and the breeding population migrating inland in the spring. They breed across the province (SDJV 2003b), but the breeding population appears absent from a strip of the extreme northeast corner of the province (Natureserve 2009).

Elevation range:

Nests have been found in subalpine habitats up to 2100m (Freeman and Goudie 1998).

Provincial context:

Harlequins are year-round residents and confirmed breeders on Vancouver Island, the Lower Mainland, Kootenay and Okanagan Ministry of Environment (MOE) regions. For the remaining MOE regions harlequins are seasonal residents and breeders. They appear as transients in the Mackenzie Forest District (BC CDC 2010n). Note that range maps and other accounts of distribution (SDJV 2003b, NatureServe 2009) indicate that harlequins are year-round residents and breeders in the Skeena MOE region.
The western population of harlequins has experienced significant population declines (Natureserve 2009); however there are no reliable estimates of numbers or trends for western North America (SDJV 2004). Recruitment rates of harlequins wintering in the Strait of Georgia appear lower than required to sustain the population based on estimated survival rates (LeBourdais et al. 2009). Crude estimates of wintering populations in BC range from 11,000 – 15,000 individuals (SDJV 2003b).

General ecology and life history

Reproduction:

Generally, breeding pairs migrate inland from the coast to nest; however some proportion of the population nests in the coastal mountains (SDJV 2003b). Males defend the females until the commencement of incubation upon which the pair bond ends and males return to the coast to moult (SDJV 2003b). Incubation of eggs by females begins early May – late June, dependent on elevation and snow. Clutch size ranges from 5 – 10 (usually 6 – 8) eggs with incubation lasting between 27 – 32 days (Natureserve 2009). During incubation females leave the nest rarely to feed or wash. Young are precocial and tended by the female. Within 24 hrs of hatching, the female leads the young to secluded streams where they learn to forage on aquatic insects and larvae. Young fledge in 5 – 6 weeks at which time the brood size is generally 2 – 5 individuals (Natureserve 2009). Breeding habitat is occupied from April through September.

Pair bonds are commonly long-term and are renewed each year on the wintering grounds (Natureserve 2009). Harlequins recruit into the breeding population at 2 – 3 years of age. Due to a late age of first breeding, generally small clutch sizes, and in some years apparent high proportions of nonbreeding birds (possibly related to insect abundance), harlequins have low productivity and recruitment rates.

Movements and home range:

Breeding pairs migrate northward and inland in spring arriving in the breeding areas late April through May (Natureserve 2009). Specific migration routes and spring and fall staging areas are not well known. Staging areas not be heavily used (SDJV 2003b). Moulting areas are well known and widespread throughout the harlequin’s range. Important moulting areas in BC include the Strait of Georgia and Hecate Strait (SDJV 2003b). Post-breeding males arrive on the moulting and wintering grounds in June, followed by failed breeders with females and young arriving in September (SDJV 2003b).

Feeding habits:

The harlequin feeds almost exclusively on benthic aquatic invertebrates, mostly crustaceans and molluscs in coastal habitats, but also small fishes and row (Natureserve 2009). In breeding habitats harlequins feed on a wide variety of benthic aquatic insects (LeBourdais 2006).
Range use: Life Requisites

General:

The harlequin winters on the coast and islands, generally along rocky shores or reefs that experience rough waters, constant breaking of the surf (Godfrey 1986) and minimal winter ice accumulation. Summering immature birds and nonbreeding birds also occur in this habitat (Natureserve 2009). Breeding birds migrate to utilize swift rivers and streams, either coastal or inland, usually in forested environments. Prior to migration, harlequins frequently congregate at herring spawning grounds to feed on row. Broadly, migration occurs along the coast and then up rivers to the breeding grounds (SDJV 2004). Selection of clear and turbulent streams for breeding sites is likely due to the abundance of aquatic invertebrates that serve as the primary food during the breeding season.

Foraging habitat:

Wintering habitats consist of turbulent, rocky coastal areas where harlequins dive in the intertidal or subtidal shallows (<10m; SDJV 2004) over rocks and ledges to feed on invertebrates.

When on the breeding grounds, harlequins dive to the river or stream bottom and propel themselves against the current, probing rocky substrates on the streambed for larvae and immature stages of aquatic insects. Breeding stream substrates are primarily composed of cobbles and boulders that provide refuges for aquatic insects (LeBourdais 2006). Harlequin breeding densities on streams are positively related to food availability and food availability is negatively related to variability in stream flow. Indirect interactions between harlequins and fish also apparently occur, due to aquatic insects altering activity to avoid fish predation, which in turn reduces their availability to harlequins.

Cover from thermal extremes:

Natal sites/denning/nesting:

Harlequins are solitary, cryptic nesters and breed in low densities (Bond et al. 2009). Harlequins nest along fast-moving rivers and braided to reticulate turbulent mountain streams often in forest environments. In forested breeding areas harlequins prefer undisturbed areas with intact riparian reserves compared to logged stream banks (Hill and Wright 2000). They prefer second order or greater, oligotrophic streams with widths ranging between 5 – 30 m (Freeman and Goudie 1998) and low gradients (1 – 5%; Hill and Wright 2000) with dense shrubby riparian habitat (>50% shrub cover on streamsides) and woody debris (for nesting and rearing broods). Cover and loafing habitat is provided by mid-stream boulders or log jams and overhanging vegetation. Nests are often on rocky islands or stream banks. Occasionally, harlequins will nest beside mountain lakes or outlets to lakes (Natureserve 2009).
Nests may be built in hollows on the ground, in rock crevices or cavities in small cliff ledges, in tree cavities, on stumps, or in burrows from other wildlife. Nests are well concealed by vegetation or other overhead cover and are generally within 30m of water (SDJV 2004, NatureServe 2009). Harlequins tend to exhibit fidelity to breeding areas in successive years.

Correlations between fish indices and density of breeding harlequins are negative LeBourdais et al. 2009 and higher breeding densities of harlequins occur on fishless stream reaches (LeBourdais 2006).

Security:

**Range use: Interaction with agents of disturbance/competition**

**Disturbance:**

Harlequins are vulnerable to human disturbance on both wintering and breeding grounds from recreationists such as boaters (SDJV 2004). Where breeding populations are sparse, riparian recreationists (hikers, river boaters) may affect their distribution (SDJV 2003b). Recommendations for road and trail buffers of at least 50m from inhabited streams, maintenance of obscuring vegetation, localized road closures and avoidance of logging in riparian areas (NatureServe 2009) highlight breeding harlequins’ susceptibility to human activities.

**Competitors:**

Harlequins and fish compete although interactions between fish and harlequins appear to be indirect and mediated through anti-predator behaviour of aquatic insects due to fish presence rather than insect density reduction by fish consumption (LeBourdais et al. 2009).

**Range use: Mortality factors**

Although harvest survey data suggest that <50 harlequin ducks are harvested annually in BC (SDJV 2003b), harlequins in coastal habitats may be vulnerable to hunters due to their tameness, tendency to feed close to shore, high site-fidelity and the resemblance of females and immatures to other legally hunted duck species. On coastal waters, harlequins are susceptible to oil spills due to their use of intertidal habitats where oil washes ashore (SDJV 2004, NatureServe 2009).

Female harlequin mortality rates have been reported as highest on the breeding grounds as compared to other annual cycle stages and locations, and that on the breeding grounds, incubation is the time of highest mortality as compared to nest initiation and brood rearing. Mortality of females during the breeding season appears to be a constraint of population growth and stability. Most mortality is apparently due to
predation, primarily by mustelids such as mink and marten and secondarily by avian predators (Bond et al. 2009). It is surmised by Bond et al. (2009) that regional differences in breeding mortality are a function of differences in regional predator communities.

**Potential limiting factors and threats**

Harlequins exhibit high site fidelity to breeding and wintering grounds and small localized breeding populations may be subject to extirpation (NatureServe 2009). Mining, logging, road construction, shoreline developments, and water impoundment projects may affect water quality (turbidity and temperature), degrade riparian nesting habitat, and alter stream flow rates (SDJV 2003b) for breeding populations. Pesticide use and the introduction of fish to freshwater systems can negatively alter food availability (SDJV 2004, LeBourdais 2006, LeBourdais et al. 2009, NatureServe 2009). Agricultural and ranching activities such as tillage, irrigation and removal of beaver dams can also alter water quality and stream flow rates (LeBourdais 2006).
American White Pelican

**Scientific name:** *Pelecanus erythrorhynchos* (Gmelin 1789)
**Species code:** B-AWPE
**BC Status:** Red
**COSEWIC status:** Not at risk

*Published species accounts*


Note: There are a large number of North American bird identification books and reports on the market in which brief species accounts are available. Due to this plethora of basic information on the bird species of North America the above list is generally limited to accounts that are specific to BC.

*Distribution*

**Provincial range:**

American White Pelicans (hereafter white pelicans) are listed as transients in the Vancouver Island, Lower Mainland, Skeena and Peace Ministry of Environment (MOE) regions; as seasonal nonbreeding residents in the Thompson, Kootenay, Omineca and Okanagan MOE regions; and as seasonal residents and confirmed breeders in the Cariboo region (BC CDC 2010o). At the level of Provincial Forest Districts, white pelicans are confirmed breeders only in the Chilcotin Forest District (BC CDC 2010o).
Elevation range:
White pelicans occur across an elevational range of sea level to 1220m (Campbell et al. 1990b).

Provincial context:
White pelicans nest at one location, Stum Lake, in the province. Birds from this nesting colony forage over ~ 30,000 km² of the Fraser Plateau utilizing lakes, rivers and streams (Harper and Steciw 2000). The nonbreeding proportion of the provincial populations is poorly understood; however it is believed that they forage over the same range as the breeding birds (BC MWLAP 2004d). A large population (maximum count of 77 in 2000) of unknown breeding status utilize Nulki and Tachick lakes for foraging, and white pelicans are common in the Creston Valley Wildlife Management Area (maximum count of 83 in 1999). Typically, white pelicans do not winter in the province, although individuals occasionally stay through the winter months (BC MWLAP 2004d and references therein). For both spring and fall migrations, lakes in the Nicola and Okanagan valleys are used as staging areas (Blood 1993).

White pelicans are a highly migratory species (BC MWLAP 2004d) and winter in California and Mexico. White pelicans generally arrive on the Fraser Plateau in mid-April and depart between September and mid-October (Dunbar 1984 in BC MWLAP 2004d, Campbell et al. 1990b). It is believed that the Stum Lake population’s migration route in on the west side of the Rocky Mountains (Campbell et al. 1990b).

The provincial breeding population of white pelicans is believed to be stable, notwithstanding population fluctuations (BC MWLAP 2004d). At Stum Lake an annual average of 285 nests was observed between 1997 and 2001; a maximum count of 423 nests was obtained in 1993 (BC MWLAP 2004d and references therein).

General ecology and life history

Reproduction:
White pelicans are seasonally monogamous and breed in colonies that often include nesting pairs of Double-crested Cormorants (Phalacrocorax auritus). Nesting is usually synchronized across the colony (Baicich and Harrison 1997 in BC MWLAP 2004d) with courtship and nest building starting within 3 – 4 days after arrival at the site (Campbell et al. 1990b). Both sexes build the nest, a mound of dirt and debris or a shallow scraped depression rimmed with dirt and debris, over a 3 – 5 day period (BC MWLAP 2004d and references therein). The peak period when clutches are laid is the second and third weeks of May (range: early May to late July) and typically 1 – 4 eggs are laid (mean: 1.95 eggs in years without disturbance, 1.69 eggs in years with disturbance; Dunbar 1984 in BC MWLAP 2004d). Both sexes incubate the eggs in alternating two-day shifts, for 29 – 36 days (Baicich and Harrison 1997 in BC MWLAP 2004d). Rarely is more than one young fledged due to aggressive competition directed from the first born chick to those born later (Evans 1996 in BC MWLAP 2004d).
Parents tend the brood for 15 – 18 days (BC MWLAP 2004d) after which the young are mobile and start to form overnight crèches (aggregations that may provide thermoregulatory and anti-predation advantages) and both parents simultaneously leave the nest to forage (Evans 1984 in BC MWLAP 2004d). Young white pelicans fledge at 7 – 10 weeks of age (Baicich and Harrison 1997 in BC MWLAP 2004d). Generally, most young are hatched by late June and fledged by late July or early August (Campbell et al. 1990b).

**Movements and home range:**

White pelicans are fast and efficient flyers (up to 50 km/hr) and regularly travel 50 – 100 km (and up 165 km) from the nesting colony at Stum Lake to outlying lakes to forage (BC MWLAP 2004d and references therein). Members of the Stum Lake colony are known to utilize 40 different lakes on the Fraser Plateau (BC MWLAP 2004d and references therein).

**Feeding habits:**

White pelicans are primarily piscivorous and opportunistic foragers. A variety of fish species appear in their diet including minnows (Cyprinidae), suckers (Catostomidae), stickleback (Gasterosteidae), sunfish (Centrarchidae), bullhead (Ictaluridae), perch (Percidae) and salmon and trout (Salmonidae). Amphibians such as salamanders (Caudata) and invertebrates such as crayfish (Astacidae) are also utilized. White pelicans surface feed in shallow water near shore although they will also feed in the upper part (≈1m) of the water column in deeper waters (BC MWLAP 2004d and references therein).

White pelicans forage singly or in co-operative groups where individuals dip their bills into the water and swim forward together in a semi-circle (Blood 1993) to drive fish into shallow water. During the breeding season, nocturnal foraging is common and is likely reliant on direct bill contact with prey mediated through an increased rate of bill dipping. Nocturnal foraging may provide advantages in travel, allowing pelicans to utilize rising thermals during daytime. Diurnal foraging is probably visual oriented (BC MWLAP 2004d and references therein).

**Range use: Life Requisites**

**General:**

White pelicans require undisturbed islands for breeding colonies and isolated aquatic environments with abundant prey species for foraging (BC MWLAP 2004d). They demonstrate a strong fidelity to nesting islands, and return to the same sites each year. Abandonment of nesting sites is rare and usually results from catastrophic disturbance, lesser disturbances do not deter white pelicans from returning (BC MWLAP 2004d).

Loafing areas that permit white pelicans to preen, rest and wait for favourable flight conditions as they travel between nesting colonies and foraging sites are important (BC MWLAP 2004d). Sandbars, mud flats on the deltas of larger inlet streams, partially
submerged deadfall, and the shoreline or floating vegetation proximal to the shoreline of shallow lakes are common loafing habitats (Harper and Steciw 2000, Wood 1990 in BC MWLAP 2004d). Structural stages associated with loafing activities include: 1a (sparse), 2a (forb-dominated herb), 2b (graminoid-dominated herb), and 2c (aquatic herb; BC MWLAP 2004d).

**Foraging habitat:**

In BC, lakes, reservoirs, permanent or semi-permanent marshes, and slow-moving streams and rivers are used for foraging. These water bodies vary from nutrient rich to poor, muddy to clear, with shorelines of mud, sand, gravel or rock. Presence of prey species is likely the dominating factor determining use and timing of use. Stream foraging for instance, has only been observed in the spring and is related to the spawning of coarse fish species (BC MWLAP 2004d and references therein).

The primary foraging lakes used on the Fraser Plateau tend to be small (mean size = 321 ha, maximum size = 1706 ha), shallow (mean depth = 4 m), and alkaline. Foraging is conducted along shorelines, at creek inlets and outlets, and where shallow open water occurs further from shore. Sites where prey species coincide with loafing habitat (inlets and outlets), particularly during spawning, are important foraging habitats (Harper and Steciw 2000).

**Cover from thermal extremes:**

**Natal sites/denning/nesting:**

In BC, nesting occurs on four islands in Stum Lake. The islands are small (90 - 1000 m$^2$), low in profile ($\leq$ 6.7 m in height), and with one exception are non-forested and sparsely vegetated. Physical disturbance by the pelicans combined with acidic guano contribute to the lack of vegetation. Nests are closely situated on flat areas and often adjacent to rocks, logs, or dead trees (BC MWLAP 2004d and references therein). Structural stages associated with nesting habitat include: 1a (sparse), 2a (forb-dominated herb), and 2b (graminoid-dominated herb; BC MWLAP 2004d).

**Security:**

Security from terrestrial predators for nesting colonies is provided by the water barrier surrounding islands. At Stum Lake islands are 80 – 600 m from shore. Effectiveness of the water barrier is dependent on stable and suitable water levels during the nesting period (BC MWLAP 2004d).
**Range use: Interaction with agents of disturbance/competition**

**Disturbance:**

White pelicans are vulnerable to disturbance at breeding colonies, foraging sites and loafing sites. Disturbance early in the nesting period by humans or predators at breeding colonies may cause complete desertion of the colony for that year. Human disturbance of colonies may also cause temporary nest abandonment by adults resulting in loss of eggs or chicks to avian predators or factors related to lack of parental care such as cooling, overheating, and dehydration (Knopf and Evans 2004 in NatureServe 2009, BC MWLAP 2004d and references therein). Egg and chick mortality may also result from trampling by frightened adults (Blood 1993).

Effects of human disturbance at foraging and loafing sites are less well known. Recreation (boating, fishing, water skiing, hiking and camping along shorelines), aircraft overflights, vehicle traffic along nearby roads, and forest harvesting activities are all implicated (BC MWLAP 2004d and references therein). In response to such disturbances, white pelicans may move to another portion of the water body or leave (Wood 1990 in BC MWLAP 2004d).

**Competitors:**

Other fish eating birds such as ospreys as well as game fish may compete with white pelicans for coarse fish prey species.

**Range use: Mortality factors**

Mortality factors for offspring are related to human disturbance that expose eggs and chicks to avian predators or environmental extremes, or cause trampling by frightened adults. Offspring are also lost due to events that permit terrestrial predators to access the colonies (low water levels, frosts resulting in ice formation) or from high water events that flood nests (NatureServe 2009, BC MWLAP 2004d, Blood 1993). For older individuals, shooting mortality has historically been a significant mortality factor and still is the leading mortality factor in band returns (NatureServe 2009).

Recently, diseases including botulism and West Nile virus have resulted in significant mortality of white pelicans (Rocke et al. 2005 in NatureServe 2009).

**Potential limiting factors and threats**

Strong fidelity to breeding sites and only one breeding colony in BC likely exposes white pelicans to a higher risk of local extirpation via agents such as habitat alteration and destruction. Alteration of hydrological regimes by humans can result in a loss of breeding, foraging and loafing habitats (Murphy 2005 in NatureServe 2009, Harper and Steciw 2000, BC MWLAP 2004d). Damming or alteration of stream courses, irrigation projects, and draining of lakes may result in high or low water levels that either 1) flood nests or loafing sites, 2) allow nest sites and loafing sites to become connected to the shore eliminating the barrier for terrestrial predators or 3) creates barriers to spawning...
prey fish or alterations in water level that adversely affect prey fish abundance (Harper and Steciw 2000, BC MWLAP 2004d and references therein). Additional potential threats to prey fish abundance include pollution (motorboats, chemical fertilizers in runoff from farm lands, rural sewage) and the introduction of game fish that outcompete or predate upon the prey fish species of white pelicans (BC MWLAP 2004d and references therein).
Mule Deer

**Scientific name:** *Odocoileus hemionus hemionus* (Rafinesque 1817)

**Species code:** M-ODHE

**BC status:** Yellow-listed

**COSEWIC status:** no assessment available (March, 2008)

*Published species accounts*


*Distribution*

**Provincial range:**

Mule deer are found throughout BC. There are 2 subspecies; the black-tailed deer (*columbianus* Columbian and *sitkensis* Sitka) and the mule deer (*hemionus*). The Columbia Mountains separates the 2 subspecies although some interbreeding occurs along the edges of their range (Blood 2000a). The mule deer subspecies is found in all ecoprovinces except the Coast and Mountain and Northeast Pacific ecoprovince.

**Elevation range:**

Mule deer are found at all elevational ranges from sea-level to alpine (BCMoE SA-MD).

**Provincial context:**

The population of the coastal subspecies is estimated at 150,000 to 250,000. The interior subspecies is estimated at approximately 165,000 and in the northern ranges the population is estimated at 20,000 to 25,000 (Blood 2000a).
General ecology and life history

Reproduction:

Breeding occurs in the fall, usually late November to mid-December and 1 to 2 fawns are born in May and June (BC CDC 2010q). Males may breed as yearlings, but due to dominance, the older males do most of the breeding (Blood 2000a). Females also begin breeding as yearlings (Blood 2000a).

Movements and home range:

Mule deer are generally solitary or may travel in small groups, but are rarely found in large groups. Clans of females related by maternal decent will travel together sometimes with an unrelated male (Blood 2000a). Home range size differs depending on sex, habitat (such as availability of food, water and cover) and individuals (BCMoE SA-MD) but may vary from 30 to greater than 240 ha (BC CDC 2010q). Mule deer demonstrate a high fidelity for their seasonal home ranges (BC CDC 2010q). Many of the interior mule deer are migratory, moving from subalpine in the summer to lower montane winter range when snow depth increases (Wallmo and Regelin 1981) although some individuals will remain residents at lower elevations all year (Blood 2000a). Snow becomes too deep for deer movement and forage when depths are greater than 30cm (Blood 2000a).

Feeding habits:

Mule deer are mainly browsers, but will also forage on grasses and forbs. They are able to digest a wide variety of plant material and will vary their diet seasonally depending on forage digestibility and protein content as well as the nutritional needs of the animal (BCMoE SA-MD). In the spring and summer they prefer grasses (i.e., Agropyron spp., Poa spp. Koeleria spp), shrub leaves as well as herbs such as clover (Trifolium spp.), and fireweed (Epilobium spp.). They may also feed on dandelion (Taraxacum officinale), lupine (Lupinus spp.), alfalfa (Medicago sativa), vetch (Vicia spp.), peavine (Lathyrus), horsetail (Equisetum spp.), showy daisy (Erigeron speciosus), yarrow (Achillea millefolium), mariposa lily (Calochortus spp.), common harebell (Campanula rotundifolia), gentian (Gentianella spp), and rock cress (Arabis spp.) (BCMoE SA-MD). In winter they feed on grasses and herbs as well as Douglas fir tree foliage and shrubs such as big sagebrush, pasture sage, bitterbrush, rabbitbrush, snowbrush, rose, saskatoon, and serviceberry (Blood 2000a).

Range use: Life Requisites

General:

Mule deer in the interior are generally found in open coniferous forests and in early structural stages where they can find plenty of forage and cover (BCMoE SA-MD). In the interior, winter range usually consists of shrubland in the dry forest zone and in broken terrain on steep south and west facing slopes. They will often not migrate from their high
elevation summer range until December when they descend to lower elevations to areas with shallower snow (Blood 2000a).

**Foraging habitat/mineral licks:**

In the interior, spring forage is usually found on moderate to steep mid elevation south to west facing slopes where early green up occurs; usually close to their winter ranges (BCMoE SA-MD). In the spring they also use low elevation grasslands, open mixed forests, clear cuts and riparian areas (BCMoE SA-MD). In the summer they tend to use higher elevations such as shrubby alpine, alpine tundra, subalpine parkland and subalpine wet meadows.

**Cover from thermal extremes:**

Mule deer require winter range that has snow depths of less than 30cm as snow becomes too deep for deer movement and forage when depths are greater than this (Blood 2000a).

**Natal sites/denning/nesting:**

**Security:**

**Range use: Interaction with agents of disturbance/competition**

**Disturbance:**

No specific information available for large-scale disturbances such as MPB.

**Competitors:**

Mule deer occupy the same ranges and can compete for forage with Rocky Mountain elk, white-tailed deer and domestic cattle (Blood 2000a).

**Range use: Mortality factors**

In general, the main causes of death are predation, starvation and hunting (Blood 2000a). Mule deer are prey to predators such as cougars, wolves and bears as well as bobcats and coyotes. Another form of mortality for mule deer is accidents (Blood 2000a).
Potential limiting factors and threats

One of the limiting factors for deer is snow and the chance of fawn survival decreases with occurrences of heavy snowfall (BCMoE SA-MD).
Moose

Scientific name: *Alces americanus* (Clinton 1822)
Species code: M-ALAM
BC status: Yellow-listed
COSEWIC status: no assessment available (March, 2008)

Published species accounts


Cited as BCMoE SA-M in following text.

Distribution

Provincial range:

Moose can be found throughout BC except on the coastal islands including Vancouver Island and the Queen Charlottes, as well as the coastal fjords therefore are in every ecoregion except the Georgia Depression and the Northeast Pacific. They can be found in all biogeoclimatic zones with the exception of the CDF, Bunchgrass and Ponderosa Pine (BCMoE SA-M).

Elevation range:

Moose can be found from sea-level to alpine but are seldom found in areas above 1300m in the winter (BCMoE SA-M).

Provincial context:

The population of moose in BC is estimated at 240,000 (BCMoE SA-M). Moose are most abundant in central and northern BC (Blood 2000c). In BC, typical population densities in winter range from 0.3 moose per km$^2$ to 1.5 per km$^2$ (Blood 2000c).
General ecology and life history

Reproduction:

The moose breed between September and late October and bear 1 to 2 calves in late May or early June. They can first breed at 1.5 years but peak productivity for females is not reached until 4 years of age. Due to intra-sexual competition, males often don’t begin breeding until 5 or 6 years of age (BC CDC 2010r).

Movements and home range:

Not all moose are migratory and the size of their home ranges varies widely. Non-migratory moose may have a home range anywhere from 6 to 27 km² in the winter to 2 to 35 km² in the summer (Petticrew and Munro 1979, Stevens and Lofts 1988). In the southern interior, seasonal ranges may vary from 2.2 km² (males) to 6.2 km² (females) in the summer, to 10 km² (males) to 7.4 km² (females) in the fall and 5.8 km² (males) to 6 km² (females) in the winter (Stevens and Lofts 1988). Densities of moose can also vary greatly.

Feeding habits:

Moose are browsers but will occasionally graze during the summer (Franzman 1978). Although feeding habits can vary greatly, they are generally characterized by heavy use of woody browse from early successional sites such as is found during the early stages after disturbance (Franzman 1978). In the winter, they will feed on mainly low quality woody browse but will feed on non-woody vegetation if it is available (BCMoE SA-M). During the spring and summer, they feed more selectively then in winter but feed primarily on leaves of woody plants. In BC preferred browse includes willows, red osier dogwood, saskatoon, aspen (Populus tremuloides), high bush cranberry (Viburnum edule), bog birch (Betula glandulosa), lodgepole pine (Pinus contorta), paper birch (Betula papyrifera) and mountain ash (Sorbus sitchensis) (BCMoE SA-M). Species specific browse may occur preferentially depending on its height and accessibility.

Range use: Life Requisites

General:

Moose are generally found in semi-open forest with abundant browse as well as floodplains of major rivers, riparian areas of streams and lakes, wetlands, regenerating burns and cutblocks and early successional avalanche chutes with abundant shrubs (BCMoE SA-M). In BC they also seem to prefer successional stages dominated by deciduous trees and shrubs. Forage and climate are considered the 2 most important variables determining moose distribution (BCMoE SA-M). Winter range is usually restricted to elevations lower than 900m and is critical to moose survival; the lack of winter range can be a limiting factor in moose populations (BCMoE SA-M). Moose have the ability to adapt to varied vegetation but are greatly dependant on key shrub species.
in winter such as: willows, falsebox (*Pachistima myrsinites*), balsam (*Abies spp*.), serviceberry (*Amelanchier alnifolia*), paper birch, and mountain ash (*Sorbus spp.*; Singleton 1976). They may also feed on red-osier dogwood (*Cornus stolonifera*), red cedar regeneration, *Vaccinium spp.*., alder, cottonwood (*Populus balsamifera ssp. trichocarpa*), paper birch, and aspen (Peek 1974; Petticrew and Munro 1979). Winter range may include forested areas adjacent to either natural openings or recently disturbed sites such as clearcuts or fires. The structural stage is important as it is related to the amount of available shrubs and winter browse. Clearcuts 10-20 years old often have these characteristics (BCMoE SA-M). Areas of high value winter habitat can be described as having > 30%-50% shrub cover, mature tree density of <200 stems/ha and gentle slopes of <7% (Romito et al. 1996; VanDyke 1995). Preferred winter habitat is riparian habitat on the floodplains of major rivers, riparian shrub thickets on tributaries, or low elevation regenerating burns on warm aspects (BCMoE SA-M).

**Foraging habitat/mineral licks:**

Ideal spring habitat for moose is considered to be south facing, deciduous leading stands which provide relatively open conditions and abundant preferred forage (BCMoE SA-M). In the spring they feed on aquatic vegetation and forage primarily in areas that have early green-up. In the summer, the amount of woody browse is decreased and the amount of succulent vegetation such as aquatic macrophytes increases. Much of the summer is spent around wetlands such as shallow ponds and small lakes where aquatic vegetation is accessible. Not all wetlands provide similar life requisites for moose, and the capability of a wetland to produce aquatic macrophytes and preferred browse depends on substrate, pH, soil temperatures and flow rates (Fraser et al. 1984). Adair et al. (1991) state that small lakes 1-5ha in size with organic bottoms, slow streams, and beaver ponds are most likely to produce this habitat. Willow and horsetail (*Equisitum spp.*) are considered the most important terrestrial species consumed by moose in the summer (Peek 1974; Singleton 1976). Other terrestrial browse used by moose in the summer is: swamp birch (*Betula glandulosa*), include red-osier dogwood, highbush cranberry, trembling aspen, saskatoonberry, and twinberry (BCMoE SA-M). In central BC, the area of highest summer use is thought to be the ESSF biogeoclimatic zone, in particular, areas with low slopes, seepages and standing water, and other upper elevation sites described as climax timberline communities of birch and willow combined with heath and forbs interspersed with sub-alpine forest (LeResche et al. 1974; Modaferri 1992). Peek (1974) states that the use of any particular browse is contingent on season of use, population density as well as, abundance and distribution of the browse species. Winter habitat is described in the sections below.

**Cover from thermal extremes:**

In summer, moose will often immerse in water to stay cool but shaded forest is considered more important; structure and species does not seem as important as a canopy closure of at least 60% (BCMoE SA-M). In winter, as snow depth increases, thermal cover becomes more important. It is suggested that the most effective habitat for snow interception is low elevation, south exposure with a minimum of 65% canopy closure (Nyberg 1990) although too much canopy closure restricts light to the understory. During periods of heavy snow accumulation most foraging occurs within 80m of cover (Hamilton et al. 1980). During periods of high wind chill, shelter is important; this
may be topographic or small coniferous stands that are low enough density to allow solar radiation to penetrate (Forbes and Théberge 1993).

**Natal sites/denning/nesting:**

**Security:**

Security habitat is most vital during calving and usually consists of islands and gravel bars on floodplains or areas of dense growth of shrubs or mature white spruce-poplar stands with a minimum of dense understory. Cows and calves require landscape features adjacent to water for escape from predators. They also may use dense stands of deciduous or tall shrubs with a canopy cover of at least 50% (BCMoE SA-M). In the summer and fall, moose may also use coniferous and mixed forest, shrubs in riparian habitat and thickets of willow on plateaus. Winter security cover is often in dense coniferous forest adjacent to foraging habitat (BCMoE SA-M).

**Range use: Interaction with agents of disturbance/competition**

**Disturbance factors:**

No specific information available for large-scale disturbances such as MPB. There is potential for loss of cover in high-quality wetland complexes.

**Competitors:**

Deer will compete with moose for browse. In addition, in times of food shortage elk will also compete for food resources (McMillan 1953). However, moose are adapted to a niche where there is minimal competition from other ungulates (Blood 2000c).

**Range use: Mortality factors**

The main natural causes of death in moose are from predation and starvation (Blood 2000c). During severe winters with deep snow cover moose are in poor condition and the most common cause of death is starvation or wolf kill. Black bears are a significant predator on newborn calves and grizzly bears will also predate on moose from spring to fall. In some areas, cougars may also predate on moose. Although not common, moose may also succumb to heavy tick infestations when they are weakened by malnutrition. Moose are also killed by humans through hunting, poaching and accidents with vehicles and trains (Blood 2000c).
Potential limiting factors and threats

Predation is a major regulating factor for moose populations (Gasaway et al. 1992; Ballard 1992). Other limiting factors of moose populations may be food availability, snow accumulation, and hunter access (Dussault et al. 2005). A study in Ontario indicated that if hunter access increased in conjunction with landscape disturbance, moose density decreased; density increased if disturbance occurred without hunter access (Rempel et al. 1997).

Winter range is usually restricted to elevations lower than 900m and is critical to moose survival. Lack of adequate winter range can be a limiting factor in moose populations (BCMoE SA-M).
Caribou

Scientific name: *Rangifer tarandus* (Linnaeus 1758)
Species code: M-RATA
BC status: Red/Blue: Some local populations of northern woodland caribou in the Southern Mountain Ecological area are designated as Red-listed, while some northern populations of northern caribou are designated as Blue-listed (BC CDC 2010t).

COSEWIC status: T/SC: Northern caribou in the Southern Mountains National Ecological Area are designated as Threatened and northern caribou in the Northern Mountains Ecological Area is designated as Special Concern (BC CDC 2010t).

Published species accounts


Distribution

Provincial range:

The northern woodland caribou occur in the western and northern mountainous parts of BC where snowfall is relatively low. In west central BC they are located in and around the Itcha, Ilgachuz, Rainbow, and Trumpeter mountains, northern Tweedsmuir Provincial Park, Entiako Provincial Park and Protected Area, Telkwa Mountains as well as the northern part of Takla Lake. In the northern part of the province they can be found from the Williston Lake area north to the Yukon border, as well as northwest to Atlin, and southeast along the east side of the Rockies to the Alberta border near Kakwa Provincial...
Park (BC CDC 2010t). The northern ecotype is found in the following ecoprovinces: Boreal Plains, Central Interior, Coast and Mountains, Northern Boreal Mountains, Sub Boreal Interior, Southern Interior Mountains, and Taiga Plains (BC MWLAP 2004e).

Elevation range:

Northern caribou use a variety of elevations depending on season and local population. In winter, they are found in subalpine forest or above the treeline on windswept alpine slopes from 1500m to over 2000m or in forested habitat at lower elevations; 500 to 1500m depending on local population. In the summer they may be found anywhere from 500m in coastal areas to 2500m in mountainous areas (BC MWLAP 2004e).

Provincial context:

The population of northern caribou is estimated at 16,235; 5,235 in the Southern Mountains National Ecological Area and 11,000 in the Northern Mountains Ecological Area (BC CDC 2010t).

General ecology and life history

Reproduction:

The rut for this polygynous ungulate occurs from late September to mid October. Rutting groups may number 20 or more with a dominant male mating with several cows (BC MWLAP 2004e). During calving, this species exhibits a number of anti-predator strategies, including calving alone in isolated rugged locations or on islands in low elevation lakes in forested habitat (BC MWLAP 2004e). Caribou have relatively low productivity compared to other ungulates. Adult females generally have only one calf per year and most yearlings do not become pregnant (BC MWLAP 2004e). Gestation is approximately 230 days. When calves are first born they make up approximately 27 to 30% of the population but within a year they only represent less than 20% of the population (BC MWLAP 2004e).

Movements and home range:

Home range sizes for northern caribou are highly variable depending on the local population and horizontal distances moved between summer and winter ranges. In north and north-central BC the home range size may be as large as 1100-1900 km² or as small as 150 km² (Hatler 1986, Terry and Wood 1999, Poole et al. 2000). There are also variable seasonal movements and habitat use by this ecotype. Some populations migrate long distances between summer and winter range. The relative use of high elevation versus low elevation winter range may vary not only between populations but also within populations between winters. These variations reflect differences in the topography, snow accumulation and availability of habitat at low elevations that occurs between areas and populations (BC MWLAP 2004e). Similar to mountain caribou, the northern caribou can be described as having 4 seasonal time periods: (1) late fall (e.g., November) movements from high elevation summer ranges to early winter habitat at
lower elevations triggered by snowfall; (2) mid to late winter movements into low elevation forested habitat or high elevation alpine/subalpine winter ranges providing abundant terrestrial lichens (BC MWLAP 2004e); (3) in late April, those caribou that choose to migrate begin moving back to calving and summer ranges along relatively snow-free low elevation routes (Cichowski 1993, Johnson et al. 2002); and (4) those that winter at high elevations move to lower elevations to take advantage of spring green-up (BC MWLAP 2004e).

**Feeding habits:**

The primary forage of northern caribou is terrestrial lichens; in the winter their preferred forage is *Cladina* but they will also feed on genera such as *Cladonia*, *Cetraria*, and *Stereocaulon* (BC MWLAP 2004e). They may also feed on some arboreal lichens in winter, especially when conditions make access to terrestrial lichens difficult (BC MWLAP 2004e). In the spring, they also feed on forbs and graminoids. Summer diets consist of a variety of forbs, graminoids, lichens, fungi and leaves of some shrubs (BC MWLAP 2004e).

**Range use: Life Requisites**

**General:**

Both calving sites and rut locations are important and vulnerable habitat elements. Each is difficult to classify as a specific habitat type. Calving sites can vary between years and do not appear to be chosen according to habitat type but rather by the extent of isolation from other caribou, ungulates and predators. Rutting locations are more predictable from year to year, but can only be located by having knowledge of specific local populations (BC MWLAP 2004e). The most critical component of northern caribou range is access to high undisturbed calving range (BC MWLAP 2004e).

**Foraging habitat/mineral licks:**

Foraging and security habitat for northern caribou often are in the same locations, and commonly consist of older forest in large contiguous patches. These large old growth areas generally have fewer alternate prey species (Bergerud 1992). These forests also provide better visibility for predator avoidance as well as being a good source of terrestrial lichens such as *Cladina*, *Cladonia*, and *Cetraria*. The large crowns of the older trees provide good snow interception and the contiguous nature of these larger patches decreases the energy needed by caribou to move between foraging sites (BC MWLAP 2004e). Old stands of lodgepole pine (*Pinus contorta*) or lodgepole pine and white spruce (*Picea glauca*) at low elevations are widely used. Alpine habitats are also used by northern caribou in both summer and winter. Such alpine areas provide forage as well as open vistas that allow detection of predators (BC MWLAP 2004e).

Mineral licks are also considered a vulnerable habitat element. These licks are used consistently year to year and can only be located by having knowledge of local populations (BC MWLAP 2004e).
Cover from thermal extremes:

Natal/denning/nesting:

Security:

Range use: Interaction with agents of disturbance/competition

Disturbance:

Caribou are most sensitive to disturbance during calving and the rut (Webster 1997). Caribou are known to be affected by disturbance factors such as petroleum exploration activities and may become displaced as a consequence (Bradshaw et al. 1997). Snowmobile activity in traditional winter ranges causes increased stress on the caribou and invokes avoidance behaviours. Hard packed snowmobile trails also provide predators with easy access to caribou wintering areas (Webster 1997). The significance of disturbance to caribou by aircraft is uncertain; however, caribou have shown increased sensitivity to aircraft during the rut (Calef et al. 1976, Webster 1997). All terrain vehicle (ATV) use also has the potential to disturb caribou. In particular, ATV use in the alpine during calving may displace the caribou into less preferred habitat (Webster 1997) where they may be at increased risk of mortality. Human presence and road traffic also has the potential to increase stress levels (Webster 1997).

Competitors:

Elk, deer and moose may compete with caribou for some forage. However, the main threat these other ungulates pose to caribou is by being significant prey for predators (BC MWLAP 2004e), thereby increasing the mortality risk to caribou.

Range use: Mortality factors

Predation is often the leading cause of mortality. In a recent study on woodland caribou, Wittmer et al. 2005 states that the major proximate cause of population decline appears to be predation on adult caribou. In the northern subpopulations wolves and bears were the predominant predators and in the southern subpopulations, bear, wolverine and cougar were predominant. Recent studies are indicating that an increase in populations of alternative prey is leading to increased predator pressure on the caribou (Wittmer et al. 2005). In multiple predator/prey systems caribou tend to be the most vulnerable species (BC MWLAP 2004e). This increase in alternative prey may have been influenced by habitat alterations that have led to more early seral habitats preferred by
other ungulate species (Kinley and Apps 2000). Other causes of mortality in caribou are hunting, poaching accident and malnutrition (BC MWLAP 2004e, Wittmer et al. 2005).

**Potential limiting factors and threats**

The BC CDC (2010t) lists the major threats to northern caribou as: predation, access, industrial development, and natural disturbances. Predation is thought to be the greatest threat (BC CDC 2010t); it is suggested that in areas where wolf populations are sustained by alternate prey species, caribou populations can be eliminated (Seip 1992). Increased access leads to disturbance from such things as recreation, hunting and poaching as well as increasing predator efficiency (BC CDC 2010t). Industrial development can threaten winter food supply as well as lead to an increase in early seral stages which supports alternate prey; it will also increase habitat fragmentation and access (BC CDC 2010t). Natural disturbances such as fire and the current mountain pine beetle epidemic may also threaten northern caribou herds. Williston and Cichowski (2004) note that the mountain pine beetle outbreak may greatly affect the abundance of terrestrial lichen which caribou depend on for forage.
Mountain Goat

**Scientific name:** *Oreamnos americanus* (de Blainville 1816)

**Species code:** M-ORAM

**BC status:** Yellow

**COSEWIC status:** No current status

*Published species accounts*


*Distribution*

**Provincial range:**

The mountain goat is found throughout BC in all 9 MOE regions but is absent from Vancouver Island and the Queen Charlottes (BC CDC 2010u). In BC, the mountain goat is found on all major mountain ranges of the mainland (Festa-Bianchet 2008). It is found in the following BEC zones: BAFA, CMA, CWH, ESSF, ICH, IDF, IMA, MH, MS, PP, and SWB (BC CDC 2010u).

**Elevation range:**

This species is found in alpine and subalpine habitat. (BC CDC 2010u)

**Provincial context:**

In Canada, the mountain goat population is believed range between 44,000 to 72,000 with BC’s population ranging from 39,000 to 67,000 (Festa-Bianchet 2008).
General ecology and life history

Reproduction:

The mountain goat has a gestation period of 5 to 6 months and 75 percent of the time produces a single kid; 25% of the time they have twins (Eder and Pattie 2001, Festa-Bianchet 2008). Within hours, the young are able to follow the mother and after only a few days are able to forage on grasses and forbs. However, they are not weaned till about 6 weeks of age. Both sexes become sexually mature at about 2 ½ years of age (Eder and Pattie 2001). Females may bear their first young between 2 and 5 years of age (Festa-Bianchet 2008).

Movements and home range:

The mountain goat generally stays above the treeline throughout the year, but will seasonally migrate to higher or lower elevations often seeking out low elevation mineral licks in the summer (Festa-Bianchet 2008). It is most active early morning and late evening, often foraging through the night (Festa-Bianchet 2008). Movements over a 24 hour period may cover several hundred metres and they are capable of covering over 450 vertical metres in 20 minutes (Huffman 2004). The average home range size is 23 square kilometres; in winter it is much smaller (Huffman 2004).

Feeding habits:

The mountain goat is herbivorous, feeding on a wide variety of vegetation (Eder and Pattie 2001) such as herbs, sedges, grasses, moss, ferns, lichen, and the leaves and twigs of shrubs and conifers (Festa-Bianchet 2008). It is most active early morning and late evening, often foraging through the night (Festa-Bianchet 2008).

Range use: Life requisites

General:

This species primarily occurs in alpine and subalpine habitats using rocky cliffs and steep slopes where low temperatures and deep snow are common (Eder and Pattie 2001). They may be found in high altitude habitat to the limit of vegetation but in coastal areas may be found as far down as sea level (Festa-Bianchet 2008). Through most of the year they are found above treeline but may seasonally migrate to higher or lower elevations. In the summer, they may travel through supalpine or montane forests to lower elevations in order to reach salt licks (Eder and Pattie 2001, Festa-Bianchet 2008). In winter they generally seek out high, windswept ledges where they can find vegetation which is free of snow (Eder and Pattie 2001).
Foraging habitat/mineral licks:

The mountain goat varies its diet according to the habitat in which it is found. In some locations it may feed almost exclusively on shrubs and supplement its diet with plants such as forbs, mosses and lichens. In other locations, shrubs form only a small portion of the diet with the remaining forage being made up of plants such as grasses, rushes and sedges (Eder and Pattie 2001). Salt in the diet becomes a necessity at the same time as the early summer moult (Eder and Pattie 2001) and the pursuit of this mineral may take them several kilometres through subalpine or montane forests (Festa-Bianchet 2008).

Mineral licks become very important during the early summer and mountain goats may travel long distances to find rich mineral soils (Eder and Pattie 2001).

Cover from thermal extremes:

Natal sites/denning/nesting:

Mountain goats are often found bedding down in depressions they have scraped in the dirt at the base of cliffs. They will often dig dusting pits in the early summer (Eder and Pattie 2001).

Security:

This species will often be found near steep, rocky terrain which they use as escape terrain (Eder and Pattie 2001).

Range use: Interaction with agents of disturbance/competition

Disturbance:

It is proposed that many coastal populations may be affected by the current and future forest harvesting of these areas (Festa-Bianchet 2008). Mountain goats are also thought to be more sensitive to human disturbance than most ungulate species.

Competitors:

Range use: Mortality factors

Mortality is much higher in males than females with few males surviving longer than 10 years; females seldom survive longer than 16 years (Festa-Bianchet and Côté 2008). Avalanches are a major mortality factor for the mountain goat especially during late
winter and spring (Eder and Pattie 2001). Predators of the mountain goat are cougars, wolves and bears (Festa-Bianchet 2008).

**Potential limiting factors and threats**

In Canada, some goat populations and their habitat are protected within the boundaries of national and provincial parks (Festa-Bianchet 2008). Some hunting is permitted within provincial parks, but harvest rate in BC although varying between populations, ranges from 0.4 to 9% of the population (Hebert and Smith 1986) so is not thought to be a limiting factor (Festa-Bianchet 2008). However, it is thought that mountain goats are more sensitive to human disturbance than most ungulate species. Conservation measures in BC however indicate the importance of determining the winter habitat requirement for mature forest on steep slopes in the coastal mountains; it is thought that many coastal populations may be affected by the current and future forest harvesting of these areas (Festa-Bianchet 2008).
Grizzly Bear

**Scientific name:** *Ursus arctos* (Linnaeus 1758)
**Species code:** M-URAR
**BC status:** Blue-listed
**COSEWIC status:** SC (May 2002)

*Published species accounts*


*Distribution*

**Provincial range:**

Grizzly bears are found throughout BC except on Vancouver Island (although animals have been sited occasionally) and the Queen Charlotte Islands, and are likely extirpated from some areas of south (Greater Vancouver) and south-central BC (central Okanagan; BC MWLAP 2004f; BC CDC 2010v). Grizzly bears are found in all ecoprovinces in BC except the Northeast Pacific (Cannings et al. 1999).

**Elevation range:**

Grizzly bears are found at all elevations from sea-level to alpine.

**Provincial context:**

The population of grizzlies in the province was estimated at 16,887 bears in 2004 (Hamilton et al. 2004). BC’s population accounts for roughly half the number of grizzlies found in all of Canada (BC MoE SA-GB). For the most part, the population is considered stable, although there is thought to be some areas of local decline. It is felt that they are threatened in 8% of their BC range and extirpated from roughly 10% of their BC range (BC MWLAP 2004f).
General ecology and life history

Reproduction:

In south-eastern BC grizzly bears were found to begin breeding when they were approximately 6 years old and produced young approximately every 2.7 years (McLellan 1989). Like fisher, grizzly bears have delayed implantation so breeding occurs between April and June but the cubs are born during hibernation between January and March (BC MoE SA-GB); the average litter size was reported by (McLellan 1989) to be 2.3. The young tend to stay with the mother for at least 2 years (BC MWLAP 2004f).

Movements and home range:

Grizzly bears are generally solitary with the exception of females with cubs, sibling groups or during mating. They have large annual and seasonal home ranges; one study in the Flathead Valley averaged 446 km$^2$ for males and 200 km$^2$ for females (McLellan 1981). Mother and daughters often overlap and males will tend to overlap with several females (Bunnell and McCann 1993). The size of the home range is in proportion to food quantity, quality and distribution (BC MWLAP 2004f). For example, the home range of a grizzly on the coast that includes salmon streams was smaller (male avg min=137 km$^2$; females=52 km$^2$) then drier interior mountains and plateaus (male avg min=804 km$^2$; female=222 km$^2$) (Ciarniello et al. 2001; McLellan 1981; Russell et al. 1979; Wielgus 1986). Grizzlies display strong site fidelity and will return to the same sites throughout their lives (BC MWLAP 2004f).

Feeding habits:

Grizzly bears are omnivores and are opportunistic foragers (BC MWLAP 2004f). They tend to have flexible eating habits and usually use the same seasonal areas and food sources throughout their lives (BC MWLAP 2004f). The Grizzly makes use of the most digestible food in the various seasons such as early spring vegetation, ungulates in early spring and often salmon in the fall (BC MWLAP 2004f). The greatest regional difference in feeding pattern happens between the coastal and interior bears. On the coast (Hamilton 1987; MacHutchon et al. 1993), bears begin the year feeding on young vegetation (i.e., skunk cabbage (Lysichiton americanus) and sedges) in estuaries and wetland sites and as the snows melts, work their way up avalanche chutes feeding on the emerging vegetation. Upon completion of this seasonal migration in pursuit of young vegetation, bears return to the lower slopes and floodplains. Here, they feed on berries, shifting to salmon as they become available. Throughout the seasons they are also opportunistic, feeding on other sources available such as insects, grubs and mollusc in the intertidal. In the interior (Ciarniello et al. 2001; McLellan and Hovey 1995), the bears begin the year feeding on roots (i.e., Hedysarum spp., spring beauty (Claytonia lacneolata), avalanche lily (Erythronium grandiflorum)), carrion and ungulates weakened by the winter. They then feed on the emerging green vegetation such as grasses and sedges as well as calving ungulates and continue to feed on emerging vegetation (i.e., cow parsnip [Heracleum spp.]), fruit and small mammals throughout the summer. Berries at high elevations are the most important fall food for the interior bears although, like the
coast, remain opportunistic throughout the year feeding on such things as fish, insects and roots as they are available.

**Range use: Life Requisites**

**General:**

Grizzly bear habitat is closely associated with the seasons. As the food requisites change so does the habitat. Specific seasonal habitat attributes are listed in BCMoE SA-GB.

**Foraging habitat:**

Grizzly bear feeding habitat changes as the diet changes throughout the seasons. In spring, vegetation is found in forest openings (i.e., meadows, wetlands and seepages) riparian areas, south and west facing vegetated avalanche chutes, alpine meadows, cutblocks and floodplains (BCMoE SA-GB). Grizzlies usually stalk winter-weakened ungulates in ungulate winter ranges. During the summer north aspect wet areas that provide the favoured vegetation and berries at low and high elevations are used. Berry production is most abundant at high elevations and at lower elevations in natural openings and forests with canopy closures of 20-50% as well as openings created by disturbances such as fire and 10-20 year-old clearcuts (BCMoE SA-GB). In the fall, depending on the region, either salmon spawning streams or areas of high berry production become important. Coarse woody debris as a source of insects and larvae are important throughout the year (BCMoE SA-GB).

**Cover from thermal extremes:**

To escape the heat of summer, bears will seek out shade under rock overhangs, in shrub areas or in forested areas with CWD. They will also use water such as ponds, streams and wetlands to cool down (BCMoE SA-GB). In the winter, bear dens are located in areas where the hillside and snow can provide insulation (BCMoE SA-GB).

**Natal sites/denning/nesting:**

Habitat used for hibernating tends to be on slopes that are dry and stable and remain frozen throughout the winter (Bunnell and McCann 1993). They usually den from mid-October to May, however, adult males tend to be active longer and emerge earlier than females (Wielgus 1986). Dens can occur on any aspect but are usually in alpine and sub-alpine habitat where the snow and hillside provide insulation. Habitat characteristics needed for dens include, stumps, large trees, steep slopes or cutbanks and well drained substrate (BCMoE SA-GB). Vroom et al. (1977) found the mean slope of dug out dens in the Banff area was 33°.
Security:

Security habitat for grizzlies is needed to avoid both intra- and inter-specific (primarily with humans) contact (BCMoE SA-GB). To avoid other bears, grizzlies require forested habitat for security that is adjacent to early successional habitat for foraging (Jonkel 1987). To avoid aggressive males, females with cubs will use isolated rugged habitat and forest with diverse understory that is older than pole-sapling (Pearson 1975). To avoid humans, grizzlies require an adequate amount of high quality forest cover next to roads or these areas will be avoided (McLellan and Shackleton 1988).

Range use: Interaction with agents of disturbance/competition

Disturbance:

The increase in backcountry recreation has raised concerns because grizzly bears are vulnerable to disturbance at their den sites (Podruzny et al 2002). This disturbance may lead to elevated energy use as a result of increased movement in the den, abandonment of the den, potential loss of cubs and displacement from the den (Podruzny et al 2002).

Competitors:

For part of its diet the grizzly bear competes for food with other carnivores such as wolves, black bears, and cougars.

Range use: Mortality factors

Human caused deaths are the major source of mortality for grizzly bears (Cannings et al. 1999). McLellan et al. (2000) analyzed data for 388 grizzly bear mortalities from studies in the Rocky and Columbia mountains of Alberta, BC, Montana, Idaho and Washington and found that 77-85% of mortalities were caused by people. Where hunting was allowed, legal harvest accounted for 39-44% of deaths. They found that males had higher mortality due to hunting than females but females had higher mortality rates from natural causes. Natural mortality however, seems to be relatively minor; there appears to be no known diseases or parasites that would impact natural populations (BC MWLAP 2004f). Within the first 4 weeks of life, malnutrition appears to play a role in cub mortality indicating that pregnant females’ nutritional state entering the den is important (BC MWLAP 2004f). As well, predation or cannibalism appears to play a role in population regulation but the extent is not known (BC MWLAP 2004f).

Potential limiting factors and threats

Inter/intra specific competition, predation, and hunting can all influence grizzly populations and distribution. Grizzly distribution is especially influenced by intra-specific interactions and human disturbance (BCMoE SA-GB). Human disturbance may come in many forms, from urban and industrial development to recreation and hunting. The major limiting factor of the current population of grizzlies is thought to be human related;
especially habitat loss, alienation and fragmentation (McLellan et al. 2000, Kansas 2002). Human related mortality also comes in the form of hunting, poaching, and control kills due to close human-bear contact (i.e., poor garbage management, threatened livestock; BC MWLAP 2004f). Increased road access leads to both, direct mortality from accidents, hunting and poaching as well as habitat alienation (McLellan 1990). Roads also increase human activity such as recreation which can also lead to displacement. Direct human related mortality of adult females can be a significant threat if they occur in localized populations that experience low immigration rates (BC MWLAP 2004f). Isolation can also play a significant role in threatening grizzly populations; if populations in these isolated areas are low, restricted immigration can lead to a poor chance of recovery as well as potential inbreeding (BC MWLAP 2004f).
Pine Marten

Scientific name: *Martes americana* (Turton 1806)
Species code: M-MAAM
BC status: Yellow-listed
COSEWIC status: NL (not listed March, 2008)

Published species accounts


Distribution

**Provincial range:**

Pine marten are found throughout BC generally coinciding with boreal and montane coniferous forest (Eder and Pattie 2001). In BC, the marten are found in most forested biogeoclimatic zones and are found in every ecoprovince except Northeast Pacific (Lofroth 1993).

**Elevation range:**

Pine marten may be found at most elevations including alpine (Eder and Pattie 2001).

**Provincial context:**

Pine marten population numbers are considered fairly stable\(^{16}\) although may be cyclic in nature (Eder and Pattie 2001). Densities of marten may vary considerably among seasons and years largely driven by changes in food supply\(^{17}\). In the fall, densities of 1 to 2 per km\(^2\) have been recorded (BC CDC 2010w). Although there is variation depending on the area population densities of marten across North America range from 0.4 to 2.4 animals per km\(^2\), the highest densities occurring in the fall\(^{18}\).

\(^{17}\)http://ilmbwww.gov.bc.ca/risc/pubs/tebiodiv/marten/maweml20-07.htm
\(^{18}\)http://www.elp.gov.bc.ca/fw/docs/marten.pdf
**General ecology and life history**

**Reproduction:**

The pine marten breeds in the summer but has delayed implantation and bears 1 to 5 young the following spring. Natality and food supply appear to be correlated. When food is scarce, fewer young are born. Females become sexually mature at 1 to 5 years of age and males at a year (BC CDC 2010w).

**Movements and home range:**

Pine martens are generally solitary creatures with home ranges that vary in size but average less than 10 km$^2$. This may increase if food becomes scarce. Female home ranges are usually smaller than males and males will often overlap with several females (BC CDC 2010w). In the early fall, densities may be 1-2 martens per km$^2$. Young can disperse more than 40 km (BC CDC 2010w).

**Feeding habits:**

Pine martens feed mainly on small mammals, birds, insects or carrion but may also feed on vegetation such as berries and other seasonal vegetation (BC CDC 2010w). They may use various foraging techniques such as tracking, ambushing, excavation of burrows and hunting subnivean prey. They also use hunting perches (BC CDC 2010w). In summer, they may also feed in the alpine on pikas and marmots (Eder and Pattie 2001).

**Range use: Life Requisites**

**General:**

Pine martens are usually found in coniferous upland and lowland forests with an abundance of CWD but may also be found in either dense deciduous or mixed forest (BC CDC 2010w, Eder and Pattie 2001). They may also use rocky alpine areas (BC CDC 2010w). They are not known to occupy recent clear-cuts or burns (Eder and Pattie 2001). Lofroth (1993) found that pine martens generally avoid young seral stages, xeric habitat types and wetlands. However, if specific habitat needs are met, martens with larger home ranges and lower population densities may use areas with younger seral conditions (Lofroth 1993). Lofroth (1993) also found that, at the stand scale, habitat was selected for the abundance of structural features such as CWD, deciduous canopy closure, high and low shrub closure, as well as abundance and size of trees and snags. Habitat selection is most pronounced during winter when foraging opportunities become limited, thermoregulatory costs are at their peak and movement is restricted (Lofroth 1993).
Foraging habitat:

The pine marten is often used as an indicator species due to its dependence on mature conifer forests for food (Eder and Pattie 2001). They forage in forests that have plenty of CWD as well as branches and leaves that provide cover for their prey.

Cover from thermal extremes:

The pine marten may find thermal cover in a hole in a tree or a subnivean burrow or rock pile (BC CDC 2010w).

Natal sites/denning/nesting:

Natal and maternal dens are often located in hollow trees or rock piles (BC CDC 2010w).

Security:

The pine marten may find security cover in a hole in a live or dead tree or stump, an abandoned squirrel’s nest, conifer crown, rock pile, burrow or snow cavity. In the winter, they most commonly use subnivean sites often associated with CWD.

Range use: Interaction with agents of disturbance/competition

Disturbance:

No specific information available for large-scale disturbances such as MPB.

Competitors:

Pine marten and fisher can compete for similar food resources such as voles and mice (Weir 2003). It is thought that fisher can out-compete pine marten in areas of low snowfall, but pine marten may out-compete fisher in areas with greater snowfall such as the Engelmann Spruce-Subalpine Fir biogeoclimatic zone (Weir 2003). Species that prey on pine marten also compete with them for the same food resources (e.g., coyote, fisher and raptors).

Range use: Mortality factors

No diseases or parasites, although present, are thought to influence pine marten population levels. However, due to their high metabolic rates and low fat reserves they are susceptible to energetic stresses increasing their vulnerability to the effects of

---

19 [http://www.elp.gov.bc.ca/fw/docs/marten.pdf](http://www.elp.gov.bc.ca/fw/docs/marten.pdf)
parasites and disease as well as starvation. This also increases their vulnerability to predation. Pine marten that do not have secure home ranges or dispersing juveniles are most susceptible to these mortality factors. Predators of pine marten include larger raptors, fisher, lynx, bobcat, coyote, wolves, and in extreme conditions, other pine marten\(^8\). Pine marten are also one of the primary furbearers trapped in BC\(^8\).

*Potential limiting factors and threats*

The main threats to pine marten are silvicultural practices that lead to loss of habitat structure and over trapping\(^{20}\). Food supply is also a major determinant of population levels\(^8\).

Wolverine

Scientific name: *Gulo gulo luscus* (Linnaeus 1758)
Species code: M-GUGU-LU
BC status: Blue-listed
COSEWIC status: SC (May 2003)

Published species accounts


Distribution

Provincial range:

Historically, wolverines were found throughout BC at low densities except on the Queen Charlotte Islands. They may now be extirpated on Vancouver Island, the lower Fraser Valley, Okanagan Basin and the Thompson River (BC MWLAP 2004g). Wolverines could be found in all ecoprovinces except Northeast Pacific (Cannings et al. 1999).

Elevation range:

Wolverines may be found from the valley bottoms up into the alpine. The upper limit is most likely determined by prey distribution (BC MWLAP 2004g). Adult females are found at higher elevations then other sex and age-classes; this is followed by sub adult females and adult males with subadult males typically found at the lowest elevations (Lofroth 2001; BC MWLAP 2004g).

Provincial context:

In BC the present population estimate for wolverines is 3,530 (Lofroth and Krebs 2007). Predicted mean densities varied with habitat quality but ranged from 0.3/1000 km\(^2\) to 6.2/1000 km\(^2\) (Lofroth and Krebs 2007). The highest densities were predicted to be in the Interior Mountains of BC and moderate densities in the Interior plateau and boreal forest with low densities predicted on the mainland coast and drier interior plateaus. Wolverines are thought to be rare on Vancouver Island, outer mainland coast and dry interior forest. Besides the Queen Charlotte Islands, wolverines are not found on interior grasslands or in areas of high urban development (Lofroth and Krebs 2007).
General ecology and life history

Reproduction:
Wolverines exhibit delayed implantation. Breeding occurs between April and September but implantation occurs in January. One to five cubs are born between late February and mid-April and will stay with the mother for the first winter, dispersing in the spring (BC MWLAP 2004g). Reproduction is found to be closely associated with food abundance (Lofroth et al. 2007).

Movements and home range:
Home ranges of males are often 3 times as large as females; for example in the Omineca males home range was 1366 km² and females was 405 km² and in the Columbia Mountains males was 1005 km² and females was 311 km² (Krebs and Lewis 2000). Home ranges are kept between years but males will overlap home ranges with females and males, but females do not overlap with other females (Krebs and Lewis 2000). Wolverines will display slightly nomadic behaviour when they first disperse away from their mothers; males will disperse between 30-100 km and females a shorter distance (BC MWLAP 2004g). Daily movements by wolverine are most likely influenced by the distribution and availability of food. In highly modified landscapes, human activity can lead to displacement and alterations to the movement paths of wolverines (BC MWLAP 2004g).

Feeding habits:
Wolverines feed on a variety of food depending on the season and its location in BC (Lofroth et al. 2007). Moose (Alces alces), caribou and hoary marmots (Marmota caligata) are common prey, however, in the Columbia mountains the most common and abundant prey are mountain goats (Oreamnos americanus) and porcupine (Erethizon dorsatum) (Lofroth et al. 2007). In the Omineca mountains, the most common and abundant prey are the snowshoe hare (Lepus americanus) and the beaver (Castor canadensis) (Lofroth et al. 2007). In the winter, the prey of reproductive females was most often caribou, hoary marmots and porcupines — a different selection than made by other sex and age classes (Lofroth et al. 2007).

Range use: Life Requisites

General:
The predominant structural stage used by the wolverine is mature and old forest. However, due to the varied diet of wolverines, a wide variety of structural stage may be used in their day to day movements (BC MWLAP 2004g), although Lofroth (2001) found that there is relatively little use of mid-successional forest and late successional forest is used at least 50% of the time. Lofroth (2001) also reports that use of different structural stages varies with sex and season; females use early and late successional forest and
males are generally found most often in late successional forest. Females use early successional structural stages usually at high elevations while rearing their young. Wolverines also frequent alpine habitat (BC MWLAP 2004g). Wolverines seem to prefer traveling by following riparian corridors and using low elevation passes between valleys (BC MWLAP 2004g). Wolverines will avoid clearcuts and watersheds with extensive clearcuts (<25 years old) (BC MWLAP 2004g).

Habitat associations for male wolverines are strongly associated with food (Krebs et al. 2007). In winter, Krebs et al. (2007) found that there were positive associations between male wolverines and moose winter range, valley bottom forests and avalanche terrain. They also found a negative association between helicopter skiing areas and male and female wolverine habitat use. Habitat use by female wolverines was also found to be negatively associated with other winter recreation such as backcountry skiing. Winter habitat use by female wolverines was positively associated with moose winter range in rugged landscapes (Krebs et al. 2007).

**Foraging habitat:**

In a study by Krebs et al. (2007) male habitat use was positively associated with food in both summer and winter in the Omineca and Columbia mountains. Female habitat use is more complex; however, there seems to be a shift from high sub alpine and alpine in the summer to low-elevation forests in the winter. Both male and female wolverines use avalanche paths consistently in both summer and winter. Avalanche kill of large mammals such as moose and mountain goat likely provide abundant prey for wolverines in winter and in the summer and late winter, hoary marmots provide key prey especially for reproductive females (Krebs et al. 2007).

**Cover from thermal extremes:**

**Natal/denning/nesting:**

Wolverines tend to use habitat at a landscape scale. The main stand level features that wolverine seem to use are natal and maternal dens (BC MWLAP 2004g). Placement of these dens in the landscape is important in order to provide security cover for the kits and proximity to food. Dens are usually associated with high elevation (i.e. ESSF/ESSFp) forest openings that are less than 100 m across and are often composed of snow tunnels that lead to piles of CWD or to rocky colluviums (Krebs and Lewis 2000; Lofroth 2001).

**Security:**
Range use: Interaction with agents of disturbance/competition

Disturbance:

Wolverines are considered sensitive to disturbance from roads and recreational activities such as snowmobiles, backcountry skiers and helicopter skiers (BC MWLAP 2004g).

Competitors:

Wolverines compete with other predators for food although they also rely on these same predators to provide them with carrion.21

Range use: Mortality factors

Although parasites are present in wolverines, their populations are not known to be affected by chronic disease or parasite disorders. The greatest source of mortality to wolverine is thought to be trapping and hunting. The greatest source of natural mortality is predation by wolves and starvation.

Potential limiting factors and threats

The key demographic characteristics of wolverines mentioned above (low densities, large home ranges and have relatively low reproductive rates) suggest this species has a low resiliency to population perturbation (Banci and Proulx 1999). Human related activity such as roads and recreation has a negative association with wolverine habitat use and distribution (Krebs et al. 2007). Krebs et al. (2007) found that female wolverines were positively associated with roadless areas and negatively associated with logged areas in summer. From their study, they conclude that both male and female wolverines respond negatively to human activity in their home range. It is thought that habitat loss, over-harvest, and the presence of major transportation corridors and other human related disturbance factors decrease dispersal success between metapopulations (Kyle and Strobeck 2001). Habitat loss and alienation such as large scale conversion of mature and old growth to early structural stages and logging of high elevation forests are thought to be major contributing factors to population declines and may also influence rearing success (BC MWLAP 2004g).

Harvest of wolverines can also contribute to population decline (BC MWLAP 2004g). Over harvest in the past contributed to the decline of wolverine across North America (BC MWLAP 2004g). Human alterations that have contributed to a changing prey base are also a potential contributor to population decrease over the past 100 years. Additive mortality from trapping is believed to be the primary population threat to wolverine and that increased access due to forest development increases this threat (BC MWLAP 2004g).

21 http://www.elp.gov.bc.ca/fw/docs/wolverine.pdf
Literature Cited


APPENDIX C. MODEL PROCESSING AND SEQUENCE OF ACTIVITIES

Introduction

The use of causal webs (McCann et al. 2006) in our application of predicting potential occupancy probabilities for selected wildlife involves activities associated with data management and implementation of a variety of modeling tools. Model processing and sequencing closely follow the procedure laid out in Sutherland and McNay (2008). The description below reflects that description with some updates where procedures and inputs have changed.

Input Data Gathering and Management

Input data for this model was broad in scale and scope. As part of a collaboration on a larger project, solicitations were sent out to the data management group at the Nature Conservancy of Canada to acquire and use data sets prepared for their terrestrial and freshwater modeling work. Other data sources were acquired from Provincial Government Ministries including Ministry of Environment, Ministry of Forests and Range, and Integrated Land Management Bureau. After data acquisition, all raw datasets were backed up and stored offline. Initial preparation of data included standardization (of projection and coordinate system), clipping to study area extent, and conversion to raster format (if necessary). In most cases, this preparation was conducted using ArcGIS ModelBuilder® models (Environmental Systems Research Institute, Redlands, CA) to ensure all data was treated in a consistent and repeatable fashion.

Once models were constructed and all inputs reviewed for consistency in naming convention and state identifiers, we sorted inputs according to the type of data preparation required prior to case file construction as follows: a) those that simply required stratification into node states (e.g., BEC zones, subzones, and variants), b) those that required scripting modification in Netica Manager to derive node states directly from associated databases (e.g., VRI), and c) those that required independent modeling to derive node states (solar loading from a Digital Elevation Model). Spatial layers were constructed accordingly and reviewed for interpretation or coding errors, and case files were then constructed.

Table J contains a listing of all input variables and their sources. A more detailed accounting of input data is available in meta-data consistent with Digital Data Standards for Species Distribution Modeling. Those details are provided under separate cover in a MS Excel spreadsheet provided with the delivered model output grids.

---

22 Netica Manager is a custom application used to implement Netica™ (Norsys Systems Corp., Vancouver, British Columbia) and is based on Microsoft Access (Microsoft Systems Inc., Redmond).
Table J. A list of data inputs contributing to case files used by Netica™ in processing causal-web models for the species modeled in the study area we used.

<table>
<thead>
<tr>
<th>Input Variable</th>
<th>Description</th>
<th>Data source</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stand age for leading/secondary species</td>
<td>Projected age of the stand (projected to a reference year)</td>
<td>VRI&lt;sup&gt;a&lt;/sup&gt;</td>
</tr>
<tr>
<td>Stand height for leading/secondary species, stratified by layer</td>
<td>Projected height of the stand (projected to a reference year) for each layer</td>
<td>VRI&lt;sup&gt;a&lt;/sup&gt;</td>
</tr>
<tr>
<td>Species composition for leading/secondary species</td>
<td>Percentage of each stand in each species</td>
<td>VRI</td>
</tr>
<tr>
<td>Closure for canopy, shrub and herb layers</td>
<td>Percent closure of different layers in each stand</td>
<td>VRI</td>
</tr>
<tr>
<td>Disturbance history</td>
<td>Year and type of last disturbance</td>
<td>VRI</td>
</tr>
<tr>
<td>Inventory type group</td>
<td>Tree species composition</td>
<td>VRI</td>
</tr>
<tr>
<td>Site Index</td>
<td>Measure of tree height at 50 years of age</td>
<td>VRI</td>
</tr>
<tr>
<td>Stand percent (pine)</td>
<td>Percentage of stand in pine</td>
<td>VRI</td>
</tr>
<tr>
<td>Stand percent (fir)</td>
<td>Percentage of stand in fir</td>
<td>VRI</td>
</tr>
<tr>
<td>Non-Productive Code</td>
<td>Identifies non-productive areas and describes their type</td>
<td>VRI</td>
</tr>
<tr>
<td>Volume (m&lt;sup&gt;3&lt;/sup&gt;/ha)</td>
<td>Merchantable volume</td>
<td>VRI</td>
</tr>
<tr>
<td>Year of MPB attack</td>
<td>Year that MPB attacked the stand</td>
<td>SELES projection</td>
</tr>
<tr>
<td>Volume killed by MPB</td>
<td>Volume of merchantable wood killed by MPB</td>
<td>SELES projection</td>
</tr>
<tr>
<td>Aspect</td>
<td>Aspect of a slope in degrees</td>
<td>DEM&lt;sup&gt;b&lt;/sup&gt;</td>
</tr>
<tr>
<td>Slope</td>
<td>Landscape slope in degrees</td>
<td>DEM&lt;sup&gt;b&lt;/sup&gt;</td>
</tr>
<tr>
<td>Elevation</td>
<td>Elevation in metres above sea level</td>
<td>DEM&lt;sup&gt;b&lt;/sup&gt;</td>
</tr>
<tr>
<td>Topographic Curvature</td>
<td>Concave upward or downward curvature of landscape</td>
<td>DEM&lt;sup&gt;b&lt;/sup&gt;</td>
</tr>
<tr>
<td>Solar Radiation</td>
<td>Summer and winter solar radiation inputs as influenced by topography, latitude, and date</td>
<td>DEM&lt;sup&gt;b&lt;/sup&gt;</td>
</tr>
<tr>
<td>Ice &amp; Bare Areas</td>
<td>Non-vegetated surfaces</td>
<td>BTM&lt;sup&gt;c&lt;/sup&gt;</td>
</tr>
<tr>
<td>Landcover Permeability</td>
<td>Surface Landcover/Use as it pertains to animal movement</td>
<td>BTM&lt;sup&gt;c&lt;/sup&gt;</td>
</tr>
<tr>
<td>Winter Precipitation</td>
<td>Precipitation sum for December, January, and February</td>
<td>PRISM&lt;sup&gt;d&lt;/sup&gt;</td>
</tr>
<tr>
<td>BGC subzone</td>
<td>Biogeoclimatic (BGC) subzone classification</td>
<td>BEC&lt;sup&gt;e&lt;/sup&gt;</td>
</tr>
</tbody>
</table>

<sup>a</sup> VRI refers to BC Vegetation Resources Inventory program
<sup>b</sup> DEM refers to a digital elevation model from the BC Terrain Resource Information Management program: [http://ilmbwww.gov.bc.ca/bmgs/trim/index.html#](http://ilmbwww.gov.bc.ca/bmgs/trim/index.html#)
<sup>c</sup> BTM refers the BC Baseline Thematic Mapping program: [http://ilmbwww.gov.bc.ca/cis/initiatives/ias/btm/index.html](http://ilmbwww.gov.bc.ca/cis/initiatives/ias/btm/index.html)
<sup>d</sup> PRISM refers to Oregon State University's PRISM Group precipitation modeling: [http://www.prism.oregonstate.edu/](http://www.prism.oregonstate.edu/)
<sup>e</sup> BEC refers to a spatial coverage of the Biogeoclimatic Ecosystem Classification system for BC (Meidinger and Pojar 1991).

**Modeling Tools and Sequence of Use**

Upon completion of data gathering, modeling tools were constructed in the order described below:

1. Bayesian Belief Networks (BBNs)

   We constructed a few key networks that were applied in multiple models. These special networks included:

   1) mountain pine beetle effects on structural stage, crown volume, canopy closure, snags, coarse woody debris, and forest age and,

   2) BEC subzone effects on coarse woody debris/snags, snowfall potential, spring snowmelt, age to attain old forest structure, relative moisture, and bear food retention through succession.
Each subcomponent of the species models identified in the conceptual model were constructed separately resulting in 70 individual BBNs. These were then amalgamated for each species into:

1) components that required spatial analyses (e.g., distance to denning habitat) and,

2) final composite run models.

2. Netica Manager

Netica Manager was constructed as a custom form for Microsoft Access™ (Microsoft Corp., Redmond, Washington). The form assists with the following operations:

- codes specific data inputs coming directly from databases that are spatially referenced with unique cell identifiers (e.g., VRI). This links various input data sources and classifies them to represent BBN case states for each raster cell location in the study area.

- manages case files for individual BBNs. Classified values are exported to a text delimited ASCII file that Netica™ is capable of processing.

- manages BBN results. Netica Manager imports model results from executing BBNs using Netica™ (stored as ASCII result files) back into Access™ and joins them to spatially referenced data to allow results to be expressed visually on a map.

Use of Netica Manager was instituted primarily to reduce the likelihood of human error when implementing a series of BBN in repetition across multiple study areas.

3. Spatial Layers

Spatial input layer construction was a time intensive process. For reclassified spatial layers, raster grid values were prepared according to established routines and standards, calculated and summarized by model node state; for example, a 25m Slope grid was derived from a 25m Digital Elevation Model, resampled to 100m, and reclassified into the model node states.

For non-classified data, raster grid values correspond to unique identifier values in the original polygon coverage which are then referenced by the Netica Manager during a model run; for example, a unique identifier was added to the VRI polygon layer prior to raster conversion; the VRI attribute table complete with all spatial and non-spatial values was exported to a database; during the model run, the Netica Manager references the VRI values for tree species, stand age, et cetera.

Once all spatial layers were developed, they were clipped to 33 processing units and combined into one raster grid per processing unit for modeling.

4. Sequence of Use
The modeling tools are designed to be used in a set sequence to make use of the outputs created by preceding tools to generate outputs for use by the next tool in the sequence. The tools are applied in the following order:

1) Spatial Layers: spatial layers are combined into a resultant grid in a GIS whose attribute table contains all of the information from the input spatial layers. This table is exported to a MS Access Database containing the Netica Manager Form.

2) Netica Manager: the imported table from the previous step is processed along with tables describing forest attributes, topographic features, biogeoclimatic subzones, and baseline thematic mapping to produce an ASCII 'case file' describing BBN model states for every location on the landscape.

3) BBN: the ‘case file’ from the previous step is applied to the ecological relationships and conditional probabilities in the BBN to generate an ASCII text file describing model results and their associated standard deviations for every location on the landscape.

4) Netica Manager: the information in the ASCII file generated by the BBN(s) is imported back into the MS Access database and attached to the resultant table of spatial layer attributes. The results, along with the ID field of the resultant are then exported as a new .dbf table for use in a GIS.

5) Spatial Layers: The table exported in the previous step is joined to the resultant grid and processed into maps of the model results in an automated process using ArcView 3.2 Avenue scripts.

Because many of the BBNs are dependent on the results of other models in this process, an application of this framework goes through 4 iterations (“runs”) to build up all of the model results. Each iteration follows the sequence described above.

Modeling Steps

1. Model runs

Model runs begin with creating a case file (*.cas) from the resultant input raster grid using Netica Manager. Netica is used to ‘process’ the case file for the particular model being run (i.e., High-elevation Winter Range for Northern Caribou (RHW)). Sequences of model runs are shown in Table K. The results of each model, exported as a text file, are imported back through Netica Manager where the resultant table is then linked back to the spatial data for viewing or mapping in a GIS.
Table K. Sequence of model implementation for developing estimates of species occurrence throughout the study area in north-central British Columbia.

<table>
<thead>
<tr>
<th>Model Run Sequence</th>
<th>Model Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Alal</td>
<td>Full species model for moose</td>
</tr>
<tr>
<td></td>
<td>Ceel</td>
<td>Full species model for elk</td>
</tr>
<tr>
<td></td>
<td>Odhe</td>
<td>Full species model for mule deer</td>
</tr>
<tr>
<td></td>
<td>Spgr</td>
<td>Full species model for spruce grouse</td>
</tr>
<tr>
<td></td>
<td>Tahu</td>
<td>Full species model for red squirrel</td>
</tr>
<tr>
<td></td>
<td>Gugu_denning</td>
<td>Winter denning model for wolverine</td>
</tr>
<tr>
<td></td>
<td>Interception</td>
<td>Forest canopy interception</td>
</tr>
<tr>
<td>2</td>
<td>Mape_forage</td>
<td>Forage map for fisher</td>
</tr>
<tr>
<td></td>
<td>*Spatial processing for: distance to wolverine dens, distance to cover (interception), and patch size (interception)</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Mape</td>
<td>Full species model for fisher</td>
</tr>
<tr>
<td></td>
<td>Rata_hi_win</td>
<td>Component model for caribou, high-elevation in late winter</td>
</tr>
<tr>
<td></td>
<td>Rata_lo_win</td>
<td>Component model for caribou, low-elevation in early winter</td>
</tr>
<tr>
<td>4</td>
<td>N/A</td>
<td>Not applicable to this work, amalgamates caribou models</td>
</tr>
<tr>
<td>5</td>
<td>Gugu</td>
<td>Full species model for wolverine</td>
</tr>
<tr>
<td></td>
<td>Ratam_ew</td>
<td>Component model for mountain caribou, early winter</td>
</tr>
<tr>
<td></td>
<td>Ratam_lw</td>
<td>Component model for mountain caribou, late winter</td>
</tr>
<tr>
<td></td>
<td>Urar_spr</td>
<td>Component model for grizzly bear, spring</td>
</tr>
<tr>
<td></td>
<td>Urar_sum</td>
<td>Component model for grizzly bear, summer</td>
</tr>
</tbody>
</table>

2. Gathering outputs and merging into raster maps

Model result outputs (value and standard deviation) were calculated by species by processing unit using scripting available in ESRI ArcView 3.2 Avenue scripts. Each species resultant grid was put together to span the entire study area using a mosaic routine. After the value and standard deviation grids were created by species, the grids were combined to create the resultant grid for a particular species.

3. Post-Processing

After the grids for each processing unit have been combined into a seamless mosaic some post-processing needed to be performed to improve the final product and make it conform to establish Digital Data Delivery Standards. These processing tasks are outlined below:

1) In the mosaic of caribou low elevation winter habitat, areas where habitat had been identified but was more than 20km from any high value (>50 animals/1000km² carrying capacity) high elevation habitat were set to a value of 0.

2) All grid mosaics had lakes greater than 250ha in area removed from them and were replace with a null value.

3) Because northern caribou and mountain caribou inhabit geographically distinct areas, model results dealing with each species were spatially restricted to the identified ranges of each sub-species.

4) A final ArcView 3.2 Avenue script was applied to all of the grid mosaics to combine the modeled results and their standard deviations into a single grid for each species/range model. This script also formatted and populated the
attribute table of each grid to conform to Digital Data Delivery Standards requirements.

4. Constructing meta-data

For each of the species models, we constructed a metadata spreadsheet in Excel, following the Digital Delivery Standards guidelines from B.C. Ministry of Environment. These models contain the sources for the relationships in each model, the nodes defined for each model, and the probability tables for each node value or state. The metadata spreadsheets are available separately.

Literature Cited


APPENDIX D: EMPIRICAL DERIVATION OF WILDFIRE DISTRIBUTION

Historically, an application of SELES Natural Disturbance models at WII would involve fire input parameters determined by Craig DeLong (BC Min. of For. and Range) based on Natural Disturbance Units (NDUs). In the case of the Quesnel TSA (DQU), this was not possible as NDUs and their associated fire parameters have only been developed for the northeastern quarter of the province.

Instead, we first tried to develop fire parameters for the SELES FireInfo.txt input text file based on values for each Natural Disturbance Type (NDT) in DQU found in the Biodiversity Guidebook. This proved to involve many unsupportable assumptions that led to clearly inaccurate results when extrapolated to the size classes in the SELES FireInfo.txt input text file. These calculations are contained in the spreadsheet titled "Fire_Distribution_Calculations_for_SELES_100226.xls" in the worksheet titled "BGB Calculations".

We settled on an empirical approach. Point locations for all recorded fire events in BC were downloaded from the LRDW. From this, natural fires were selected and grouped by BEC and NDT as they are in the Biodiversity Guidebook. From these 'samples' which often comprised of thousands of fires, the proportion that fell into each of the FireInfo.txt size classes was calculated and entered into the FireInfo.txt input file. These calculations are contained in the spreadsheet titled "Fire_Distribution_Calculations_for_SELES_100226.xls" in the sheet titled "Observational Calculations". This method makes the assumptions that fire suppression has not drastically changed fire size distribution in British Columbia and that the historical fire record is both complete and accurate in its reporting of fires and their sizes.
APPENDIX E: FC_ID RASTER AND LAYER TABLE DEVELOPMENT

List of Inputs

For each time step of the multi-species habitat supply modeling, the following nineteen data inputs were required, seven of which were dynamic over time or time-step dependant (TSD):

- Cumulative Kill % (TSD)
- Disturbance (TSD)
- MPB age since death (TSD)
- Non-Forest Descriptor
- Non-Productive Code
- Non-Productive Descriptor
- NLT (TSD)
- NST (TSD)
- NTT (TSD)
- Projected Height (TSD)
- Site Index
- Site Class 5M
- Species Type for leading/secondary species
- Species Composition for leading/secondary species
- Type Group Number
- Updated Age (TSD)

FC_ID Raster Development

The resultant obtained from Gordon Nienaber (BC Min. For. and Range, FAIB) contained Vegetation Resources Information (VRI) and BCMPB data; inputs derived from the resultant will be referred to as such. A raster called FC_ID was created from the following data inputs using the ESRI Combine tool in ArcMap. A field called FC_ID was added to the raster and populated with unique integer values for each record.

1. Cumulative Kill % (CK):
   - Rasters for the timesteps were derived from the CUMKILL_## fields in the resultant. CUMKILL09 = T0; CUMKILL14 = CUMKILL_T5; CUMKILL19 = CUMKILL_T10; CUMKILL24 = CUMKILL_T15 and CUMKILL_T20.
   - Integer fields were created in the resultant for each timestep and populated with the percent values. Rasters were created for each timestep.
   - For the natural disturbance (ND) scenarios the % values were changed to zero.

2. Disturbance (LBL_DISTUR):
   - The HARV_CLS field from the resultant formed the initial development of the LBL_DISTUR raster, integer numbers were assigned to the text values and a lookup table was created to later assist with developing the Layer table. A raster was created from the integer HARV_CLS field.
   - Timestep 0 the TSR4 harvest raster (created by Gordon Nienaber, MoFR) was calculated and gridded from the TSR4 (by Rob McCann) were added to the LBL_DISTUR raster.
- For subsequent timesteps the LBL_DISTUR raster was updated with the respective timestep harvest. 
- The ND scenario LBL_DISTUR rasters were reclassified to a value of 3 representing wildfire.

3. MPB age since death (MPB):
- The values for the MPB rasters were calculated by Rob McCann using data from the resultant. These results produced rasters for each timestep. 
- The ND scenario MPB rasters were reclassified to a value of 0 to negate the influence of the MPB infestation.

4. Non-Forest Descriptor (NFOR_DESC):
- The text values for this field were assigned unique integer values and a lookup table was created to assist in developing the Layer table. 
- A raster was produced from the NFOR_DESC integer field.

5. Non-Productive Code (NP_CODE):
- An integer field was created in the resultant and populated with the NP_CODES from which a raster was created.

6. Non-Productive Descriptor (NP_DESC):
- An integer field was created in the resultant and populated with the NP_CODES from which a raster was created. A lookup table was created to assist in developing the Layer table.

7. NLT, NST, NTT:
- These three inputs for timestep 0 were reclassified values originating from Ian Moss’ stand structure tables. Respectively they represent number of trees >25 cm dbh, number of trees between 11 – 25 cm dbh, and number of trees <10 cm dbh. Rasters were generated from the reclassified values. 
- The ND scenario rasters were reclassified to a 'not classified' value.

8. Projected Height (PROJ_HT_1):
- Timestep rasters were made from the TSR4 height ascii grids (created by Gordon Nienaber, MoFR). 
- The ND scenario rasters were reclassified to 9999 and the projection of height was handled in the bbn’s.

9. Site Index (SITE_INDEX):
- An integer field was created in the resultant and populated with the SITE_INDEX values from which a raster was made.

10. Site Class 5M (SITECL_5M):
- An integer field was created in the resultant and populated using calculations of the site index values provided by the Forest Inventory Planning Relational Data Dictionary V. 2.0 (Province of British Columbia 1997).

11. Species Type for leading/ secondary species (SPEC_CD_1 and SPEC_CD_2)
- All species codes occurring within the SPEC_CD_1 and SPEC_CD_2 fields of the resultant were identified then assigned a unique integer value from which a lookup table was created.
- An integer field was created in the resultant for both the SPEC_CD_1 and SPEC_CD_2 fields and populated according to the species codes occurring in either field. A raster was then created for each field.

12. Species Composition for leading/secondary species (SPEC_PCT_1 and SPEC_PCT_2):
- Integer fields were created in the resultant and populated with both the SPEC_PCT_1 and SPEC_PCT_2 fields. A raster was then created for each field.

13. Inventory Type Group Number (TYPEGRP_NO):
- The resultant (created by Gordon Nienaber, MoFR) was exported as a .dbf which was imported into a MS Access database for processing. WII developed an Access form to allocate an Inventory Type Group Number based on the tree species codes and their composition. Post processing was required afterwards to assign codes where known exceptions existed.
- The codes were exported from Access then linked back to the resultant so a raster could be created.

14. Stand Age (UPDATEDAGE):
- Timestep rasters were made from the TSR4 Stand Age ascii grids (created by Gordon Nienaber, MoFR).
- The ND scenario rasters were generated by a MS Access database form called Timestep Disturbance simulator which forecasted stand age 400 years into the future to 2409.

Layer Table Development

A .dbf output of the FC_ID raster was imported into a MS Access database for further processing. The LBL_DISTUR, NFOR_DESC, NP_DESC, SPEC_CD_1, SPEC_CD_2 fields were renamed by adding a preceding N_ to each field name. Five additional text fields were added to the table and labelled as per the aforementioned field names. Linkages were made to the lookup tables previously developed for the data inputs and the fields populated with the text values.

A copy of the FC_ID table was made and called Layer_### with the timestep number or the natural disturbance number. All extraneous fields were deleted from the table.
LITERATURE CITED

APPENDIX F: MULTI-SPECIES HABITAT SUPPLY MODEL
RUN PROCEDURE

While the modeling was applied to multiple time steps, the nature of the projected spatial information and time constraints have thus far not allowed for model tools to integrate time step compatibility. As a result, all landscape updating is done manually prior to the start of the model run. Provided this has been done, this procedure can be applied to any time step of the multi-species habitat supply models.

1. Run 1 - Create Res1 Grid

1. Launch ArcMap and load the following grids from the
   E:\Geomodeler\[Timestep#]\Spatial_Inputs\Grids directory:

   | AEFT | FHV | PET | ROUGH_CODE | TEM |
   | BEC  | FWDB| PTHD| SIZE       | WHV |
   | BTM  | LHV | PTMR| SLOPE_CODE |
   | FC_ID| MR2 | PTR | SRW        |

   2. Combine all of the above grids using the Raster Calculator under the
      Spatial_A nalyst Menu by entering the following expression:

      \[\text{Combine([AEFT], [BEC], [BTM], [FC_ID], [FHV], [FWDB], [LHV], [MR2],}
      \[\text{[PET], [PTHD], [PTMR], [PTR], [ROUGH_CODE], [SIZE], [SLOPE_CODE], [SRW],}
      \[\text{[TEM], [WHV]])}\]

   3. Save the resulting grid as RES1 by right clicking on the result in the table of
      contents (TOC) and selecting ‘Make Permanent’ on the ‘Data’ submenu.
      E:\Geomodeler\[Timestep#]\Spatial_Outputs\Grids\ folder.

2. Run 1 - Export Case File to Netica

4. Right-click on RES1 in the TOC and select ‘Open Attribute Table’. Export the
   table to a .dbf file by clicking the ‘Options’ button and selecting ‘Export’. Save the
   table to the [Spatial_Outputs]\Tables\ folder as res1.dbf.

5. Launch the prepared Access database for the timestep you are working on and
   import the res1.dbf table into the database.

6. Open the res1 table in Access in Design View and change the name of the
   ‘VALUE’ field to ‘ID’ then make this field the primary key of the table.

7. Open the ‘Netica Manager’ form and fill in the blanks on the ‘Export To’ side of
   the form:

   Model Year: enter the year of the timestep you are processing
   Layer Table: Layer_[Timestep#]
   Result Table: RES1
   Export To: copy the path to the \Models\out\ directory

8. Click the ‘Export Run 1 Nodes’ button to create the case file that will be
   processed in Netica.
3. Run 1 - Process Cases in Netica

9. Open each of the 7 models in the \Models\Run\ folder in a separate instance of Netica and apply the models by selecting ‘Process Cases’ from the ‘Cases’ menu and following the prompts. The outputs from Netica should be saved to the \Models\in\ folder. The parameters for running each of the models are given below:

<table>
<thead>
<tr>
<th>Model Name</th>
<th>Control File</th>
<th>Outfile Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>alal_beta_dqu.dne</td>
<td>Control_alal.txt</td>
<td>alal_in.txt</td>
</tr>
<tr>
<td>odhe_beta_dqu.dne</td>
<td>Control_odhe.txt</td>
<td>odhe_in.txt</td>
</tr>
<tr>
<td>oram_gama_dqu.dne</td>
<td>Control_oram.txt</td>
<td>oram_in.txt</td>
</tr>
<tr>
<td>spgr_beta_dqu.dne</td>
<td>Control_spgr.txt</td>
<td>spgr_in.txt</td>
</tr>
<tr>
<td>rsm_tahu_beta_dqu.dne</td>
<td>Control_tahu.txt</td>
<td>tahu_in.txt</td>
</tr>
<tr>
<td>xgugu_denning_win_beta_dqu.dne</td>
<td>Control_xgugu_denning_win.txt</td>
<td>xgugu_denning_win_in.txt</td>
</tr>
<tr>
<td>xinterception_dqu.dne</td>
<td>Control_xinterception.txt</td>
<td>intcpt_in.txt</td>
</tr>
</tbody>
</table>

4. Run 1 - Import results to Access and Export to ArcView

10. Return to the Netica Manager form in Access and enter RES1 into the result table dropdown and the path to the \Models\in\ folder in the “Import From” blank on the form. Press the ‘Import Run 1 Nodes’ button to import the model results to the RES1 table.

11. Create a new MakeTable query in Access and enter the following SQL query in SQL View:

```sql
SELECT res1.ID, res1.ALAL_CCVAL, ODHE_CCVAL, ORAM_CCVAL, res1.SPGR_CCVAL, res1.TAHU_CCVAL, res1.GWD_DHQVAL, res1.INT_IVAL INTO R1OUT
FROM res1;
```

Run the query by clicking the button that looks like this !.

12. Export the R1OUT table to a .dbf file by right-clicking on the table in the TOC and selecting ‘Export’. Save the table to the \Spatial_Outputs\Tables\ folder.

13. Create a new MakeTable query in Access and enter the following SQL query in SQL View:

```sql
SELECT res1.ID, res1.ALAL_CCSD, res1.ODHE_CCSD, res1.ORAM_CCSD, res1.SPGR_CCSD, res1.TAHU_CCSD INTO R1SD
FROM res1;
```

Run the query by clicking the button that looks like this !.

14. Export the R1SD table to a .dbf file by right-clicking on the table in the TOC and selecting ‘Export’. Save the table to the \Spatial_Outputs\Tables\ folder.
15. Select Tools → Database Utilities → Compact and Repair Database to maintain a reasonable file size for the database.

5. Run1 – GIS Processing

16. In ArcView 3.2, add the E:\Geomodeler\T[Step]\Spatial_Outputs\Grids\RES1 grid to the view.
17. If you can’t see it listed in the dropdown, ensure you have GRID selected from the Data Source Types dropdown.
18. Ensure the RES1 grid is selected in the TOC.
19. Select, Theme → Convert to Grid from the menus at the top of the ArcView 3.2 window. Browse to your E:\Geomodeler\T[Step]\SpatialOutputs\Grids directory and call the grid R1OUT. Select YES when ArcView asks to Add the Grid to the View.
20. Make the res1 grid active in the TOC by clicking on it and remove it from the View by selecting Edit → Delete Themes.
21. Open the grid’s attribute table by selecting the Open Theme Table icon (it looks like a database table).
22. Select XTools → Delete Multiple Fields
23. Select all fields EXCEPT Value and Count and select ‘OK’ and ‘Yes To ALL’.

6. Run 1 – Create Carrying Capacity and Standard Deviation Grids

24. Open a new script in ArcView by selecting Script → New in the ArcView window (look on the left side of the GUI) then select Script → Load Text file.
25. In Explorer, browse to the E:\Geomodeler\T[Step]\Scripts directory and double-click to open the “2_Run1_Create_VAL_and_SD_Grids.ave” Avenue script.
26. Change the ScenarioGridPath in the script to “E:\Geomodeler\T[Step]\Spatial_Outputs\Grids\” (look below for an example)
27. Change the ScenarioTable path in the script to “E:\Geomodeler\T[Step]\Spatial_Outputs\Tables\” (example seen below)
28. Change the MaskGrid_Name to “R1OUT”
29. Change the ResultTable_Name to “R1SD.dbf”
30. Change PUName to the number of your timestep (place it in quotes, e.g. “T0”)
31. Change the Viewname to “View1”
32. ‘Setup

ScenarioGridPath = "E:\Geomodeler\T0\Spatial_Outputs\Grids\"
ScenarioTablePath = "E:\Geomodeler\T0\Spatial_Outputs\Tables\"
MaskGrid_Name = ScenarioGridPath+ "R1OUT"
ResultTable_Name = ScenarioTablePath+ "R1SD.dbf"
PUName = "T0"
viewname = "View1"

33. Compile the script with the compile button and click the Run button.
34. The result of this script will be 10 grids but it will take a while to produce them so this is a great time work on other timesteps for a while.

35. Copy all of the output grids for each timestep to a central location using ArcCatalog separating the grids for each run into a separate directory. This will be useful when the both halves of the Quesnel TSA are run through the MSHSM and need to be mosiackted together. An example of a suitable location for Run 1 grids would be:

E:\Geomodeler\DQU_Species_Mosaic_100311\Spatial_Inputs\Grids\Run_1\n
A full listing of the grids to be copied is given below:

```
Run 1
alal_sd<T#>  oram_val<T#>
alal_val<T#>  spgr_sd<T#>
odhe_sd<T#>  spgr_val<T#>
odhe_val<T#>  tahu_sd<T#>
oram_sd<T#>  tahu_val<T#>
```

7. Run 1 – Create Proximity Grids

36. Remain in ArcView 3.2 and load the R1OUT grid into the active view.
37. Select Tables from the ArcView Window and click the ‘Add’ button.
38. Browse to your E:\Geomodeler\[Timestep#]\SpatialOutputs\Tables directory and select the r1out.dbf table and click ‘OK’.
39. Select the ID field from the r1out.dbf table by clicking on the field header in the table.
40. Select the VALUE field from the r1out grid table using the same method.
41. Select the Table Join icon.
42. Go to File → Extensions and select FixJoin (this adds an icon to your ArcView GUI that looks like)
43. Click the FixJoin button and click ‘Yes’ to make the table join permanent. This will take a while.
44. Once the FixJoin routine is complete, remove R1OUT from the active view.
45. Launch ArcMap and load the R1OUT grid into the data frame.
46. Load the Reduced_MSHSM_Model_Run_Tools toolbox into ArcToolbox by right-clicking on the ArcToolbox pane and selecting Add → Toolbox. Then navigate to E:\Geomodeler\[Timestep#]\Toolboxes\ folder and select the Reduced_MSHSM_Model_Run_Tools.tbx file.
47. Open the model called ‘Run1_1_Create_Fields’ by double-clicking on it in the ArcToolbox table of contents.
48. There is one parameter for this model. For the input R1OUT grid, click on the dropdown arrow and select ‘r1out’. Click ‘OK’.
49. Under the model window’s Model menu select ‘Validate Entire Model’.
50. Click the Run button to execute the model and add 3 fields to the R1OUT attribute table.
51. Open the model called ‘Run1_2_Create_Proximity Grids’ by double-clicking on it in the ArcToolbox table of contents.
There are four parameters for this model. For the input R1OUT grid, click on the dropdown arrow and select ‘r1out’. For the remaining parameters enter the following:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output Location for ptcw Grid</td>
<td>E:\Geomodeler\T[Timestep#]\SpatialOutputs\Grids\ptcw</td>
</tr>
<tr>
<td>Output Location for ptcb Grid</td>
<td>E:\Geomodeler\T[Timestep#]\SpatialOutputs\Grids\ptcb</td>
</tr>
<tr>
<td>Output Location for ps Grid</td>
<td>E:\Geomodeler\T[Timestep#]\SpatialOutputs\Grids\ps</td>
</tr>
</tbody>
</table>

Click ‘OK’ to execute the model and make the ‘ptcw’ grid for use in Run 2 (ptcw – proximity to cover wolverine, ptcb – proximity to cover bears, ps – patch size).

8. Run 2 – Create Res2 Grid

52. This step is not necessary in these runs as all of the input information we need is found in the res1 grid.

9. Run 2 – Export Case File to Netica

53. Open the ‘Netica Manager’ form and fill in the blanks on the ‘Export To’ side of the form:

- Model Year: enter the year of the timestep you are processing
- Layer Table: Layer [Timestep#]
- Result Table: RES1
- Export To: copy the path to the \Models\out\ directory

54. Click the ‘Export Run 2 Nodes’ button to create the case file that will be processed in Netica.

10. Run 2 – Process Cases in Netica

55. Open each of the three models in the \Models\Run2\ folder in a separate instance of Netica and apply the models by selecting ‘Process Cases’ from the ‘Cases’ menu and following the prompts. The outputs from Netica should be saved to the \Models\in\ folder. The parameters for running each of the models are given below:

<table>
<thead>
<tr>
<th>BBN</th>
<th>Control File</th>
<th>Outfile Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>beta_xmape_forage.dne</td>
<td>Control_xmape_forage_win.txt</td>
<td>mapefw_in.txt</td>
</tr>
</tbody>
</table>

11. Run 2 - Import results to Access and Export to ArcView

56. Return to the Netica Manager form in Access and enter RES1 into the result table dropdown and the path to the \Models\in\ folder in the “Import From” blank on the form. Press the ‘Import Run 2 Nodes’ button to import the model results to the RES1 table.

57. Create a new MakeTable query in Access and enter the following SQL query in SQL View:
SELECT res1.ID, res1.MPFW_PAVAL, MPFW_PASD INTO R2OUT
FROM res1;

Run the query by clicking the button that looks like this !.

58. Export the R2OUT table to a .dbf file by right-clicking on the table in the TOC and selecting 'Export'. Save the table to the \Spatial_Outputs\Tables\ folder.
59. Select Tools → Database Utilities → Compact and Repair Database to maintain a reasonable file size for the database.

12. Run 2 – GIS Processing

60. In ArcView 3.2, add the E:\Geomodeler\T[Timestep#]\Spatial_Outputs\Grids\RES1 grid to the view.
61. If you can’t see it listed in the dropdown, ensure you have GRID selected from the Data Source Types dropdown.
62. Ensure the RES1 grid is active in the TOC.
63. Select, Theme → Convert to Grid from the menus at the top of the ArcView 3.2 window. Browse to your E:\Geomodeler\T[Timestep#]\Spatial_Outputs\Grids\ directory and call the grid R2OUT. Select YES when ArcView asks to Add the Grid to the View.
64. Open the grid’s attribute table by selecting the Open Theme Table icon (it looks like a database table).
65. Select XTools → Delete Multiple Fields
66. Select all fields EXCEPT Value and Count and select ‘OK’ and ‘Yes To All’.

13. Run 2 – Create Proximity Grids

67. Remain in ArcView 3.2 and load the R1OUT grid into the active view.
68. Select Tables from the ArcView Window and click the ‘Add’ button.
69. Browse to your E:\Geomodeler\T[Timestep#]\Spatial_Outputs\Tables directory and select the r2out.dbf table and click ‘OK’.
70. Select the ID field from the r2out.dbf table by clicking on the field header in the table.
71. Select the VALUE field from the r2out grid table using the same method.
72. Select the Table Join icon  
73. Go to File → Extensions and select FixJoin (this adds an icon to your ArcView GUI that looks like )
74. Click the FixJoin button and click ‘Yes’ to make the table join permanent. This will take a while.
75. Once the FixJoin routine is complete, remove R2OUT from the active view.
76. Launch ArcMap and load the R2OUT and ALAL_VAL[Timestep#] grids into the data frame.
77. If necessary, load the Reduced_MSHSM_Model_Run_Tools toolbox into ArcToolbox by right-clicking on the ArcToolbox pane and selecting Add → Toolbox. Then navigate to E:\Geomodeler\PU[Timestep#]\Toolboxes\ folder and select the Reduced_MSHSM_Model_Run_Tools.tbx file.
78. Open the model called ‘Run2_1_Create_Fields’ by right-clicking on it and selecting ‘Edit’.
79. Double-click on the blue oval at the left of the model labelled ‘Input r2out Grid’ and make sure it says r2out on the blank. Enter r2out if necessary and click ‘OK’.
80. Under the model window’s Model menu select ‘Validate Entire Model’.
81. Click the Run button to execute the model and add 1 field to the R2OUT attribute table.
82. Open the model called ‘Run2_2_Create_Proximity Grids’ by double-clicking on it in the ArcToolbox table of contents.
83. There are five parameters for this model. For the input R2OUT and ALAL_VAL(PU) grids, click on the dropdown arrow and select ‘r2out’ and your alal_val(pu) grids respectively. For the remaining parameters enter the following:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output Location for ptpcs Grid</td>
<td>E:\Geomodeler\T[Timestep#]\SpatialOutputs\Grids\ptpcs</td>
</tr>
<tr>
<td>Output Location for ptpclf Grid</td>
<td>E:\Geomodeler\T[Timestep#]\SpatialOutputs\Grids\ptpclf</td>
</tr>
<tr>
<td>Output Location for pd Grid</td>
<td>E:\Geomodeler\T[Timestep#]\SpatialOutputs\Grids\pd</td>
</tr>
</tbody>
</table>

Click ‘OK’ to execute the model and make 3 grids for use in Run 3 (ptpcs – proximity to predators caribou spring, ptpclf – proximity to predators caribou low fall, and pd – prey density).

14. Run 2 – Create Marten Carrying Capacity and Std. Deviation Grid

84. This step is not necessary for this round of runs as Marten is not a species covered by this project.
15. Run 3 – Create Res3 Grid

85. Launch ArcMap and load the following grids from the \Spatial_Inputs\Grids and \Spatial_Outputs\Grids directories:

<table>
<thead>
<tr>
<th>Grid Name</th>
<th>Code/Field</th>
</tr>
</thead>
<tbody>
<tr>
<td>RES1</td>
<td>PD</td>
</tr>
<tr>
<td>ASPCT_CODE</td>
<td>PRECIP</td>
</tr>
<tr>
<td>CURV_CODE</td>
<td>PS</td>
</tr>
<tr>
<td>DEADWOOD</td>
<td>PTPCLF</td>
</tr>
<tr>
<td>ELEV_CODE</td>
<td></td>
</tr>
</tbody>
</table>

86. Combine all of the above grids using the Raster Calculator under the Spatial_Analyst Menu by entering the following expression:

```
Combine([res1],[aspct_code],[curv_code],[deadwood],
         [elev_code],[pd],[precip],[ps],[ptpclf])
```

87. Save the resulting grid as RES3 by right-clicking on the result in the TOC and selecting 'Make Permanent' on the 'Data' submenu. Save the grid to the E:\Geomodeler\T[Timesstep#]\Spatial_Outputs\Grids folder.

16. Run 3 – Export Case File to Netica

88. Right-click on RES3 in the TOC and select ‘Open Attribute Table’. Export the table to a .dbf file by clicking the ‘Options’ button and selecting ‘Export’. Save the table to the \Spatial_Outputs\Tables\ folder as res3.dbf.

89. Check the size of the prepared Access database using Windows Explorer and if it has exceeded 1.2 GB make a copy of the database and strip out unnecessary tables (i.e., R1OUT, R2OUT) before compacting the copy and continuing with modeling.

90. Launch the prepared Access database for the timestep you are working on and import the res3.dbf table into the database.

91. Open the res3 table in Access in Design View and change the name of the ‘VALUE’ field to ‘ID3’ then make this field the primary key of the table.

92. Open the ‘Netica Manager’ form and fill in the blanks on the ‘Export To’ side of the form:

- Model Year: enter the year of the timestep you are processing
- Layer Table: Layer [Timesstep#]
- Result Table: RES3
- Export To: copy the path to the Models\out\ directory

Click the ‘Export Run 3 Nodes’ button to create the case file that will be processed in Netica.
17. Run 3 – Process Cases in Netica

93. Open each of the three models in the ‘Models\Run3\’ folder in a separate instance of Netica and apply the models by selecting ‘Process Cases’ from the ‘Cases’ menu and following the prompts. The outputs from Netica should be saved to the ‘Models\in’ folder. The parameters for running each of the models are given below:

<table>
<thead>
<tr>
<th>BBN</th>
<th>Control File</th>
<th>Outfile Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>mape_beta_dqu_edits.dne</td>
<td>Control_mape.txt</td>
<td>mape_in.</td>
</tr>
<tr>
<td>rata_gamma_winhi_dqu.dne</td>
<td>Control_rata_hi_win.txt</td>
<td>ratahiwin_in.</td>
</tr>
<tr>
<td>rata_gamma_winlo_dqu.dne</td>
<td>Control_rata_lo_win.txt</td>
<td>ratalow_in.txt</td>
</tr>
</tbody>
</table>

18. Run 3 – Import results to Access and Export to Table & GIS Processing

94. Return to the Netica Manager form in Access and enter RES3 into the result table dropdown and the path to the ‘Models\in’ folder in the “Import From” blank on the form. Press the ‘Import Run 3 Nodes’ button to import the model results to the RES3 table.

95. Create a new MakeTable query in Access and enter the following SQL query in SQL View:

```sql
SELECT res3.ID3, res3.MAPE_CCVAL, res3.RHW_CCVAL, res3.RLW_CCVAL
INTO R3OUT
FROM res3;
```

Run the query by clicking the button that looks like this !.

Export the R3OUT table to a .dbf file by right-clicking on the table in the TOC and selecting ‘Export’. Save the table to the ‘Spatial_Outputs\Tables’ folder.

96. Create a new MakeTable query in Access and enter the following SQL query in SQL View:

```sql
SELECT res3.ID3, res3.MAPE_CCSD, res3.RHW_CCSD, res3.RLW_CCSD INTO R3SD
FROM res3;
```

Run the query by clicking the button that looks like this !.

Export the R3SD table to a .dbf file by right-clicking on the table in the TOC and selecting ‘Export’. Save the table to the ‘Spatial_Outputs\Tables’ folder.

97. Select Tools → Database Utilities → Compact and Repair Database to maintain a reasonable file size for the database.

98. In ArcView 3.2, add the E:\Geomodeler\[Timestep#]\Spatial_Outputs\Grids\RES3 grid to the view.

99. If you can’t see it listed in the dropdown, ensure you have GRID selected from the Data Source Types dropdown.

100. Ensure the RES3 grid is active in the TOC.

101. Select, Theme → Convert to Grid from the menus at the top of the ArcView 3.2 window. Browse to your E:\Geomodeler\[Timestep#]\Spatial_Outputs\Grids\
directory and call the grid R3OUT. Select YES when ArcView asks to Add the Grid to the View
102. Open the grid’s attribute table by selecting the Open Theme Table icon (it looks like a database table)
103. Select XTools → Delete Multiple Fields
104. Select all fields EXCEPT Value and Count and select ‘OK’ and ‘Yes To All’.

19. Run 3 – Create Carrying Capacity and Standard Deviation Grids

105. Open a new script in ArcView by selecting Script → New in the ArcView window (look on the left side of the GUI) then select Script → Load Text file.
106. In Explorer, browse to the E:\Geomodeler\T[Timestep#]\Scripts directory and double-click to open the “4_Run3_Create_VAL_and_SD_Grids.ave” Avenue script.
107. Change the ScenarioGridPath in the script to:
   “E:\Geomodeler\T[Timestep#]\Spatial_Outputs\Grids\” (look below for an example).
108. Change the ScenarioTablePath in the script to:
   “E:\Geomodeler\T[Timestep#]\Spatial_Outputs\Tables\” (look below for an example).
109. Change the MaskGrid_Name to “R3OUT”.
110. Change the ResultTable_Name to “R3OUT.dbf”
111. Change the SDTable_Name to “R3SD.dbf”.
112. Change TimestepNumber to the number of your timestep (place it in quotes)
113. Change the Viewname to “View1”

*Setup

ScenarioGridPath = "E:\Geomodeler\T[Timestep#]\Spatial_Outputs\Grids\"
ScenarioTablePath = "E:\Geomodeler\T[Timestep#]\Spatial_Outputs\Tables\"
MaskGrid_Name = ScenarioGridPath+ "R3OUT"
ResultTable_Name = ScenarioGridPath+ "R3OUT.dbf"
SDTable_Name = ScenarioGridPath+ "R3SD.dbf"
TimestepNumber = "T0"
viewname = "View1"

114. Compile the script with the compile button and click the Run button .
The result of this script will be 6 grids. This will take a while so it is a good time to work on other PUs while you wait.
115. Copy all of the output grids for each PU to a central location using ArcCatalog separating the grids for each run into a separate directory. An example of a suitable location for Run 3 grids would be:

   E:\Geomodeler\MPBHSM_Species_Mosaic_080816\Spatial_Inputs\Grids\Run_3\n
A full listing of the grids to be copied is given below:
### Run 3

- mape.sd.<T#>
- rhw.val.<T#>
- mape.val.<T#>
- rlw.sd.<T#>
- rhw.sd.<T#>
- rlw.val.<T#>

### 20. Run 4 – Create Res4 Grid

116. Launch ArcMap and load the following grids from the \Spatial_Inputs\Grids and \Spatial_Outputs\Grids directories:

- RES1 PTCB SRS
- RES3 PTCW
- BBHV PTFNS

117. Combine all of the above grids using the Raster Calculator under the Spatial_Analyst Menu by entering the following expression:

\[
\text{Combine}([\text{res1}], [\text{res3}], [\text{bbhv}], [\text{ptcb}], [\text{ptcw}], [\text{ptfns}], [\text{srs}])
\]

118. Save the resulting grid as RES4 by right-clicking on the result in the TOC and selecting ‘Make Permanent’ on the ‘Data’ submenu. Save the grid to the E:\Geomodeler\T[Timestep#]\Spatial_Outputs\Grids\ folder.

### 21. Run 4 – Export Case File to Netica

119. Right-click on RES4 in the TOC and select ‘Open Attribute Table’. Export the table to a .dbf file by clicking the ‘Options’ button and selecting ‘Export’. Save the table to the \Spatial_Outputs\Tables\ folder as res4.dbf.

120. Check the size of the prepared Access database using Windows Explorer and if it has exceeded **1.2 GB** make a copy of the database and strip out unnecessary tables (i.e. R1OUT, R2OUT, R3OUT, RES2) before compacting the copy and continuing with modeling.

121. Launch the prepared Access database for the Timestep you are working on and import the res4.dbf table into the database.

122. Open the res4 table in Access in Design View and change the name of the ‘VALUE’ field to ‘ID4’ then make this field the primary key of the table.

123. Open the ‘Netica Manager’ form and fill in the blanks on the ‘Export To’ side of the form:

- Model Year: enter the year of the timestep you are processing
- Layer Table: VRI
- Result Table: RES4
- Export To: copy the path to the \Models\out\ directory

124. Click the ‘Export Run 4 Nodes’ button to create the case file that will be processed in Netica.
22. Run 4 – Process Cases in Netica

125. Open each of the six models in the \Models\Run4\ folder in a separate instance of Netica and apply the models by selecting ‘Process Cases’ from the ‘Cases’ menu and following the prompts. The outputs from Netica should be saved to the \Models\in\ folder. The parameters for running each of the models are given below:

<table>
<thead>
<tr>
<th>BBN</th>
<th>Control File</th>
<th>Outfile Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>beta_gugu_dqu.dne</td>
<td>Control_gugu.txt</td>
<td>gugu_in.txt</td>
</tr>
<tr>
<td>urar_sum_dqu.dne</td>
<td>Control_urar_sum.txt</td>
<td>urarsum_in.txt</td>
</tr>
</tbody>
</table>

23. Run 4 – Import results to Access and Export to Table & GIS Processing

126. Return to the Netica Manager form in Access and enter RES4 into the result table dropdown and the path to the \Models\in\ folder in the “Import From” blank on the form. Press the ‘Import Run 4 Nodes’ button to import the model results to the RES4 table.
127. Create a new MakeTable query in Access and enter the following SQL query in SQL View:

```
SELECT res4.ID4, res4.GUGU_CCVAL, res4.URSU_PDVAL INTO R4OUT FROM res4;
```

Run the query by clicking the button that looks like this !.
128. Export the R4OUT table to a .dbf file by right-clicking on the table in the TOC and selecting ‘Export’. Save the table to the \Spatial_Outputs\Tables folder.
129. Create a new MakeTable query in Access and enter the following SQL query in SQL View:

```
SELECT res4.ID4, res4.GUGU_CCSD, res4.URSU_PDSD INTO R4SD FROM res4;
```

Run the query by clicking the button that looks like this !.
130. Export the R4SD table to a .dbf file by right-clicking on the table in the TOC and selecting ‘Export’. Save the table to the \Spatial_Outputs\Tables\ folder.
131. Select Tools → Database Utilities → Compact and Repair Database to maintain a reasonable file size for the database.
132. In ArcView 3.2, add the E:\Geomodeler\T[\Timeslap\]Spatial_Outputs\Grids\RES4 grid to the view.
133. If you can’t see it listed in the dropdown, ensure you have GRID selected from the Data Source Types dropdown.
134. Ensure the RES4 grid is active in the TOC.
135. Select, Theme → Convert to Grid from the menus at the top of the ArcView 3.2 window. Browse to your E:\Geomodeler\T[\Timeslap\]Spatial_Outputs\Grids\
directory and call the grid **R4OUT**. Select YES when ArcView asks to Add the Grid to the View.

136. Open the grid’s attribute table by selecting the Open Theme Table icon (it looks like a database table).

137. Select XTools → Delete Multiple Fields

138. Select all fields except Value and Count and select ‘OK’ and ‘Yes To All’.

### 24. Run 4 – Create Carrying Capacity and Standard Deviation Grids

139. Open a new script in ArcView by selecting Script → New in the ArcView window (look on the left side of the GUI) then select Script → Load Text file.

140. In Explorer, browse to the E: Geomodeler\T\[Timestep#]\Scripts directory and double-click to open the “5_Run4_Create_VAL_and_SD(Grids).ave” Avenue script.

141. Change the ScenarioGridPath in the script to:
   “E:\Geomodeler\T\[Timestep#]\Spatial_Outputs\Grids\” (look below for an example).

142. Change the ScenarioTablePath in the script to:
   “E:\Geomodeler\T\[Timestep#]\Spatial_Outputs\Tables\” (look below for an example).

143. Change the MaskGrid_Name to “R4OUT”.

144. Change the ResultTable_Name to “R4OUT.dbf”

145. Change the SDTable_Name to “R4SD.dbf”

146. Change TimestepNumber to the number of your Timestep (place it in quotes)

147. Change the Viewname to “View1”

```plaintext
*Setup

ScenarioGridPath = "E:\Geomodeler\T\[Timestep#]\Spatial_Outputs\Grids\"
ScenarioTablePath = "E:\Geomodeler\T\[Timestep#]\Spatial_Outputs\Tables\"
MaskGrid_Name = ScenarioGridPath+ "R4OUT"
ResultTable_Name = ScenarioGridPath+ "R4OUT.dbf"
SDTable_Name = ScenarioGridPath+ "R4SD.dbf"
TimestepNumber = "T0"
viewname = "View1"
```

148. Compile the script with the compile button and click the Run button.

The result of this script will be 4 grids. This will take a while so it is a good time to work on other Timesteps while you wait.

149. Copy all of the output grids for each PU to a central location using ArcCatalog separating the grids for each run into a separate directory. An example of a suitable location for Run 4 grids would be:

```
E:\Geomodeler\MPBHSM_Species_Mosaic_080816\Spatial_Inputs\Grids\Run_4\n```

A full listing of the grids to be copied is given below:
Run 4

\begin{align*}
gugu_{sd} & <T#> \\
gugu_{val} & <T#> \\
ursu_{sd} & <T#> \\
ursu_{val} & <T#> \\
\end{align*}

25. Post-Processing – Remove Woodland Caribou Low Winter Habitat That Isn’t Near High Winter Habitat

150. In ArcMap, select all RHW_VAL cells with a value \( \geq 50 \) and use the ‘Euclidean Distance’ tool to generate a grid of distances from the selected cells.
151. Reclassify the distance grid such that values \( \leq 20 \text{km} = 1 \) and all other values = 0. Save this grid as RHW_DIST.
152. Rename the RLW_VAL grid to RLW_VAL_A
153. Perform the following conversion in the Raster Calculator to remove RATA low winter habitat that is too far from High Winter habitat. Ensure that your analysis mask and extents are set to the extent of your study area.

\[
\text{Con}([\text{rhw\_dist}] > 0, [\text{rlw\_val}], [\text{rhw\_dist}])
\]
154. Name the output of the previous step RLW_VAL.

26. Post-Processing – Remove Water From Mosaicked Grids

155. Create a 100m grid of lakes with an area \( \geq 250 \text{ha} \) for your study area. This grid should have the extent of your study area with cell values of 1 for lakes and 0 for everything else. Name this grid A\_LAKE\_GT250.
156. Delete the lakes from A\_LAKE\_GT250 with the following expression using the Single Output Map Algebra Tool:

\[
\text{Setnull}(\text{A\_LAKE\_GT\_250} >0, \text{A\_LAKE\_GT\_250})
\]

Save the resulting grid as LK\_ERASER.
157. Rename the VAL and SD grids produced by ArcView scripts 2 – 5 by adding _RAW to the grid names and add them to your ArcMap Map Document.
158. Add the VJB\_MPB\_HSM\_Tools toolbox to ArcToolbox and open the 2\_Remove\_Large\_Lakes model.
159. Edit the locations of the input and output grids where necessary (also ensure the extent, analysis mask, and cell size for each tool are set to the LK\_ERASER grid for each tool) and run the model.

27. Post-Processing – Remove Woodland Caribou From Mountain Caribou Areas

160. In ArcCatalog, rename the RMEW_VAL and RMLW_VAL grids as RMEW\_VAL\_X and RMLW\_VAL\_X respectively.
161. Rename the SD grids for the models renamed in the previous step in the same manner by adding _X to the grid names.

162. Add the VJB_MPB_HSM_Tools toolbox to ArcToolbox and open the 3_Mask_Mountain_Caribou model.

163. Edit the locations of the input grids and run the model. The grid called MC_MASK is a grid of the MPBHSM study area with cell values of 1 in Mountain Caribou Areas and 0 everywhere else.

28. Post-Processing – Remove Mountain Caribou From Woodland Caribou Areas

164. In ArcCatalog, rename the RHS_VAL, RHW_VAL, RLF_VAL, and RLW_VAL grids as RHS_VAL_X, RHW_VAL_X, RLF_VAL_X, and RLW_VAL_X respectively.

165. Rename the SD grids for the models renamed in the previous step in the same manner by adding _X to the grid names.

166. Add the VJB_MPB_HSM_Tools toolbox to ArcToolbox and open the 4a_Mask_Woodland_Caribou_Fewer_Models model.

167. Edit the locations of the input grids and run the model. The grid called MC_MASK is a grid of the MPBHSM study area with cell values of 1 in Mountain Caribou Areas and 0 everywhere else.

29. Post-Processing – Round Off Large Values

168. Four of the models contain enough unique values that ArcView is unable to combine the VAL and SD Grids. To get Around this add _X to the names of the ODHE, SPGR, STGR, and TAHU model VAL and SD grids as was done in stages 27 and 28.

169. Load each of the renamed grids into ArcView and add the following integer field to the attribute table (Name: RoundedVal).

170. Populate the RoundedVal field using the following expression in the Field Calculator. This will round the cell values to the nearest 10 and shrink the number of unique values used when later combining grids:

$$\left(\left\lfloor \frac{\text{Value}}{10} \right\rfloor \cdot \text{Round} \right) \cdot 10$$

171. Using the Map Calculator, create a new grid based on the values in the RoundedVal field. Name the grids ODHE_VAL, ODHE_SD, SPGR_VAL, etc.

30. Post-Processing – Create Final Grids For Delivery

172. Open a new script in ArcView by selecting Script → New in the ArcView window (look on the left side of the GUI) then select Script → Load Text file.

173. In Explorer, browse to the E:\Geomodeler\[Timestep#]\Scripts directory and double-click to open the “10_create_final_grids_for_delivery.ave” Avenue script.

174. Make sure you have a copy of the ‘dqu_west’ grid (or dqu_east if applicable) in the folder listed below and change the ScenarioGridPath in the script to the location of the other post-processed grids: (look below for an example).

175. Change the MaskGrid_Name to “dqu_west”.

Multi-species habitat supply – Quesnel TSA: Appendices 136
176. Change the Viewname to “View1”

'Setup

ScenarioGridPath = "E:\Geomodeler\QMC_DataPrep_DQU_100115\ Post_Processed_Grids\T0"
MaskGrid_Name = ScenarioGridPath + "dqu_west"
viewname = "View1"

Compile the script with the compile button ✔️ and click the Run button ✉️. The result of this script will be 10 grids.
APPENDIX G. INFLUENCE DIAGRAMS
Figure 1. An influence diagram depicting the ecological relationships between input nodes (blue) and the probability of habitat occupancy (green) by moose.
Figure 2. An influence diagram depicting the ecological relationships between input nodes (blue) and many different ecological proxy variables (red) used in species habitat supply modeling.